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Chapter 1
RF Flow Introduction

RF Design Process Overview

The Radio Frequency (RF) tool in the Expedition Enterprise flow, enables you to create RF
designs. You can also simulate the RF design with a third party RF simulator by transferring
design data over a bidirectional dynamic link.

Using these RF tools, you can edit and simulate your designs, while maintaining concurrency in
schematic capture and layout. The transfer of design data over a dynamic link provides a secure,
real-time integration, and a seamless process between schematic capture, layout, and the
simulator (Figure 1-1).

Figure 1-1. EE RF Flow

Schematic Capture | RF 4
| Connect

|
Third Party
RF Simulator

Server
Design DB i:>

Layout | bi? <
| Connect

The RF design flow supports the following third party RF simulators:

* Agilent Technologies’ Advanced Design System (ADS) RF Simulator (ADS RF
Simulator).

* Applied Wave Research (AWR) Microwave Office (MWO) RF Simulator (MWO RF
Simulator).

RF tools enable you to:

® Transfer data bidirectionally (Connecting Schematic Capture to RF Simulator Server
and Connecting Layout to RF Simulator Server).
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® Group RF shapes and elements in the schematic (Creating an RF Group) and send the
RF group to the RF simulator via the dynamic link. You can make design changes in the
RF simulator and post back the changes to the schematic capture tool (Post Back to
Schematic Capture and Layout and Posting Back MWO Updates to Layout).

® Use RF shapes in the Central Library to create a design in the RF simulator (Placing RF
Symbols). You can send the RF simulator design to schematic capture where it becomes
part of an existing design.

* Forward Annotate (FA) the schematic capture design to layout. Use the RF Toolkit in
layout to add and create meanders (traces), vias, and RF shapes (RF Layout). You can
send an RF group to the RF simulator and make design changes (Sending Layout Data).
Post back the RF simulator changes to incorporate the changes into the layout design ().

DxDesigner RF Introduction

You must acquire a DxXRFEngineer license to access the RF tools (Acquiring an RF License).
You can place RF shape symbols in the same manner as any other symbol (Placing RF
Symbols).

Develop an RF design in the schematic capture tool as follows:

® Place RF simulator RF shapes in the schematic design (Adding ADS RF Shapes to
Central Library and Adding AWR/MWO RF Shapes to Central Library).

® Check the RF designs (RF DRC).
* Edit the RF shape parameters (RF Parameters Dialog Box - Schematic Capture).
® Set the following RF design defaults:

- Parameter Units (Setting the RF Parameters Default Units of Measure)
- Min/Max Frequency (Setting RF Frequency Range)
- Substrate (Adding a Substrate)

® Create variable blocks, which enables use of parameter variables for RF shapes.
(Creating Variables in RF Shape Parameters).

* Transfer design data between the schematic capture tool and the RF simulator with the
dynamic link. (Connecting Schematic Capture to RF Simulator Server).

Related Topics

Getting Started
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RF Design Process Overview

Expedition RF Introduction

You must have an Advanced Technology Pro (RF) license to access the RF Toolkit (Advanced
Technology Pro (RF)). Use the RF tools to create a mixed technology design that includes RF,
digital, and analog (RF Toolkit Toolbar). The RF Toolkit provides access to the layout RF tools.

Use the following to develop an RF design in the layout tool:

Create variable blocks to define RF shape parameters (Adding a Varblock).
Place RF shapes with the auto arranger (Placing RF Groups with Auto Arranger).
Create meanders (traces) (Meander Properties Dialog Box).

Place RF stitched vias (Vias in RF Designs).

Set RF shape clearance rules in X, Y, and Z axes (Clearance Editor Dialog Box).
Define RF shape entry angles (RF Entry Rules Dialog Box).

Change RF shape parameters (RF Shape Parameters Dialog Box).

Transfer design data between the layout tool and the RF simulator with the dynamic link
(Connecting Layout to RF Simulator Server).

Related Topics

Getting Started

Manufacturing Data

RF circuits require special attention to the precision of the output data. Typically, the
dimensions are much smaller than analog and digital designs and require a more accurate
format (Generating Manufacturing Data).

Related Topics

Getting Started

RF in DxDesigner - Expedition Flow Users Manual, EE 7.9.5
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Getting Started

The following is an overview of the RF design process. Clicking a link takes you to detailed
information on the selected subject matter.

Acquiring an RF licence:

o DxDesigner — Acquiring an RF License

o Expedition — Opening a PCB for RF Design
Supported RF simulators:

o Agilent Technologies’ Advanced Design System (ADS) RF Simulator — ADS RF
Simulator

o Applied Wave Research (AWR) Microwave Office (MWO) RF Simulator — MWO
RF Simulator

Installing RF simulator elements into the central library:
o Adding ADS RF Shapes to Central Library
o Adding AWR/MWO RF Shapes to Central Library
Grouping the design by RF functions or regions:
o DxDesigner — RF Group/Ungroup Dialog Box
o Expedition — Group/Ungroup Dialog Box
Setting up the bidirectional dynamic link:
® The RF simulator provides a server:
o ADS RF simulator — Launching the ADS Server
o AWR RF Simulator — Launching MWO Server
* DxDesigner and Expedition connecting to RF simulator server:
o DxDesigner — Connecting Schematic Capture to RF Simulator Server
o Expedition — Connecting Layout to RF Simulator Server
Sending the RF design group to the RF simulator:
o DxDesigner — RF Group/Ungroup Dialog Box Treeview Popup Menu Items
o Expedition — Sending Netlist - Layout
Sending the RF simulator data back to DxDesigner or Expedition for incorporation:
* DxDesigner

o Sending ADS Design to Schematic Capture Tool

18

RF in DxDesigner - Expedition Flow Users Manual, EE 7.9.5



RF Flow Introduction
Getting Started

o Sending an MWO Design to Schematic Capture
* Expedition

o Post Back to Schematic Capture and Layout

o Posting Back MWO Updates to Layout

In addition to this document, a the following manual provides a description of the ADS third
party RF simulator elements:

® RF Design Tools User’s and Reference Manual Supplement: Supported ADS Library
Elements

Related Topics

RF Design Process Overview
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Chapter 2
Schematic Capture

Use the schematic capture tool to place RF symbols in a design when you have an RF license.

The following topics describe how to create an RF design:

Acquiring an RF License

Setting the RF Parameters Default Units of Measure
Setting RF Frequency Range

Adding a Substrate

Editing a Substrate

Placing RF Symbols

Creating an RF Group

Moving Members Between RF Groups
Adding an RF Varblocks

Creating Variables in RF Shape Parameters
Changing RF Symbol Parameters

RF DRC

Sending Netlist

Sending Schematic Data
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Acquiring an RF License

Acquiring an RF License

You must have an RF license to access the RF toolbar and menus in the schematic capture tool.

Prerequisites

The schematic capture tool must be open.

Procedure

1.

Choose Setup > Settings.

2. Select Licensing category.
3. Choose DxRFEngineer.
4. Click OK.

Results

The RF Toolbar appears in the schematic capture tool (RF Toolbar).

Related Topics

Setting the RF Parameters Default Units of

Setting RF Frequency Range

Measure
Adding a Substrate Editing a Substrate
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RF Toolbar

RF Toolbar

Access RF functions through the RF toolbar. Display the RF toolbar by selecting View >
Toolbars > RF (Figure 2-1).

Figure 2-1. RF Toolbar

BETEELS

RF Connect / RF DRC Setup Selactian
RF Group/Ungroup RF Parameters

The RF Toolbar provides access to the following:

RF Connect — RF Connect Functionality

RF Group/Ungroup — Creating an RF Group

RF DRC — RF DRC

RF Parameters — Changing RF Symbol Parameters
Setup Selection — RF Toolbar Setup Selections

Related Topics

Acquiring an RF License

RF Toolbar Setup Selections

Use the setup selections to define units of measure, frequency range, and substrates. Typically,
you define these items before you place RF symbols.

Note
Changes to setup selections are not retroactive. Therefore, it is strongly recommended

that you do not change any setup selections values after placing RF symbols.

The RF Toolbar setup selections provide the following:
Default Units (%) — Setting the RF Parameters Default Units of Measure
Frequency Range ( ;7 ) — Setting RF Frequency Range
Substrates (= ) — Adding a Substrate and Editing a Substrate
Related Topics

RF Toolbar Acquiring an RF License
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Placing RF Symbols
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Default Units

Default Units

To access:
* Click Default Units ({{%) (RF Toolbar)

® Choose View > RF > Default Units

Description

Use the Setup Default Units dialog box to define the unit of measure for RF symbol parameters
(Figure 2-2). To define a unit of measure, refer to Setting the RF Parameters Default Units of
Measure.

Figure 2-2. Setup Default Units Dialog Box

n Defa 1

Marme |'-.-'a|ue ~
Frequency GHz
Resistance ohim
Conduckance 5
Inductance nH
Capacitance pF

Length mils
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Angle deg

Power W —
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Current &

ST — —ile bt
< N
ADS variable handling
[ K ] [ fpply ] [ Cancel ]

Table 2-1. Setup Default Units Dialog Box Content

Field Description
Name Displays the RF parameter name (refer to Table 2-2).
Value Defines the default unit value (refer to Table 2-2).
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Default Units

Table 2-1. Setup Default Units Dialog Box Content (cont.)

Field Description
ADS variable Defines the variable evaluation method and checks compatibility with
handling Advanced Design System (ADS) (ADS RF Simulator).

Checked, converts the base unit value for the evaluation result to the default
value.

Unchecked, prevents the conversion of the base unit to the default value in
an expression.

Note:
Refer to the following for ADS variable handling examples:

® (Calculation Example with Defined Unit
* Calculation Example with Undefined Unit

Table 2-2. Setup Default Units Dialog Box - Supported Parameter Values

Parameter | Base Default | Supported Values

Name Unit Value

Frequency Hertz GHz GHz, Hz, MHz, PHz, THz, cHz, fHz, mHz, nHz, pHz, uHz

Resistance | Ohm Ohm Gohm, Kohm, Mohm, Pohm, Tohm, cohm, fohm, mohm,
nohm, ohm, pohm, uohm

Conductance | Siemen | S GS, KS, MS, PS, S, TS, ¢S, fS, mS, nS, pS, uS

Inductance | Henry |nH GH, H, KH, MH, PH, TH, cH, fH, mH, nH, pH, uH

Capacitance | Farad pF F, GF, KF, MF, PF, TF, cF, fF, mF, nF, pF, uF

Length Meter | mil Gm, Km, Mm, Pm, Tm, cm, fm, ft, in, m, mi, mils, mm,
nm, pm, um

Time Second | psec Gsec, Ksec, Msec, Psec, Tsec, csec, fsec, hr, min, msec,
nsec, psec, sec, Usec

Angle Radian | Deg deg, rad

Power Watt W GW, KW, MW, PW, TW, W, ¢cW, dBm, fW, mW, nW,
pW, uW

Voltage Volt A% GV,KV,MV,PV, TV, V, cV, fV,mV,nV, pV, uV

Current Ampere | A A, GA, KA, MA, PA, TA, cA, fA, mA, nA, pA, uA

Distance Meter | mil Gm, Km, Mm, Pm, Tm, cm, fm, m, mm, nm, pm, um

Temperature | Celsius | C C

Attenuation | Decibel | dB dB
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Default Units

Related Topics

Setting RF Frequency Range Adding a Substrate

Editing a Substrate Placing RF Symbols

RF Toolbar Setup Selections

Calculation Example with Defined Unit

This example demonstrates the variable evaluation method with a defined unit of measure
(Parameter = Length; Value = mil). Results are shown with ADS variable handling checked
and unchecked.

Description
Variable V1 and component C1 belong to the same group.

Variable V1
A=100 mil

Component C1
L=A

Default unit
Length (1 mil = 2.54e-5 meter)

ADS variable handling checked

1.
2.

3.
4.
5.

The variable evaluation equation is: 100 * 2.54e-5.

With the length (L) as a multiplier in the expression, all units are converted to the base
unit for calculations.

Result: 0.002540 meters
Convert the result from the base unit (meter) to the default value (mil).

Result: 100 mil

ADS variable handling unchecked

1.
2.

The variable evaluation equation is: 100 * 2.54e-5.

With the length (L) as a multiplier in the expression, all units are converted to the base
unit for calculations.

Result: 0.002540

The result does not contain a unit of measure, which prevents conversion to the default
value.
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Default Units

Related Topics

Calculation Example with Undefined Unit

Setting RF Frequency Range
Editing a Substrate

Setting the RF Parameters Default Units of
Measure

Adding a Substrate
Placing RF Symbols

28

RF in DxDesigner - Expedition Flow Users Manual, EE 7.9.5



Schematic Capture
Default Units

Calculation Example with Undefined Unit

The following example demonstrates the variable evaluation method with no defined unit of
measure. Results are shown with ADS variable handling checked and unchecked.

Description
Variable V1 and component C1 belong to the same group.

Variable V1
A=100+100

Component C1
L=A

Default unit
Length

ADS variable handling checked
1. The plus (+) operator indicates that the value of the base unit (A) is 200.

2. Convert the result from the base unit (meter) to the default value (mil) (1 meter =
39370.0787 mil).

3. Result: 7874015.74 mil.

ADS variable handling unchecked
1. The plus (+) operator calculates the value to 200.
2. Result: 200.

3. The result does not contain a unit of measure, which prevents conversion to the default
value.

Related Topics

Calculation Example with Defined Unit Setting the RF Parameters Default Units of
Measure

Setting RF Frequency Range Adding a Substrate

Editing a Substrate Placing RF Symbols
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Substrates

To access:
® Click Substrates (= ) (RF Toolbar)

® Choose View > RF > Substrates

Description

Use the Setup Substrates dialog box to define the default substrate for RF symbols.
Table 2-4 lists the default substrates.

Figure 2-3. Setup Substrates Dialog Box

Substrates: ﬂ
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< >

Table 2-3. Setup Substrates Dialog Box Content

Selection Description

New Creates a new substrate from a selected substrate or from the default
substrate if none is selected (Adding a Substrate).

Edit () Enables editing for the selected substrate (Editing a Substrate).

Delete Deletes the selected substrate. Default substrates cannot be deleted
(Table 2-4).
ID Specifies an ID for the substrate. You can assign multiple IDs to the same

substrate name.

Name Specifies the substrate name.

Table 2-4. Alphabetical List of Default Substrates
CPWSUB
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Table 2-4. Alphabetical List of Default Substrates (cont.)

Related Topics

Setting RF Frequency Range

Placing RF Symbols

FSUB

MLSUBSTRATE2

MLSUBSTRATE3

MLSUBSTRATE4

MLSUBSTRATES

MLSUBSTRATE6

MLSUBSTRATE7

MLSUBSTRATES

MLSUBSTRATE9

MLSUBSTRATEI10

MLSUBSTRATEI12

MLSUBSTRATE14

MLSUBSTRATE16

MSUB

PCSUBI

PCSUB2

PCSUB3

PCSUB4

PCSUBS

PCSUB6

PCSUB7

SSSUB

SSUB

SSUBO

Setting the RF Parameters Default Units of

Measure

RF Toolbar Setup Selections
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Setting the RF Parameters Default Units of
Measure

You can set the default unit of measure for any RF symbol parameter.

Use the following procedure to set the default unit for an RF symbol parameter. The following
example uses the Frequency parameter value.

Prerequisites
® A schematic capture project must be open.

® The RF toolbar must be displayed (RF Toolbar).

Procedure
1. Click Default Units () in the RF toolbar.
2. Click the Value cell for the Frequency parameter.

3. Select the new unit of measure from the dropdown list (Figure 2-4).

0 Tip: Stretch the dialog box horizontally so you can see both columns as you make
changes.
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Figure 2-4. Setup Default Units Dialog Box - Frequency
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4. Click Apply to save and continue making changes, or click OK to save and exit.

Results

The default unit of measure for Frequency changes to the selected value.

Related Topics

Setting RF Frequency Range Adding a Substrate
Editing a Substrate Placing RF Symbols
Default Units RF Toolbar Setup Selections

Setting RF Frequency Range

Use this procedure to define the frequency range of the RF design.

Prerequisites
® A schematic capture project must be open.

® The RF toolbar must be displayed (RF Toolbar).

RF in DxDesigner - Expedition Flow Users Manual, EE 7.9.5
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Procedure
1. Click Frequency Range ( ;7 ) in the RF toolbar (Figure 2-5).

Figure 2-5. Setup Dialog Box
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2. Enter the minimum and maximum values (in GHz) for the frequency range.

Note
The values are in GHz. You can change the unit of measure for Frequency in the Setup

Default Units dialog box.

3. Click OK.

Results

The frequency range of the RF design is defined.
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Related Topics

Adding a Substrate Editing a Substrate

Setting the RF Parameters Default Units of Placing RF Symbols
Measure

RF Toolbar Setup Selections

Adding a Substrate

Substrates determine RF symbol characteristics. The RF tool set includes a group of predefined
substrates (Table 2-4). You can also create a custom substrate using one of the predefined
substrates as a seed.

Prerequisites

* A schematic capture project must be open.

® The RF toolbar must be displayed (RF Toolbar).

Procedure
1. Click Substrates ( = ) in the RF toolbar.

2. Select an existing substrate that closely matches the parameters you want in your new
substrate

3. Click New ( ER).
4. Rename the ID and Name of the RF substrate.

5. Make additional changes to the Values in the Select parameters table to define the new
substrate.

6. Click Apply.

Results

The new substrate appears in the Substrates list after the substrate you originally selected as the
seed.

Note
You cannot reorder the list of substrates.
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Related Topics

Editing a Substrate Setting RF Frequency Range
Setting the RF Parameters Default Units of Placing RF Symbols
Measure

Substrates RF Toolbar Setup Selections

Editing a Substrate

Use the following procedure to change an RF substrate’s parameters.

Prerequisites

A schematic capture project must be open.

The RF toolbar must be displayed (RF Toolbar).

Procedure

1.

Click Substrates ( == ) in the RF toolbar.

2. Select the substrate you wand to edit in the Substrates table.

3. Click Edit (). The Substrates properties dialog box displays.
4.
5
6
7

Click in the Value cell for the parameter you want to change.

. Under the Parameters section, enter a new value in the Value text box.
. Select the appropriate unit of measure in the Units dropdown list.

. Click Apply.

Results

The changes are saved.

Related Topics

Adding a Substrate Setting RF Frequency Range

Setting the RF Parameters Default Units of Placing RF Symbols
Measure

RF Toolbar Setup Selections
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Placing RF Symbols

Create RF circuits in the schematic capture tool by placing RF symbols in your design.

Use the following procedure to place RF symbols in your design.

Prerequisites
* A schematic capture project must be open.
* RF symbols must be in the Central Library (Adding ADS RF Shapes to Central Library
and Adding AWR/MWO RF Shapes to Central Library).
Procedure
1. Click DxDataBook ) in the DxDesigner toolbar.
2. Select the CL View tab.
3. Choose the Symbol View tab (Figure 2-6).

Figure 2-6. DxDataBook - Symbol View Window
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4. Expand the RF partition that contains the RF symbol you want to place.
5. Select the RF symbol from the expanded list.

6. Place the RF symbol by dragging the symbol from the Place Symbol window into the
drawing workspace and dropping it at the correct location.

Results

The RF symbol appears in the schematic.
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Related Topics

Creating an RF Group

Creating Variables in RF Shape Parameters

Adding an RF Varblocks
RF DRC

38
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RF Group/Ungroup Dialog Box

To access:

® Click RF Group/Ungroup (35) (RF Toolbar)
® Choose View > RF > RF Group/Ungroup.

Description

Use the RF Group/Ungroup dialog box to group or ungroup RF and non-RF symbols. You can
group relevant RF circuitry by functionality or area. A symbol can only belong to one RF group,
but a group can span several sheets and multiple schematics. You can create both RF groups and
RF subgroups within RF groups. You can create any number of RF subgroups (Figure 2-7).

Note
D Adding non-RF symbols into an RF group does not convert them to RF symbols. They
remain regular symbols that are members of an RF group or subgroup.

Figure 2-7. RF Group/Ungroup Dialog Box
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RF Group/Ungroup Dialog Box

Table 2-5. RF Group/Ungroup Dialog Box Content

Field Description

New Adds a new RF group with the selected heading name with an appended
number.

Undo < Restores the last deleted RF group with members.

Redo Reverses the previous Undo.

Delete Deletes the selected RF group and subgroups. Members of the RF group and

subgroups are placed in the Default RF group.

Treeview area

Displays the project tree. This is identical to the Navigator window RF
Groups tab (Navigator RF Groups Tab).

items to group

Members Lists all the symbols within an RF group.

Remove Click, removes selected members from the RF group and places them in the
Default RF group. Use Ctrl or Shift to select more than one item.

Add selected | Click, adds the selected symbol(s) to the active RF group.

Fit view Checked, selected objects fit into the dialog box viewer.

Select Checked, enables cross probing between the RF Group/Ungroup dialog box
and the schematic capture tool.

Update block | Checked, updates the block level value (RF Parameters Dialog Box -

value Schematic Capture).

Unselected, updates only the instance value.

Table 2-6. RF Group/Ungroup Dialog Box Treeview Popup Menu Items

Selection Description

Add group Creates an RF group under the selected item in the treeview area.

Delete Deletes the selected RF group. If there are members within the RF group, a
confirmation dialog box appears. Selecting Yes deletes the RF group and
subgroups. Members within the deleted RF groups become part of the Default
RF group.

Rename Enables renaming of the selected RF group.
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Table 2-6. RF Group/Ungroup Dialog Box Treeview Popup Menu Items (cont.)

Selection Description
Generate Creates a netlist, HTML, and xml file at the following locations:
netlist <project directory>\RF\netlist\<project name>_<group
name>_<current date (yyyymmdd)>_<current time (hhmmss)>.net
<project directory>\RF\netlist\html\<project name>_<group
name>_<current date (yyyymmdd)>_<current time
(hhmmss)>.html
<project directory>\RF\netlist\xml\<project name>_<group
name>_<current date (yyyymmdd)>_<current time (hhmmss)>.xml
Send netlist | Sends a schematic capture RF group netlist to the ADS RF Simulator (Sending
Netlist). The dynamic link must be connected and an RF project needs to be
open in the RF simulator (Connecting Schematic Capture to RF Simulator
Server).
Import Synchronizes the Central Library (CL) with the RF simulator library. If there is
Library a difference, the RF simulator updates the CL (Adding ADS RF Shapes to
Central Library and Adding AWR/MWO RF Shapes to Central Library).
Generate Creates a .iff file (Interchange File Format) at the following locations:
Schematic
Data <project directory>\RF\iff\<project name>_<group
name>_<current date (yyyymmdd)>_<current time (hhmmss)>.iff
<project directory>\RF\xml\<project name>_<group
name>_<current date (yyyymmdd)>_<current time (hhmmss)>.xml
Send Sends a .iff file to the ADS RF Simulator or MWO RF Simulator (Sending
Schematic Schematic Data). The schematic capture tool must be connected to the RF
Data simulator with an active RF project (Connecting Schematic Capture to RF

Simulator Server).

Related Topics

Creating an RF Group
Placing RF Symbols
Sending Schematic Data

Moving Members Between RF Groups
Adding an RF Varblocks
Sending Netlist

RF in DxDesigner - Expedition Flow Users Manual, EE 7.9.5 41




Schematic Capture
Creating an RF Group

Creating an RF Group

When you create an RF group, you can send that group’s netlist or schematic data to the RF
simulator.

Use the following procedure to create an RF group.

Prerequisites

A schematic capture project must be open.

The RF toolbar must be displayed (RF Toolbar).

Procedure
1. Click RF Group/Ungroup (38) in the RF toolbar.
2. Select a level in the treeview area.
3. Click New .
4. Select the new RF group.
5. Choose Rename from the popup menu and type in the new RF group name.
6. Select the RF and non-RF symbols on the schematic that you want to be part of the new
RF group.
7. Click Add selected items to group.
Results

The selected symbols become members of the new RF group.

Related Topics

Moving Members Between RF Groups Sending Netlist
Sending Schematic Data Adding an RF Varblocks

Creating Variables in RF Shape Parameters RF Group/Ungroup Dialog Box
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Moving Members Between RF Groups

You can move group members between RF groups to simulate specific functions or areas within
the RF design.

Use the following procedure to move members between RF groups.

Prerequisites
* A schematic capture project must be open.

® The RF toolbar must be displayed (RF Toolbar).

Procedure
1. Click RF Group/Ungroup (38) in the RF toolbar.
2. Select the RF group that contains the members to be moved.
3. Select the members to be moved. Use Ctrl or Shift to select more than one item.
4

. Drag-and-drop the selected members to the other RF group in the treeview area,

Results

The selected members move to the other RF group.

Related Topics

Creating an RF Group Sending Netlist
Sending Schematic Data Adding an RF Varblocks
Creating Variables in RF Shape Parameters RF Group/Ungroup Dialog Box
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Navigator RF Groups Tab
To access: Choose View > Navigator > RF Groups tab

Description

Use the Navigator RF Groups tab to view the RF design hierarchy (Figure 2-8). Popup menu

selections differ depending on the hierarchy level you select (Figure 2-9).

Figure 2-8. Navigator Window - RF Groups Treeview Area
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Figure 2-9. Navigator Window - RF Group Popup Menus
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Navigator RF Groups Tab

Group/Subgroup right-click menu
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Table 2-7. Navigator Window - RF Groups Tab Treeview Popup Menu

Selections
Selection Description
RF DRC Runs RF DRC on the selected RF group and displays the results in the
Output > RF DRC tab window (RF DRC).
RF Connect Opens the RF Connect Dialog Box (Schematic Capture).
Group/Ungroup | Opens the RF Group/Ungroup Dialog Box.

RF Parameters

Opens the RF Parameters Dialog Box - Schematic Capture.

Setup

Enables the following setup selections:
* Default Units — Setting the RF Parameters Default Units of Measure
* Frequency Range — Setting RF Frequency Range
* Substrates — Adding a Substrate and Editing a Substrate

Generate netlist

Refer to Table 2-6.

Send netlist

Refer to Table 2-6.

Generate
Schematic Data

Refer to Table 2-6.

Send Schematic
Data

Refer to Table 2-6.

Related Topics

Creating an RF Group

Moving Members Between RF Groups

RF DRC

Changing RF Symbol Parameters

Connecting Schematic Capture to RF
Simulator Server
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Sending Netlist

To simulate an RF group netlist, you must send the netlist to the RF simulator.

Use the following procedure to send an RF group netlist to the RF simulator:

Prerequisites

* A dynamic link must exist between the RF server and the schematic capture tool
(Connecting Schematic Capture to RF Simulator Server).

® A design must be open in the RF simulator.

Procedure
1. Click RF Group/Ungroup (38) in the RF toolbar.
2. Select an RF group.
3. Choose Send netlist.

Results

The RF group appears in the RF simulator design.

Related Topics

Sending Schematic Data Creating an RF Group
Generate netlist Generate Schematic Data
Moving Members Between RF Groups Navigator RF Groups Tab
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Sending Schematic Data

To simulate RF group schematic data, you must send the schematic data to the RF simulator.

Use the following procedure to send schematic data to the RF simulator.

Prerequisites

* A dynamic link must exist between the RF server and the schematic capture tool
(Connecting Schematic Capture to RF Simulator Server).

® A design must be open in the RF simulator.

Procedure
1. Click RF Group/Ungroup (38) in the RF toolbar.
2. Select an RF group.

3. Choose Send Schematic Data in the popup menu.

Results

The RF group appears in the RF simulator design.

Related Topics

Sending Netlist Creating an RF Group
Generate netlist Generate Schematic Data
Moving Members Between RF Groups Navigator RF Groups Tab
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RF Parameters Dialog Box - Schematic Capture
Scope: DxDesigner

To access:

® Click RF Parameters () (RF Toolbar).
® Choose View > RF > RF Parameters.
* Choose Navigator > RF Groups tab > Schematic, choose RF Parameters.
® Click an RF DRC Error or Warning message (RF DRC).
Description

Use the RF Parameters dialog box to define the RF symbol parameters (Changing RF Symbol
Parameters).

Figure 2-10. RF Parameters Dialog Box
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RF Parameters Dialog Box - Schematic Capture

Table 2-8. RF Parameters Dialog Box Content

Element

Description

RF Component
Name

Displays the name of the selected RF symbol.

Instance name

Displays the schematic number, instance name, and reference designator
of the RF component.

Undo ﬂ

Removes the latest changes in the select parameter field.

Redo

Reinstates the Undo changes.

Parameters section — Displays the selected parameter information.

Name Displays the name of the selected parameter.
Value Defines the parameter value. Change the value as needed:

® Real numbers require the format 0.0.

* Evaluated expressions require parentheses “()”.

® Supported arguments are listed in Equation Editor Expressions.
Unit Defines the parameter units. Choose from the dropdown list.
Equation Editor | Clicked, opens the RF Equation Editor Dialog Box (Figure 2-13 and

Creating Variables in RF Shape Parameters).

Select parameter

section — Lists the selected RF symbol parameters in the table.

Parameters items

Lists the following RF symbol parameters:
Name — The name of the parameter.
Value — The value of the parameter. Use the dropdown arrow to display
alternate selections.
Value Type — Defines the level of the parameter value.
* Instance — Parameter uses the instance level value.
* Block — Parameter uses the block level value.
* Symbol — Parameter uses the symbol level value.

Note: The top-down hierarchical order for the Value type is: Instance,
Block, Symbol.

Add Click, adds the Equation Editor variable to the VARBLOCK.
Cut Click, removes the selected variable from the VARBLOCK.
Paste Click, reinstates the Cut changes.

Information Displays information about the selected parameter.

Banner

Toggle values

Checked, the numerical value appears in the Value field.
Unchecked, the expression appears in the Value field.
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RF Parameters Dialog Box - Schematic Capture

Table 2-8. RF Parameters Dialog Box Content (cont.)

Element Description

Update block Checked, updates the Block level value types.
value Unchecked, updates only the Instance level value types.

Related Topics

Adding an RF Varblocks
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Adding an RF Varblocks

You can add an RF VARBLOCK to an RF group and create variables. Use VARBLOCK
variables to define RF symbol parameters. Any change to a VARBLOCK variable
automatically changes the variable in the RF symbol parameter.

Use the following procedure to add an RF VARBLOCK to an RF group.

Prerequisites
* A schematic capture project must be open.

® The RF toolbar must be displayed (RF Toolbar).

Procedure
1. Select an RF group.
2. Click DxDataBook (@p in the DxDesigner toolbar.
3. Click the CL View tab.
4. Click the Symbols View tab and choose RF_Varblocks (Figure 2-11).

Figure 2-11. RF_Varblocks Selection
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5. Place the VABLOCK symbol by dragging the symbol from the Place Symbol window
into the drawing workspace and dropping it at the correct location. (Placing RF
Symbols).

Results

The VARBLOCK symbol appears in the design and becomes a member of the selected RF
group.
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Related Topics

Creating Variables in RF Shape Parameters Using Variables in RF Parameters
Creating an RF Group RF Parameters Dialog Box - Schematic
Capture

Equation Editor Expressions

Creating Variables in RF Shape Parameters

Create VARBLOCK variables so they define RF symbol parameters. When you change a
VARBLOCK variable, you change all the RF symbol parameters that are defined with that
variable.

Use the following procedure to create VARBLOCK variables.

Prerequisites
®* The VARBLOCK is part of an RF group (Adding an RF Varblocks).

Procedure
1. Select the VARBLOCK.
2. Click RF Parameters () in the RF toolbar.

3. Type the variable name in the Name field (Figure 2-12).
Note

The Name text box accepts all alphanumeric characters (a-z, A-Z, 0-9) with no spaces.
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Figure 2-12. RF Parameters Dialog Box - VARBLOCK
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4. Type a value in the Value text box.
5. Click Add.

Results

The Select parameter section of the RF Parameters dialog box lists the new variables.

Related Topics

Using Variables in RF Parameters Changing RF Symbol Parameters
RF DRC RF Parameters Dialog Box - Schematic
Capture

Equation Editor Expressions

Using Variables in RF Parameters

You can use variables to define RF parameters. When you change the variable, all of the RF
parameters that are defined with that variable change accordingly.

Prerequisites
* The VARBLOCK is part of an RF group (Adding an RF Varblocks).
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* The VARBLOCK contains variables (Creating Variables in RF Shape Parameters)

Procedure
1. Select the RF symbol.
2. Click RF Parameters () in the RF toolbar.
3. Select the parameter Value.
4. Click Equation Editor.

Type the equation in the Parameter text box. In this example, the variable z was added to
the Parameter text box (Figure 2-13).

a. Select z in the Variables list.
b. Click << Insert.

In this example, the variable z was added to the Parameter text box (Figure 2-13).

Figure 2-13. RF Equation Editor Dialog Box - Variable
R Equation Editor

Parameter Wariables
W3 %
ho.o+z | E=lnsert y

(e | | Zancel

5. Click OK.
The RF Equation Editor dialog box closes and the RF Parameters dialog box becomes
active.
Results

The revised equation appears in the Value cell of the RF Parameters dialog box.
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Related Topics

Creating an RF Group Changing RF Symbol Parameters
RF DRC Equation Editor Expressions

RF Parameters Dialog Box - Schematic
Capture

Changing RF Symbol Parameters

You can change RF symbol parameters as needed to meet design requirements.

Use the following procedure to change the RF symbol parameters.

Prerequisites
® The RF design contains RF symbols (Placing RF Symbols).

Procedure
1. Select an RF symbol.
2. Click RF Parameters ([]) in the RF toolbar.

3. Click the Value cell for the parameter you want to change (RF Parameters Dialog Box -
Schematic Capture).

RF in DxDesigner - Expedition Flow Users Manual, EE 7.9.5 55



Schematic Capture
RF DRC

Figure 2-14. RF Parameters Dialog Box - Change Parameter

Parameters

Iristance name: Mare: '-.-'-.-' ]
Schematic1|$1133(RF12){min. 1) e E_EﬁES_}__: bk o - |
Select parameter I Equation editar .l

Harrie Yalue Default ~

od Kirschning

RF_REGION Meswgroupl

Subst MSubl MSubl

Temp

1 | (0.635) rmm 0.635mm

Walll Omm Ormrn ¥

_¢.. = ! _>-.

Add ik Paske

Lire: widthr

[]Toggle values [ ]update block value | Apply

4. Under the Parameters section, enter a new value in the Value text box.
5. Select the appropriate unit of measure in the Units dropdown list.

6. Click Apply.

Results
The Select parameter table shows the new value for the parameter.
Related Topics

Sending Netlist Sending Schematic Data
RF DRC

RF DRC

Design Rule Checking (DRC) applies to the RF group and its subgroups. RF DRC checks the
dimensions of the RF symbol in conjunction with the RF frequency range.
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RF DRC

RF DRC checks the complete design. If you want to run RF DRC on a specific hierarchical
level (Table 2-7), select the RF Group in the Navigator window, right-click and choose RF
DRC from the popup menu.

Use the following procedure to run RF DRC.

Procedure
1. Click RF DRC () in the RF toolbar.
2. Select the RF DRC tab on the Output window (Figure 2-15).

Figure 2-15. RF DRC Output Window
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3. Click any of the Error or Warning messages to highlight the offending symbol in the
design.

4. Alter the RF design as needed to resolve the errors or warnings.

5. After resolving all of the errors and warnings, run RF DRC again to be sure everything
is correct.

Results

If all of the DRC errors have been resolved, the Output window will report zero Errors and zero
Warnings.
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Related Topics

Sending Schematic Data Sending Netlist
Changing RF Symbol Parameters Navigator RF Groups Tab
RF Group/Ungroup Dialog Box Setting RF Frequency Range

RF Connect Functionality

The RF connect functionality enables the schematic capture tool to connect to the RF simulator
server. RF groups in the schematic capture tool are sent to the RF simulator with the dynamic
link. Send the RF simulator changes back to the schematic capture tool to update the RF group
(Connecting Schematic Capture to RF Simulator Server).

Related Topics

RF Toolbar RF Connect Dialog Box (Schematic Capture)
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Chapter 3
Forward Annotation

RF shapes are built in the layout tool as conductive shapes. RF shapes are modeled as a
component and a cell. The Central Library (CL) contains a subset of the RF simulator RF
shapes. Add RF shapes to the Central Library (Adding ADS RF Shapes to Central Library and
Adding AWR/MWO RF Shapes to Central Library).

Each RF part has a part number RFPART (ELEMENT NAME), where ELEMENT NAME is
the RF Shape name. Choose Tools > Package to create a temporary cell name

RFCELL (ELEMENT NAME), where ELEMENT NAME is the RF Shape/Symbol name.
The cell has the same number of pins as the symbol and is stored in the local design Central
Library (Figure 3-1).

When you first place an RF shape in the schematic, the RFPART property is stored as part of
the symbol. The reference designator (refdes) of the RF shape/symbol is the cell name. If two or
more cells have the same cell name, the reference designators are incremental. For example,
RF _MLIN <n>, where n is an integer and ELEMENT NAME is MLIN1, MLIN2 and so on.

On Forward Annotation (FA), the RF synthesis engine re-synthesizes the RF shape to its correct
size based on the parameters of the schematic symbol. These parameters are stored as a property
on the symbol named RF Parametric.

Forward annotate your design in schematic capture by choosing Tools > Launch Expedition or
click Expedition PCB (= ). In Expedition PCB, select the RF Toolkit and then choose Place >
Place Parts and Cells to view unplaced RF Groups.
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Figure 3-1. Automatic Cell Creation in RF Flow
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Setup > Padstack : Padstacks — The RF pad name for an RF cell and RF parts is rfpad. The
rfpad is only available to the RF cells and RF parts (Figure 3-2).
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Figure 3-2. RF Pad and Part Name - rfpad
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Setup > Cells Editor — RF cells are generic in nature and have a set number of pins. All pins
are assigned to rfpad and are not editable (Figure 3-3).

Figure 3-3. RF Cell Pins Name
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Setup > Parts Editor — The RF part name is unique to the part placed (Figure 3-4).

Related Topics

Getting Started

Figure 3-4. RF Part Name - Placed
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RF Layout
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Chapter 4
RF Layout

After you have Forward Annotated a schematic capture RF design you can place the RF parts
from the layout tool, just as you would any other part.

This chapter covers the following topics:

* RF Toolkit Toolbar

® Creating and Modifying RF Shapes

® C(Creating and Modifying Nodes

® Using RF Groups

* Setting Clearances, Copying, and Creating Adjacent Layer Clearances
® Using Variables

* Editing Existing RF Shapes
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Opening a PCB for RF Design

Opening a PCB for RF Design

Before you can access an RF design in the layout tool you need an Advanced Technology Pro
(RF) license. Acquire an Advanced Technology Pro (RF) license with one of the following
methods:

* In the layout tool splash screen, check Advanced Technology Pro (RF).

* In the layout tool select Setup > Licensed Modules > Advanced Technology Pro
(RF).

When you have an Advanced Technology Pro (RF) license, the RF Toolkit (£,) is selectable.

Related Topics

RF Layout RF Toolkit Toolbar

Opening the RF Toolkit

The RF Toolkit ®, enables you to create and modify RF designs in the layout tool.

To enable the RF Toolkit, click RF Toolkit &, in the Standard toolbar. You can then access the
RF tools/commands with one of the following methods:

® Choose Setup > RF.
® The RF toolbar.

* RF from the workspace popup.

RF Toolkit Toolbar

The RF Toolkit enables you to create and modify RF designs in the layout tool. The RF Toolkit
toolbar becomes active when you enable the RF Toolkit &, (Figure 4-1).

Note
You must have an Advanced Technology Pro (RF) license to enable and access the RF

Toolkit.
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Figure 4-1. RF Toolkit Icon and RF Toolbar
RF Toolkit Icon

o Hl é | , @SS T :-;,;@ D ®

PEEFW L8 L TRRVER T BmREE B
| ‘ | RF Toolbar
RF Shape RF Node and Segment ~ RF Toolbar Commands and
Commands Commands Menu Selections
Related Topics
Creating and Modifying a Meander Creating and Modifying RF Shapes

RF Action Keys RF Layout

RF Shape Commands

The RF shape commands enable you to manipulate RF shapes in the layout tool. Table 4-1 lists
the RF shape commands and operations.

Table 4-1. RF Shape Toolbar Commands

Command Operation Library | Meander
shape

Move shape Connecting RF Shapes by Moving Yes Yes

Angle shape 3 Rotating an RF Shape Yes Yes

Mirror about X & | Mirroring an RF Shape Yes Yes

Mirror about Y gt | Mirroring an RF Shape Yes Yes

Copy 0y Copying a Meander No Yes
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Related Topics

Creating and Modifying a Meander Creating and Modifying RF Shapes
RF Toolkit Toolbar RF Node and Segment Commands
RF Action Keys RF Toolbar Commands and Menu Selections

RF Node and Segment Commands

The node and segment commands enable you to place, add, and delete nodes on RF shapes.
Table 4-2 lists the RF node and segment commands and operations.

Table 4-2. RF Node and Segment Toolbar Commands

Command Operation Library | Meander
Shape

Add edge node Adding an Edge Node* Yes Yes

Add floating node x* Adding a Floating Node* Yes Yes

Add segment _& Adding a Segment No Yes

Add stub gt Adding a Stub No Yes
Delete node stub g Deletes the selected node stub. No Yes
Delete floating node Deletes the selected floating node. No Yes

* You can also define the node entry angle — RF Entry Rules Dialog Box

Related Topics

Creating and Modifying a Meander Creating and Modifying RF Shapes
RF Toolkit Toolbar RF Shape Commands
RF Action Keys RF Toolbar Commands and Menu Selections

RF Toolbar Commands and Menu Selections

The RF toolbar commands and menu selections enable you to create RF shapes and specify their
properties and entry rules (Table 4-3).

Table 4-3. RF Toolbar Command and Menu Summary

Command Description

Add Meander/Start Meander g Opens the Meander Properties Dialog Box.
Use the Meander properties dialog box to
define the meander properties.

Delete meander 5] Deletes the selected meander.
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Table 4-3. RF Toolbar Command and Menu Summary (cont.)

Command

Description

Add Meander Segment _s*

Adds a segment by changing the selected
segment into two segments (Adding a
Segment).

Edit Meander T

Alters the angle of the selected meander
and segment position (Editing a Meander).

Convert RF shape p

Converts a conductive polygon to an RF
shape. Refer to Creating a Custom RF
Shape.

Parametric properties/RF Parameters

Opens the RF Shape Parameters Dialog
Box in which you alter RF shapes and
define Var block variable parameters.

Group/Ungroup 22

Opens the Group/Ungroup Dialog Box in
which you alter RF groups containing RF
shapes and non-RF shapes.

Control pane/RF Counterpane *

Opens the RF Control Dialog Box in which
you alter RF design hierarchy. You can also
access RF group, segment, and node
property values with the RF Design tab and
view RF library shapes with the RF Library
Shapes tab.

Clearance rules g5

Opens the Clearance Editor Dialog Box in
which you define RF shape and segment
clearances.

Group Clearance Rules (menu selection
only)

Opens the RF Group Clearance Rules
Dialog Box in which you define RF group
level clearances for an RF shape to trace,
pad, via, plane, and top and bottom solder
mask.

Entry rules =

Opens the RF Entry Rules Dialog Box in
which you define the node entry angles for
node-to-node and node-to-trace
connections.

Place vias i

Opens the Place Via Dialog Box in which
you place stitching vias.

RF Connect m2

Opens the RF Connect Dialog Box
(Layout) in which you connect the layout
tool to an RF simulator for bidirectional
data transfers.
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Table 4-3. RF Toolbar Command and Menu Summary (cont.)

Command

Description

Selection Filter

Opens the Selection Filter Dialog Box in
which you define selectable objects in the
layout tool.

Related Topics

Creating and Modifying a Meander
Creating and Modifying Nodes

RF Node and Segment Commands
RF Action Keys

Creating and Modifying RF Shapes
Using RF Groups

RF Shape Commands

RF Toolkit Toolbar
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RF Action Keys

The Action Keys at the bottom of the work area provide quick access to commonly used
commands. Figure 4-2 shows the RF Action Keys.

Figure 4-2. RF Action Keys

1 Help |2P1aceHF5hapes] 3Hc.uteHF5hapes] 4 Edit RF Shapes | 5 Slitch Vias [ & Undo |

7 Redo 11 Group/Ungroup | 12 Previous Mode
| | | | | |

Table 4-4. Action Keys Summary

Action Key Description

F2 Opens the Place Parts and Cells dialog box with which you can place RF
Place RF shapes groups, RF shapes, and parts in your design.

F3 Enables you to route RF shapes.
Route RF Shapes | The Action keys change as follows:
F2 Add Meander — Opens the Meander Properties Dialog Box.

F4 Enables you to edit RF shapes.
Edit RF Shapes

F5 Opens the Place Via Dialog Box, with which you can place stitching
Stitch Vias vias.
F11 Opens the Group/Ungroup Dialog Box, with which you can group

Group/Ungroup design objects into RF groups.

Related Topics

Creating and Modifying a Meander Creating and Modifying RF Shapes
Creating and Modifying Nodes Using RF Groups
RF Toolkit Toolbar RF Shapes
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RF Shapes

RF shapes are conductive polygons used to connect parts or build other RF shapes.

All RF shapes in the library may be forward- and back-annotated between the schematic capture
and layout tools. If you change RF shape parameters, the parameters are also updated when you
perform forward- and back-annotation.

You define clearance rules for RF shapes with the Clearance Editor Dialog Box.

Related Topics

Creating and Modifying a Meander Creating and Modifying RF Shapes
RF Standard Shapes Meander
User-defined RF Shapes

RF Standard Shapes

An RF standard shape is a pre-defined RF shape. RF standard shapes are available from the
library (Adding ADS RF Shapes to Central Library and Adding AWR/MWO RF Shapes to
Central Library).

You can view RF library with the RF Control Dialog Box, RF Library Shape tab. Standard RF
shapes consist of one or two nodes (connection points) and a segment. As an example,

Figure 4-3 shows a one and two segment RF shape with two nodes. A node is a connection
point on an RF shape (RF Shape Node Types).

RF standard shapes are listed in RF Design Tools User's and Reference Manual Supplement.

Related Topics

Creating and Modifying a Meander Creating and Modifying RF Shapes
Meander User-defined RF Shapes
Meander

A meander is a segment or a series of segments of conductive RF shapes (Figure 4-3). Add a
meander (RF shape) to connect parts or build a complex RF shape in layout.

Note
Meanders are not back-annotated to the schematic capture tool, and all meander nodes

have the same net name.
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Figure 4-3. Meander Segments

Seament

|  Node
| ] Clearance

_______Sement L Seament

A meander contains at least one segment. You can create a meander with different corners,
radii, and/or straight segments with varying widths (Figure 4-4).

Figure 4-4. Meander Examples

Related Topics

Creating and Modifying a Meander Creating and Modifying RF Shapes
RF Standard Shapes User-defined RF Shapes

User-defined RF Shapes

You can create a custom RF shape with standard RF shapes and meanders as shown in
Figure 4-5 (Creating a Custom RF Shape).

You can add custom RF shapes to your library, which you can then place in the schematic
capture tool (Creating a Custom RF Shape).
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Figure 4-5. Custom RF Shape

Once a segment is part of an RF shape, you cannot move the segment independently of the
entire RF shape.

When you create a custom RF symbol with schematic representation, the nodes are
automatically mapped to pins on the schematic symbol.

Related Topics

Creating and Modifying a Meander Creating and Modifying RF Shapes
Meander RF Standard Shapes

Parametric RF Shape

A parametric RF shape has no fixed size or value. When you generate a meander or select an RF
shape from the library, you create a parametric RF shape in your design. To access the
parameters of an RF shape either:

* Double-click the RF Shape.
* Select the RF shape and choose RF > RF Parameters from the popup.
Related Topics

Creating and Modifying a Meander Creating and Modifying RF Shapes
Meander RF Standard Shapes

RF Shape Parameters

Each meander in an RF shape has specific parameters. You can view the RF shape parameters
with the RF Control Dialog Box. The RF Design tab lists the selected RF shape parameters.
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Changing Snap Points

A snap point is a location on an RF shape to which the cursor attaches when you move an RF
shape. The nodes of an RF shape are snap points, as is the center of the RF shape. When you
select an RF shape, the cursor snaps to the center of the RF shape by default (Figure 4-6).

Procedure
® Change the snap point with the TAB key.

Figure 4-6. Snap Points on a Single Segment
Nodes A Single RF segment

Initial selection
Center snap point

TAB Key,
Left node snap point

2nd TAB Key
Right node snap point

Related Topics

Creating and Modifying a Meander Creating and Modifying RF Shapes
Connecting RF Shapes by Moving Auto Arranger
RF Shapes Open and Floating RF Shapes
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Open and Floating RF Shapes

RF shapes with at least one unconnected node are called open RF shapes (Figure 4-7). RF
shapes with every node connected are called floating RF shapes.

Note
D DRC checks both open and floating RF shapes.

Figure 4-7. RF Shape - Open Node

Related Topics

Creating and Modifying a Meander Creating and Modifying RF Shapes
Creating a Meander Changing an RF Net Name
Changing Snap Points RF Shape Node Types
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RF Shape Node Types

A node is a connecting point of an RF shape. An RF shape can have the following types of
nodes:

* Edge node — A node placed on the edge of an RF shape (Adding an Edge Node).

* End node — A node that has only one adjacent segment.

* Floating node — A node placed on a library or custom RF shape that connects objects
(Adding a Floating Node).

* Inner node — A node having two or more adjacent segments even if those segments
belong to more than one RF shape.

When you connect RF shapes, End nodes can become Inner node as shown in Figure 4-8.

Figure 4-8. Inner Nodes

Microstrip Line

# End node

Microstrip Line

N Edge node

Both shapes Microstrip Corner
have two End

nodes Node 2 of microstrip line and

Node 1 of microstrip corner
Microstrip Corner become an Inner node.

Related Topics

Setting RF Shape Node Entry Angle Connecting Nodes and Pads with an RF Shape
Changing an RF Net Name Creating and Modifying Nodes
Floating and Edge Nodes Node-to-Node and Node-to-Trace Rules
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Node-to-Node and Node-to-Trace Rules

Use the RF Control Dialog Box, RF Design tab to set the node-to-node and node-to-trace rules.

Figure 4-9 shows RF shapes with their connectivity rules (red) and the entry angle (green
arrow). When you select RF shapes and choose RF > Auto Arranger, the selected RF shapes
rotate and move to meet the entry and connectivity rules. In the example Figure 4-9 shows the
results of the Auto Arranger (right side).

Figure 4-9. Node to Node Rules

‘—(- e

/,

‘_! n—>
Related Topics

Setting RF Shape Node Entry Angle Connecting RF Shapes by Moving
RF Shape Node Entry Angle Creating and Modifying Nodes

Multiple Nets and Pad Connections

You can connect nets with an RF shape. Figure 4-10 shows an RF shape connecting four
different nets, which creates an electrical RF net (Connecting Nodes and Pads with an RF
Shape).
Figure 4-10. Connecting Multiple Nets
Net 1 Net 5

An RF shape
connecting four
different nets.

Net 7

Net 9 /

Related Topics

Creating a Custom RF Shape Changing an RF Net Name
Connecting RF Shapes by Moving Adding a Stub
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Floating and Edge Nodes

Floating nodes and edge nodes are differentiated by their placements on an RF shape. Floating
nodes can occur anywhere on an RF shape. Edge nodes can only occur at the edge of an RF
shape. Both types of nodes enable connections to pads, traces, vias, and RF shapes. Refer to
Adding a Floating Node and Adding an Edge Node.

Floating and edge nodes cannot move between RF shapes and they are not back annotated.
When you add a floating or edge node to an RF shape, you can assign the node, node-to-node
and node-to-trace rules (RF Control Dialog Box).

When you add a floating node, you assign the node to an existing schematic capture (or parent)
node. The floating node is always associated with a schematic capture node within the RF
shape. The node is never associated with a net. The parent node (schematic capture node), child
node (floating or edge node), and RF shape always belong to the same net. When you assign a
net to an edge node, it is also assigned to the floating node.

If you change a parent node name in the schematic capture tool, the floating node and/or edge
node name assumes the parent node name during Forward Annotation (FA).

Additional information about floating and edge nodes:

® Parent nodes cannot be deleted in the schematic capture tool.

® The child node is associated with a parent node, which prevents floating or edge node
changes.

®* You cannot change connectivity in the layout tool.

®* When you add a floating or edge node, you must define both net and entry rules to
enable connection (Changing an RF Net Name and Setting RF Shape Node Entry
Angle).

®* When you push, rotate, or mirror an RF shape with floating nodes, the position and node
name remain the same within the RF shape.

®* When you update RF shapes that contain floating nodes, they are flagged as violations
(RF Expired Nodes).

* Floating nodes in violation are reported until you manually change the node’s Expired
property in the RF Control Dialog Box pin properties.

Related Topics

Connecting Nodes and Pads with an RF Shape Node-to-Node and Node-to-Trace Rules
Creating and Modifying Nodes
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Mirror about X/Y

enable you to mirror an RF shape or an RF group (a combination of RF shapes and non- RF
shapes) about the X or Y axes (Mirroring an RF Shape and Adding an RF Group or RF

Subgroup).

Non-RF parts in an RF group are mirrored only under the following conditions:

® The part must have two or more pins.

® The part must be a surface mounted or an embedded part.

® The part cannot be a through-hole part.

® The part pads must be square or rectangle.

Example 1

Figure 4-11 shows the mirroring about the X and Y axis at the snap point of the RF shape.

Figure 4-11. Mirror About X and Y Axis Examples

Mirror about Y axis

Mirror about X axis

Before
X axis
Before After After
Y axis
Example 2

Figure 4-12 shows C1 and C3 mirroring about the X axis, with the C2 center as the snap point.
C1 and C3 maintain their relationship to C2 after mirroring.
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Figure 4-12. Mirror About X Axes - Object Center
Before mirror

_ _____ _ Xaxis

Result of mirror about X (horizontal)

- - _ - _ _ Xaxis
After mirroring

Green pad is pin 1

Example 3

Figure 4-13 illustrates mirroring of an RF circuit placed at an odd angle.

Figure 4-13. Mirror of Angled Part

A. Starting position is 45°.

B. Mirroring A about the Y axis. Rotation is 135°.

C. Mirroring A about the X axis. Rotation is 225°.

D. Mirroring C about the Y axis. Rotation is 315°.

Related Topics

Creating and Modifying a Meander Creating and Modifying RF Shapes
Moving RF Groups or Objects in RF Groups  Using RF Groups
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Meander Properties Dialog Box

To access: Click RF Toolkit (2,) on the Standard toolbar, then do one of the following:
* Click Add meander ( 5] ) on the RF toolbar

® Setup > RF > Start Meander
® Choose RF > Start Meander from the popup

Description

Use the Meander properties dialog box to define the meander properties.

Figure 4-14. Meander Properties Dialog Box

General

==k
Group: | <Inherit> ()

Mode:! :Segment e |

Snap andle: | b
Strip bype: | Microstrip 5
Meander name: [ Meander_4

|:| IJse smooth termination
[ Inherit shape specifics
[ Taper ko target width

Shape specific

width | 10,000 =

Corner bype: | Corner

Mire % (50|

Radius: |ﬁ
Changes scope: | Lacal 2

Change width: i-:l:aper é-l

Length:
Slope Heighty | 5000

Gap Width: | 20,0

_ Apply
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Table 4-5. Meander Properties Dialog Box Contents

Field Description

General section

Group Defines all RF groups that are not fixed, locked, or frozen.

® <Inherit>— Applies the RF group name of the selected object to the
meander and uses the node of the selected object as a starting point (RF
Group Contents).

®* <Mouse Select>— Applies the RF group name of the selected object to
the meander. The meander does not need to be physically connected to the
object.

® <RF Group name> — Applies the active RF group name to the meander.
The meander does not need to be physically connected to the RF group.

Mode Defines the meander.

* Segment — Defines a portion (segment) of a meander (the portion
between mouse-clicks).

* Serpentine — Defines a curved shape resembling the letter “s” (refer to
the Serpentine field at the end of this table).

Snap angle Defines the meander placement angle. For example, if you set the snap angle
to 45°, the placement angles are 0°, 45°, 90°, 135°, and so forth.

Strip type Defines the meander as a:
* Stripline — A trace between ground planes.
® Microstrip — A trace on the top or bottom layer of the PCB.

Meander name | Defines the meander name.

Use smooth Checked, automatically creates an RF shape connection with the least amount
termination of signal reflection (Meander Smooth Termination Connection).
when available | Unchecked, creates a meander connection with the current settings.

Inherit shape | Checked, enables the meander to inherit properties from the selected RF
specifics shape. Selected shapes are:

®* Meander — Uses all RF shape-specific properties from the meander.

* RF shape — Uses only width and layer properties to define the meander.

* Non-RF shape — Uses only the layer property to define the meander.
Unchecked, populates the Shape-specific section with default values.

Taper to target | Checked, tapers meander width to the target width.
width Unchecked, enables you to attach the meander to different target widths.

Shape specific section — Defines the meander RF shape characteristics

Width Defines the meander width.
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Table 4-5. Meander Properties Dialog Box Contents (cont.)

Field

Description

Corner type

Defines the meander corner type as:

* Free Radius — The largest possible radius for arbitrary meanders.
® Corner — A snap angle.

* Mitre — A mitre angle.

* Radius — An arc.

Free Radius Corner Mitre Radius

Mitre

(Mitre Corner type only) Defines the percentage of the outer corner to be
removed.

Radius

(Radius Corner type only) Defines the radius of the arc applied to the outer
corner.

Changes scope

Defines the meander scope.
® Local — Applies changes only to selected meander segments.
* Global — Applies changes to the entire meander.

Change width

Defines how the width change between segments:

o Taper — Gradual width change.

e Step — Abrupt width change.

Serpentine specific section — Defines the serpentine characteristics. Serpentine attributes are
only available in the Serpentine mode (Mode field).

Gap width

"

-4— —P

?

Slope height

'47 Serpentine Length 4><

Length

Defines the serpentine length.
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Table 4-5. Meander Properties Dialog Box Contents (cont.)

Field Description

Slope Height | Defines the slope height.

Gap Width Defines the gap width.

Related Topics

Creating a Meander Continuing a Meander on a Different Layer

Creating a Serpentine Meander Editing a Meander

Meander Segment

Meander segments establish connections between nets and RF shapes as sell as between
different RF shapes.

Note
RF shape characteristics and parameter values are described in the RF simulators

documentation.

Figure 4-15 shows a simple meander with three segments. This example shows a Corner type
of meander corner (Meander Properties Dialog Box).

Figure 4-15. RF Shape - Orthogonal Bend Construction

o Mouse click

You click Meander Meander display

A non-orthogonal meander with the Corner type set to Corner or Mitre (Figure 4-16).
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Figure 4-16. RF Shape - Non-orthogonal Bend Construction
© Mouse click

You click Meander Meander display

A meander with a Corner type of Free radius has curved corners (Figure 4-17).

Figure 4-17. RF Shape - Radius Bend Construction
¢ Mouse click

You click Meander Meander display

<
oo o J

The overlap restriction, detailed in the Overlap Check, prevents meander cross-overs
(Figure 4-18)

Figure 4-18. Crossover Not Allowed
+ Mouse click indicator

Crossover not allowed

Display I

Right-click and choose End

1 \ '
+-r-—-4

: .

Related Topics

Creating and Modifying a Meander Creating and Modifying Nodes

Setting Clearances, Copying, and Creating Using RF Groups
Adjacent Layer Clearances
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Meander Display Length

When you add a meander, an animated border representing the RF shape appears during
placement with a tag displaying the meander deviation, angle, and length (Figure 4-19).

Figure 4-19. Adding RF Shape

diefdy  : 60.000/-90.000
e M onge 3037

iLen + 321,900

Animation
Related Topics
Creating and Modifying a Meander Setting Clearances, Copying, and Creating
Adjacent Layer Clearances
Creating and Modifying Nodes Meander Properties Dialog Box

Connecting RF Shapes with a Meander

When you connect RF shapes with a meander, the width of the meander can be defined by the
RF shape starting node (Figure 4-20). The meander also inherits the net name from the starting
node. The starting node and ending node (TL1 and TL2) have the same net name (Changing an
RF Net Name).

Connect the RF shapes with a meander (Creating a Meander).

Figure 4-20. Connecting RF Shapes with a Meander

+ Add meander, mouse click points :
Resulting meander (blue), The
rmeander is autornatically finalized
when connected to the node of

TLZ.

RF Shape,
Width 20th

RF Shape,
width 30th

TL1 point 1 is the starting point of the meander in Figure 4-20. The meander uses the TL1 width
If you check Inherit shape specifics on the Meander Properties Dialog Box, the meander is
20th, otherwise the width is the default value. When you click TL2 node (point 4), the meander
completes. If you checked Taper to target width, the meanders width increases to 30th. In this
example, Taper to target width was not checked.
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Related Topics

Creating and Modifying a Meander Setting Clearances, Copying, and Creating
Adjacent Layer Clearances

Creating and Modifying Nodes Meander Properties Dialog Box

Meander Smooth Termination Connection

The Use smooth termination selection on the Meander Properties Dialog Box enables you to
connect RF shapes automatically with the least amount of signal reflection. Figure 4-21 shows
the meander as a simple S-curve connecting two RF shapes.

Use the following to create a smooth termination connection:

Procedure
1. Create a meander (Creating a Meander).
2. Check the Use smooth termination check box on the Meander Properties Dialog Box.
3. Set the other meander properties as necessary.
4. Click the start node on the RF shape and then click the end node.

The smooth termination option automatically creates a meander as shown in
Figure 4-21.

Figure 4-21. Smooth Connection

R cxidy  : 250.000/200.000
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Related Topics

Creating and Modifying a Meander Setting Clearances, Copying, and Creating
Adjacent Layer Clearances

Creating and Modifying Nodes Meander Properties Dialog Box

Automatic Meander Guide and Trim

Automatic Meander Guide and Trim

When you connect two nodes with a meander, automatic guidance and trimming occurs. The
entry angle determines the guidance (RF Entry Rules Dialog Box). Trimming automatically
removes slivers (meander overhang).

When you add a meander, the meander automatically aligns with the target shape (Selecting the
Entry Angle During Meander Placement). Figure 4-22 and Figure 4-23 show guide and trim
before you finalize the meander connection.

Note
D Meander nodes must have the same net.

Figure 4-22. Meander Guide and Trim - Right Angle Placement

Last placed segment

Animated segrments
{on cursor),

Figure 4-23. Meander Guide and Trim - Odd Angle Placement

Last placed segment

Anirnated segments
{on cursor),

The trim displays only if the two guide lines intersect as shown Figure 4-22 and Figure 4-23.
The example in Figure 4-24, the guide lines do not intersect, which prevents any guide and trim
presentation.
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Figure 4-24. Meander No Guide and Trim - No Angle Placement

Last placed segment

Trirn guides not / 3
crossing \
|
i

Related Topics

Creating and Modifying a Meander Setting Clearances, Copying, and Creating
Adjacent Layer Clearances

Creating and Modifying Nodes Selecting the Entry Angle During Meander
Placement

Meander Length Calculations Meander Line-up Connections

Meander Properties Dialog Box

Meander Length Calculations

A meander’s total length is the sum of each segment and corner. The corner type calculation
depends on the corner characteristics. When you create a meander, use one of the following to
calculate the corner length:

®* Meander Corner Length Calculation
® Meander Radius Length Calculation

®* Meander Mitre Length Calculation
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Meander Corner Length Calculation

Corner length equation
L=W-S
where:
L = Corner Length

W = Corner width
S =sin (5%9)
angle = Degrees between segments

Example:

Meander width 10th

Segment length 75th
90° corner

|
Segment length 95th

Corner effective length = 7.071th

Meander effective length = 95th + 75th + 7.071th = 177.071th
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Meander Radius Length Calculation
Radius length equation

L = Angle « Radius

where:
L = Radius length
Angle = Degrees between segments
Radius = Radians value

Example:
Meander width 10th

90° corner Segment length 60th

Radius 25th

Segment length 65th

Radius effective length = 90 + 25 « -7 = 39.270th

Meander effective length = 65th + 60th + 39.270th = 164.270th

Meander Mitre Length Calculation

The mitre corner length requires evaluation before you can calculate its length. Determine the
mitre length with the following:

® Mitre Length Evaluation 1

* Mitre Length Evaluation 2
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Mitre Length Evaluation 1

Mitre % < S2
where:
S =sin(ande)
2

angle = Degrees between segments

Use Meander Corner Length Calculation.

Example:

Mitre % 20
Angle 45°

Meander and corner width 10th
Segment length 50 and 40th

Corner effective length = 3.8th

Meander effective length = 50th + 3.8th + 40th = 93.8th
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Mitre Length Evaluation 2

Mitre % > S?
where:
S= sin(a%g'e )
angle = Degrees between segments

Mitre Corner equation

L=2++7a2+p2-2(a+b-S)

where:
L = Mitre corner length
a=d-( Mit% %_ S )

2
b = Mitre % » -
C= 1-82
d= Width
C

Width = Corner width
S= sin(@%g'e )
angle = Degrees between segments

Example:
Meander width 10th

Segment length 41.6th

Mitre % 67 (.67)
90° corner

Segment length 61.6th
a = 8.400000009
b=4.737615436
c=0.707106781
d=14.14213563

Mitred effective length = 12.12023104th
Meander effective length = 12.12023104th + 61.6th + 41.6th = 115.320th
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Related Topics

Creating and Modifying a Meander Setting Clearances, Copying, and Creating
Adjacent Layer Clearances

Creating and Modifying Nodes Selecting the Entry Angle During Meander
Placement

Meander Properties Dialog Box

Meander Line-up Connections

The meander line-up enables you to use a specified entry angle to terminate a meander segment
at a target object. This reduces slivers (meander overhang) at the target object (Automatic
Meander Guide and Trim). The line-up connections occur between a part pad and a pin, a via,
bond pad, or a part pad.

When you create a connection to a part pad to an object, the object’s RF entry rules apply (RF
Entry Rules Dialog Box). The RF entry rules define the meanders entry angle.

The via and bond pad use the Meander Properties Dialog Box Snap angle as an entry rule. With
a meander property snap angle of 22.5°, every targeted via or bond pad has an assigned
temporary RF entry rule of 22.5°. If the bond pad or via is rotated, the 0° entry rule matches the
objects rotation as shown in Figure 4-25.

Figure 4-25. Meander Line-up for Bond Pad and Via

C=—— Bond pad rotation 0° and 0° entry rule
@/ Bond pad rotation 22.5° and 0° entry rule

———  Viarotation 0° and 0° entry rule

o Via rotation 22.5° and 0° entry rule

Related Topics

Selecting the Entry Angle During Meander Creating a Meander
Placement

Connecting a Pad to Pin with Meander Line-  Automatic Meander Guide and Trim
up

Creating and Modifying a Meander

Use the following to create and manipulate meanders:

® Creating a Meander
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* Editing a Meander

® Continuing a Meander on a Different Layer

® C(Creating a Serpentine Meander

® Selecting the Entry Angle During Meander Placement
* Connecting a Pad to Pin with Meander Line-up

®* Meander Smooth Termination Connection

Related Topics

Creating and Modifying RF Shapes Setting Clearances, Copying, and Creating
Adjacent Layer Clearances

Creating and Modifying Nodes Using RF Groups

Creating a Meander

Meanders represent conductive material that connects RF shapes to each other and to nets and
other non-RF shapes. Meanders have no representation in the schematic capture tool.

ﬂ Tip: The RF simulator uses temporary netss to connect individual segments of a
meander. These temporary nets are only used for RF simulation and are not utilized by
the layout tool.

Note

D If DRC prevents you from placing a meander in a confined area, use the Alt key to turn
off DRC. After placing the meander, run Batch DRC to identify and correct clearance
violations.

Note
D Only the first and last segments of a meander use entry rules and can overlap an RF shape
(Trace Connection Clearance and Node-to-Node and Node-to-Trace Rules).

Procedure
1. Click RF Toolkit (£,) to enable the RF toolbar (RF Toolkit Toolbar).
2. Click Add meander (5).

The meander is a member of the default group or the currently selected RF group
(Group/Ungroup Dialog Box).

3. Set meander properties as needed (Meander Properties Dialog Box).
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4. Click Apply.
5. Click a grid point, RF shape node, or snap point to start the meander.

By default, meanders start on grid. To place a meander off grid, press the Shift key
during placement. Meanders connect to RF shapes with nodes (not Net0):

* Adding a Stub
* Adding an Edge Node
* Adding a Floating Node
6. Click a location and the current segment ends and starts a new segment.

7. Choose End from the popup or press Esc to terminate the meander. The Esc key does
not place the last segment.

The Meander properties dialog box remains active after you terminate a meander.
8. Place additional meanders as needed.

9. Close the Meander properties dialog box when you are finished creating meanders.

Results
A meander appears in your design and is part of an RF group.
Related Topics

Meander Length Calculations Meander Properties Dialog Box

Editing a Meander Continuing a Meander on a Different Layer
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Editing a Meander

Use the Edit Meander ( j; ) command to alter the meander segment angle.

Procedure

1.
2. Click Edit Meander ( F; ).
3.
4

Click RF Toolkit (2,) to enable the RF toolbar (RF Toolkit Toolbar).

Select a meander segment.

. Move the cursor to change the segment position.

By default, the meander snaps to grid. To place the meander off-grid, press the Shift key
during placement.

Note

If DRC prevents you from placing a meander in a confined area, use the Alt key to turn
off DRC. After placing the meander, run Batch DRC to identify and correct clearance
violations.

While editing a meander, choose an angle to define segment movement as shown in
Figure 4-26. Angle Lock restricts meanders movement to the angles specified. Table 4-6
list the popup menu selections.

Figure 4-26. Meander Edit Popup Menu

Close I

Angle Lock k Mone
¥ Lock Bends

- 45
‘ »

Table 4-6. Edit Meander Popup Menu

Popup Angle Lock | Selected Object Cursor Movement
Selections Dropdown | Movement Description Direction
List
Close —
closes popup
Angle Lock— | None Object moves in any Any
enables direction from its current
defined angle position (default).
movement.
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Table 4-6. Edit Meander Popup Menu (cont.)

Popup Angle Lock | Selected Object Cursor Movement
Selections Dropdown | Movement Description Direction
List

Lock Bends | When you select this option, | Any.
the angles at either side of
the segment are maintained
during the move. The length
of the segment changes to
accommodate the locked
angles. See Figure 4-27.

45° Object only moves at 45°
angles from its current
position.

90° Object only moves

horizontally or vertically
from its current position.

End —
terminates
editing of the
meander

Figure 4-27. Moving a Meander Segment with Lock Bends Active

Eend angles maintained
as the segment is moved.

5. Move the meander to the new location.
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6. Choose End.

Results

The meander changes position.

Related Topics

Continuing a Meander on a Different Layer Adding a Segment

Creating and Modifying a Meander

Continuing a Meander on a Different Layer

Meanders use RF vias to transition between layers (Vias in RF Designs). The RF via is included
as part of the meander.

Procedure

1.

Click RF Toolkit (2,) to enable the RF toolbar (RF Toolkit Toolbar).

. Click Add meander (5).
. Set meander properties as needed (Meander Properties Dialog Box).

2
3
4.
5
6

Click Apply.

. Start the meander (click and drag).

. Place a via:

a. Double-click to place a via. A via automatically appears in the layout tool.

b. Choose the via layer range and RF via padstack from the popup menu (Figure 4-28).

Figure 4-28. M

n
---- Change next via -

el -2 4 v VIADI4EBE
Layer 1 - 16 via20_24_ 28

der Via Selection

P via30_36 44
visd0_44_48
wiaS0_60_70

The RF via belongs to the same net as the meander nodes and is part of the meander in
the RF group (Using RF Groups).

Continue creating the meander on the new layer.

Choose End to terminate the meander.
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Results

A via connects meander segments on different layers.

Related Topics

Editing a Meander Meander Line-up Connections

Creating a Serpentine Meander

Determining the best gap, height, and length of a serpentine meander for your design can be
difficult. Create the serpentine in layout and send it to the RF simulator for evaluation. When
you are satisfied with the results in the RF simulator, send the serpentine back to update the
layout serpentine (Post Back to Schematic Capture and Layout or Posting Back MWO Updates
to Layout).

Use the following to create a serpentine meander.

Procedure
1. Click RF Toolkit (2,) to enable the RF toolbar (RF Toolkit Toolbar).
. Click Add meander (51).
. Set the Mode field to Serpentine (Meander Properties Dialog Box).

2

3

4. Define the serpentine.

5. Make additional setting as needed.
6. Click Apply.

7

. Select a meander start point by clicking in the design area. The start position is on a grid
point or on a snap point. Use the Shift key during placement to select a point off-grid.

The serpentine outline attaches to the cursor.
8. Click to place the serpentine.
After placing the serpentine, the Mode field changes to Segment. If you want to place an
additional serpentine, change the Mode field to Serpentine and click Apply.
Results

The serpentine meander becomes part of the RF design.

Related Topics

Creating and Modifying a Meander Creating and Modifying Nodes
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Selecting the Entry Angle During Meander Placement

When you connect a meander to a target (part pad, pin, via, or bond pad), you can define the
entry angle.

Prerequisites

®* You are Creating a Meander and connecting it to a pad (end point).

Procedure
1. Place the cursor over the pad.

2. Click the Tab key to view each entry angle (Figure 4-29). In this example, the entry
angle is 90°.

3. Click the pad when the desired entry angle displays.

Figure 4-29. Defining Entry Angle with the Tab Key

Entry Angle South Entry Angle East

Len 1 503646

Related Topics

Creating and Modifying a Meander RF Entry Rules Dialog Box

100 RF in DxDesigner - Expedition Flow Users Manual, EE 7.9.5



RF Layout
Creating and Modifying a Meander

Connecting a Pad to Pin with Meander Line-up

Connect a meander from a part pad to a target (pin, via, or bond pad) with meander line-up
(Meander Line-up Connections). The meander line-up enables you to select the connecting
angle, reducing the meander overhang (slivers). A double-line at the target indicates meander
line-up (Figure 4-31).

Prerequisites

The target pin requires a defined entry angle (Setting RF Shape Node Entry Angle). In
this procedure, the target pin has entry angles of 45°, 90°, and 135° (Figure 4-30).

The part pad and target pin must have the same net name (Changing an RF Net Name).

Figure 4-30. Part Pad and Target Pin

Part Pad

Target Pin

Procedure

1.

Click RF Toolkit (2,) to enable the RF toolbar (RF Toolkit Toolbar).

. Click Add meander (5).
. Set meander properties (Meander Properties Dialog Box).

2
3
4.
5

Start the meander by clicking on the Part Pad.

. Move the cursor over the target pin (Selecting the Entry Angle During Meander

Placement).

A double-line attaches to the cursor. Move the cursor to the left and right and the
double-line rotates 45°, indicating the other angles of entry. The double-lines only
appears when the meander can enter the target with the defined entry angles.
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Figure 4-31. Target Meander Line-up

B dc/dy  : 97.043)-40,561

angle 3130
B Lcn 1 55,468

Double Line

6. Click to place the meander. In this example, two connection paths are possible.

Results
A meander connects the pad and pin with the desired target entry angle.
Related Topics

Creating and Modifying a Meander Creating and Modifying Nodes
Creating and Modifying RF Shapes
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Editing Existing RF Shapes
Use the following to edit and manipulate existing RF shapes:
Note

You cannot change the pin connectivity of an RF shape if it has been defined in the
schematic capture tool.

®* Adding a Segment

* Adding a Stub

® Connecting RF Shapes by Moving
* Rotating an RF Shape

® Mirroring an RF Shape

* Copying a Meander

Related Topics

Creating and Modifying RF Shapes Creating and Modifying a Meander
Creating and Modifying Nodes RF Shapes
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Adding a Segment

Add a meander segment to change the path of a meander.

Procedure
1. Click RF Toolkit (£,) to enable the RF toolbar (RF Toolkit Toolbar).
2. Click Add segment ().
3. Select a meander segment (RF Shapes).
4. Place the cursor on the meander segment you want to alter.
Selection Point
5. Move the cursor, and the selected segment changes position.
6. Move the meander node point as needed, and click to place.
7. Press the Esc key to terminate the Add segment selection.
Results

A meander segment was added and the meander path changes.

Related Topics

Creating and Modifying a Meander Editing Existing RF Shapes
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Adding a Stub

The Add Stub command enables you to start a meander from the edge of a meander.

Procedure

1.

Click RF Toolkit (£,) to enable the RF toolbar (RF Toolkit Toolbar).

2. Click Add stub (&).
3.
4

Select the meander.

. Place the stub on the edge of the meander.

The Add edge node window appears (Adding an Edge Node).

Select Node/Net from the dropdown list.

Click Apply.

The Meander Properties Dialog Box appears, enabling you to define the stub meander.

Create the meander (Creating a Meander).

Related Topics

Connecting RF Shapes by Moving Editing Existing RF Shapes

Creating and Modifying Nodes
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Connecting RF Shapes by Moving

Connect RF shapes by moving their open nodes into proximity. The open nodes become the
snap points for the RF shapes connection (Changing Snap Points).

Prerequisites

The connecting nodes must have the same net name (Changing an RF Net Name).

The connecting nodes, Connect-to-plane properties must have a Connect value (RF
Control Dialog Box).

Procedure

1.

Click RF Toolkit (£,) to enable the RF toolbar (RF Toolkit Toolbar).

2. Select an RF shape.
3.
4

Press the Tab key to make the open node the snap point.

. Move the RF shape snap point to the other open node on the target RF shape. When the

RF shape snap point is in proximity of the other open node, the RF shapes connect.

Related Topics

Creating and Modifying Nodes Editing Existing RF Shapes

Auto Arranger
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Rotating an RF Shape

An RF shape rotates in 0.01° increments around any RF shape open node.

Use the following procedure to rotate an RF shape.

Prerequisites

The RF shape must have an open node for the rotation point (RF Shape Node Types). If
there is no open node, the RF Shape center becomes the rotation point.

Procedure

l.

Click RF Toolkit (£) to enable the RF toolbar (RF Toolkit Toolbar).

2. Select Angle shape ( :x ).
3.
4

Select an RF shape.

. Press the Tab key to select the desired snap point. The RF shape rotates around the snap

point.

Rotate the RF shape around the snap point with the cursor. Observe the Angle tag and
Angle window (Figure 4-32).

a. Select an angle with the dropdown arrow and click Preview.
b. Click Apply.

c. Click Close.

Click to place the RF shape or specify the angle.

Figure 4-32. RF Shape Rotation

Angle (degrees) Q o0
ngle (degrees Preview
P e |
_ = || 180° w— - > 0°

v

Angle {(degrees) Preview 2700
| v

-
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Related Topics

Mirroring an RF Shape Editing Existing RF Shapes
Creating and Modifying RF Shapes

Mirroring an RF Shape
Mirror an RF shape or RF group around the X/Y axes. The RF shape or RF group mirror on the
same layer or multiple layers (Mirror about X/Y).
Procedure
1. Click RF Toolkit (£,) to enable the RF toolbar (RF Toolkit Toolbar).
2. Select the RF shape or RF group.
3. Click the mirroring type:
* Mirror about X (¢=).

® Mirror aboutY (4 ).

Related Topics

Creating and Modifying RF Shapes Editing Existing RF Shapes
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Copying a Meander

The RF Copy command enables you to copy an existing meander and make it part of your

design.
Procedure

1. Click RF Toolkit (2,) to enable the RF toolbar (RF Toolkit Toolbar).

2. Select the meander.

3. Click Copy ( gy )-
A copy of the meander attaches to the cursor.

4. Move the meander to a new location.

5. Click to place the meander.
In the Group/Ungroup Dialog Box member list, the default name of the copied meander
is “copy_of <Meander x> with a default description <RFPART> copy_of <Meander
x>", where x is the copy number.
All nodes of the copied meander are assigned to (Net0). The copied and original
meander belong to the same RF group. Use the RF Control Dialog Box to change the net
names (Changing an RF Net Name).

6. Add the copied meander to a different RF group (Adding Members to an RF Group).

Related Topics

Creating and Modifying a Meander Editing Existing RF Shapes

Moving Members Between RF Groups
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Creating and Modifying Nodes

Use the following to create, rename, and define entry angles for nodes:

* Adding a Floating Node

®* Adding an Edge Node

® Changing an RF Net Name

® Setting RF Shape Node Entry Angle

Related Topics

Creating and Modifying RF Shapes Setting Clearances, Copying, and Creating
Adjacent Layer Clearances

Setting Clearances, Copying, and Creating RF Shapes
Adjacent Layer Clearances

Auto Arranger

Adding a Floating Node

Add a floating node on an RF shape to connect the RF shape to traces, vias, part pads, and bond
pads.
Procedure
1. Click RF Toolkit (2,) to enable the RF toolbar (RF Toolkit Toolbar).
2. Click Add floating node ( »*).
3. Select an RF shape.
4. Click the location for the floating node.
5

. In the Add floating node dialog box, select the node name from the Node/Name
dropdown list.

6. Click Apply.
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Related Topics

Creating and Modifying a Meander Creating and Modifying Nodes
Multiple Nets and Pad Connections Adding an Edge Node

Adding an Edge Node

Add an edge node to an RF shape to connect the RF shape to traces, vias, and pins. Edge nodes
can only be placed on the edge of an RF shape (Floating and Edge Nodes).

Procedure
1. Click RF Toolkit (£,) to enable the RF toolbar (RF Toolkit Toolbar).
. Select the RF shape.
. Click Add Edge Node (&).

2

3

4. Click the location for the edge node.

5. In the Add edge node dialog box, select a net from Node/Net dropdown list.
6

. Click Apply.

Related Topics

Creating and Modifying a Meander Creating and Modifying Nodes
Multiple Nets and Pad Connections Adding a Floating Node

RF in DxDesigner - Expedition Flow Users Manual, EE 7.9.5 111



RF Layout
Creating and Modifying Nodes

Changing an RF Net Name

You can change the RF net name when the meander and pin require the same net name.
However, you only perform this procedure if the RF elements are not schematic driven.

Procedure

I.

Click RF Toolkit (£) to enable the RF toolbar (RF Toolkit Toolbar).

2. Click Control pane ().
3. Choose RF Design tab.

4.
5
6

Select the RF shape node.

. Choose the net name from the net Value dropdown list in the property field.
. Click Apply.

Related Topics

Creating and Modifying a Meander Creating and Modifying Nodes
Using RF Groups Auto Arranger
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Setting RF Shape Node Entry Angle

Set the node-to-node and node-to-trace entry angle for a node with the RF Entry Rules Dialog

Box.

Procedure
1. Click RF Toolkit (2,) to enable the RF toolbar (RF Toolkit Toolbar).
2. Click Entry rules ( % ).
3. Select the part and node.
4. Define the node-to-node and node-to-trace node entry angles with the RF Entry Rules

Dialog Box.
Results

New entry angles display or none in the case of Free.

Related Topics

Editing Existing RF Shapes Creating and Modifying Nodes

Auto Arranger Creating and Modifying RF Shapes
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RF Control Dialog Box
To access:
* With the RF Toolkit (®,) active, click Control pane (+") (RF Toolkit Toolbar)
* Setup > RF > RF Control pane
® Choose RF > RF Control pane
Description
Use this dialog box to view and change RF group, segment, and node property values.

The dialog box has the following tabs:

RF Control Dialog Box - Library Shapes tab — Displays all the RF shapes in the library. Select
an RF shape to populate the property and preview fields. You can only view the library RF
shapes and properties, you cannot edit them.

RF Control Dialog Box - RF Design Tab — Displays the RF group hierarchy within the design.
Select an RF shape, node, or part to populate the property and preview fields. The RF Design
tab enables you to define some of the RF group, RF shape, and net properties.
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RF Control Dialog Box - RF Design Tab
To access: Setup > RF > RF Control pane

Description

Displays the RF group hierarchy within the design. Select an RF shape, node, or part to populate
the property and preview fields. The RF Design tab enables you to define some of the RF group,
RF shape, and net properties.

Figure 4-33. RF Control Dialog Box - RF Design
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Table 4-7. RF Control Dialog Box - RF Design Tab Contents
Field Description

Active Group Defines the active RF group. Select an RF group from the dropdown list.

Treeview Displays the RF group hierarchy. Select an RF group, RF shape, RF
segment, or node to populate the Property table and preview area
(Treeview Dropdown Menu Selections).
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Table 4-7. RF Control Dialog Box - RF Design Tab Contents (cont.)
Field Description
Property Displays the selected RF group, RF shape, RF segment, or node

properties.
® Node Properties
* RF Segment Properties
* RF Shape Properties
® RF Group Properties

Preview area

Displays the selected RF shape, RF segment, or node.

Fit preview secti

on — Controls the preview area and layout tool display.

Shape Selected, displays an RF shape in the Preview area.
Segment Selected, displays a segment in the Preview area.
Fit Layout View | Checked, zooms the selected item to fill the layout tool view.

Node Properties

Table 4-8 lists the

node properties.

Table 4-8. RF Control Dialog Box Node Properties

Property Name

Description

Net

Defines the net. Connect different nets with an RF shape (Connecting Nodes
and Pads with an RF Shape).

Note: All nodes on a meander belong to the same net.

Node-to-node

Defines the entry angle for node-to-node connections, as defined in the RF
Entry Rules Dialog Box. Set the entry angle with the Option dropdown list.

* Default — Defines the entry angle as 180°.

* Fixed — Defines the entry angle(s) as fixed. Type values in the Values
field. Separate the entry angles with semicolons without spaces (For
example: 135;180;225).

* Free — Defines the entry angle as any angle.

Node-to-trace

Defines the entry angle for node-to-trace connections as defined in the RF
Entry Rules Dialog Box. Set the entry angle with the Option dropdown list.
® Default — Defines the entry angle as 180°.

* Fixed — Defines the entry angles as fixed. Type values in the Values
field. Separate the entry angles with semicolons without spaces (For
example: 135;180;225).

* Free — Defines the entry angle as any angle.

116

RF in DxDesigner - Expedition Flow Users Manual, EE 7.9.5




RF Layout
RF Control Dialog Box - RF Design Tab

Table 4-8. RF Control Dialog Box Node Properties (cont.)

Property Name | Description
Connect-to- Defines the type of node-to-plane connections. Use the Value dropdown list
plane to set the connection state.
® Clear — Prohibits a node to connect to a plane by default (No connect
mode).
® Connect — Enables a node to connect to a plane (Connect mode).
Connect mode overrides the RF shape clearance setting (Clearance Editor
Dialog Box). Connection occurs if:
® The plane and node belong to the same net.
® The RF shape edge is located inside or on the edge of the RF shape
plane.
Expired Defines the Design Rule Check (DRC) node reporting. An RF shape has a
floating node with a parameter value of True, which enables DRC reporting
(RF Expired Nodes and DRC RF Violations).
RFPort Defines the node as an RFPort when True. Use the Value dropdown list to
set the RFPort state.
® False — Defines the node as Default (The node is not an RFPort).
® True — Defines the entry angle as 180°.
The default RFPort is visible when False.
Note: The schematic capture tool uses a custom RF shape when at least one
RFPort node is True. (Creating a Custom RF Shape).

RF Segment Properties

Table 4-9 lists the segment properties.

Table 4-9. RF Control Dialog Box RF Segment Properties

Property Name Description

Substrate Defines the substrate.

L Defines the length of the segment.
w Defines the width of the segment.

Solder-mask

Defines the solder-mask clearance for the selected segment. Refer to
Soldermask Control.

Corner, Type

Defines the corner type.

Top/Bottom

Indicates if the soldermask settings are inherited from the group
settings.

®* Yes —Soldermask setting are inherited.

®* No — Soldermask settings are not inherited.
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RF Shape Properties

You create conductive or plane shapes in Draw mode and covert them to RF shapes (Creating a
Custom RF Shape). Draw objects within RF elements that you modify are tagged as “user
modified’ and stored as static shapes.

Note
You can assign different nets to nodes within the same RF shape.

Table 4-10 lists the RF shape properties.
Table 4-10. RF Control Dialog Box RF Shape Properties

Property Name Description

Name Displays the RF shape name. The name is the schematic reference
designator (refdes) or a user-defined name. When you use the refdes
name, the property is read-only.

w Defines the RF shape width.

Layer Defines the RF shape layer. This is the MSUB<#> in the RF Control
Dialog Box.

Solder-mask Defines the RF shape solder-mask (Soldermask Control).

L Defines the total length of the RF shape. Modify the RF shape length

with the RF Shape Parameters Dialog Box.

Strip type Defines the RF shape as a Microstrip or Stripline.

RF Group Properties

RF group clearance rules have the same limitation as the RF shape level (RF Shape Properties).
The RF group clearance rules are only set as a global rule on all RF shapes within the RF group
(RF Group Clearance Rules Dialog Box).

The RF group properties populate the RF Control Dialog Box, RF Design tab - Property field
when you select an RF group in the treeview area or in the layout tool.

RF shapes in an RF group inherit the RF group clearance values. An RF group level clearance
rule is useful in setting the clearance rules on a large number of RF shapes.

Based on the RF group clearance rules, the layout tool displays a border around the RF group
representing the defined clearances.
Treeview Dropdown Menu Selections

The treeview area menus (RF Control dialog box, RF Design tab) change when you right-click
the following:
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®* RF Group — Table 4-11
® RF Shape — Table 4-12
® Varblock — Table 4-13

Table 4-11. RF Control Dialog Box, RF Group Dropdown Menu Selections

Dropdown Menu
Selections

Description

Auto arrange

Enables the automatic arrangement of a placed RF group (Auto
Arranger).

Generate netlist

Creates a netlist file and displays the contents in the default ASCII
viewer (Generating Netlist).

Send netlist

Sends a netlist file to the RF simulator (Sending Netlist - Layout).

Generate layout data

Creates a momentum file and displays the contents in the default
ASCII viewer (Generating Layout Data).

Send layout data

Sends a momentum file to the RF simulator (ADS Sending Layout
Data, AWR/MWO Sending Layout Data).

Generate Tune/Opt Data

Creates a .iff file and displays the contents in the default ASCII
viewer (ADS Generating Tune/Opt Data).

Send Tune/Opt Data Sends a .iff file to the RF simulator (ADS Sending Tune/Opt
Data).

Synchronize library Synchronizes the layout tool library with the RF simulator library.
Only those RF simulator library parts that have changed are
updated in the layout tool library.

Add Var Block Creates a variable block in a layout design (Adding a Varblock).

Paste Var Block Pastes a copied Var block into an RF group.

Generate Library Symbol

Enables an RF shape to be placed in the library (Creating a
Custom RF Shape).

Table 4-12. RF Control Dialog Box, RF Shape Dropdown Menu Selections

Dropdown Menu
Selections

Description

Set Auto Place Seed

Selects the RF shape seed. The RF group or RF shape seed is the
reference point for placement, rotation, and move functions.
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Table 4-12. RF Control Dialog Box, RF Shape Dropdown Menu Selections

Dropdown Menu Description
Selections

Unset Auto Place Seed Removes the active RF shape seed from the RF group. The RF
group or RF shape seed is the reference point for placement,
rotation, and move functions.

Table 4-13. RF Control Dialog Box, Var Block Dropdown Menu Selections

Dropdown Menu Description

Selections

Edit Var Block Opens a Var Block (Creating Var Block Variables).

Delete Var Block Removes the selected Var Block. Any parameters with variables,
become regular values.

Related Topics

Editing Existing RF Shapes Creating and Modifying Nodes
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RF Entry Rules Dialog Box

To access:

* With the RF Toolkit (#,) active, click Entry rules (%£) (RF Toolkit Toolbar)
® Setup > RF > Entry Rules
* RF > Entry Rules

Description

Use the RF Entry Rules dialog box to define the node entry angles for node-to-node and node-
to-trace nodes.

Changes made in the RF Entry Rules dialog box also displays in the RF Control Dialog Box, RF
Design tab node properties area.

* Node entry angles ensure that traces, other RF shapes, and regular parts connect to a
node at a specific angle.

* Node-to-node entry rules apply to auto-placement (Auto Arranger).

® The node-to-trace entry rule applies to all commands and functions that connect a node
to a trace.

Figure 4-34. RF Entry Rules Dialog Box - Node to node tab

RF Entry Rules

| Mode to node :_Node to trace |
Filter

Refdes: :Meander_l ™
PinfNade | 1 |
Enitry rule

[ Default value

(%145 degrees increment

@ B O (e ]

0 (G ]
O M O

) Angle

OiFree

Shape/Park orientation
@ Asis

() Mon Mirrored/Ratated

* Traces connecting to nodes use the centerline connection, which enables half the trace
width to overlap the node (pin) (Automatic Meander Guide and Trim).

® RF shape nodes behave as pins do in Route mode and can have different entry rules.
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Figure 4-35. RF Entry Rules Dialog Box - Node to trace Tab

RF Entry Rules

Mode to nods: | Node to frace: |
| Filcer =

Refdes: | Meander_1
PinfMode 1

Eritry rule
Default value

e

Shape/Part orientation
@ As iz
(O Mon Mirrored|Rotated

BEGECH, Meandsr 1 [ apply ] [ Close ] QJ

The contents of the Node to node and Node to trace tabs are the same.

Table 4-14. RF Entry Rules Dialog Box Contents

Field Description

Filter section — Defines the RF shape and node identification.

Refdes Defines the RF shape reference designator selection. Use the dropdown list
to choose a different reference designator.

Pin/Node Defines the RF shape node selection. Use the dropdown list to choose a
different node.

Entry rule section— Defines the node entry angles.
90°
180°— & — 0°

@ Node 270°

Default value Checked, the entry angle is orthogonal to the RF shape edge (RF Shape
Node Entry Angle).
Unchecked, enables 45 degrees increment, Angle, and Free options.
45 degrees Checked, enables 45° selection.
increment
Select all Click, checks all 45° check boxes.
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Table 4-14. RF Entry Rules Dialog Box Contents (cont.)

Clear all Clears all 45° check boxes.

Angle Selected, enables you to define entry angles. Type the entry angles
separated by a semicolon without spaces (Example: 15;33;44;155 - entry
angles are 15°, 33°, 44°, and 155°).

Free Selected, disables angle checking and removes the entry angle indicator.

The angle of entry is determined by Plow or the autorouter settings.

Shape/Part orientation section — Defines the RF shape orientation in the view area.

As is

Selected, displays the layout tool view.

Non
Mirrored/Rotated

Selected, displays the library view.

Apply changes to
all parts using
this cell name:
<cell name>

Checked, applies the changes to all parts with the same cell name, except
locked or highlighted parts.

Unchecked, applies the changes only to the selected node.

Related Topics

Selecting the Entry Angle During Meander Setting RF Shape Node Entry Angle

Placement

Creating and Modifying Nodes Creating and Modifying RF Shapes
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RF Shape Node Entry Angle

When you add RF shapes to a design, the node entry angle is perpendicular to the RF shape
edge by default. Rotating the RF shape does not change the node entry angle as shown in
Figure 4-36.

The RF entry angle rule is a property on the node and not of the RF shape. After placing an RF
shape, update the entry angle as needed (Setting RF Shape Node Entry Angle).

Figure 4-36. Default Entry Angle for RF Shapes

Entry angle is 0°

The default entry angle is
perpendicular to the RF shape edge.

During rotation, the entry angle
remains the same.

N

The node entry rules apply even if the RF shape is an arbitrary polygon. The entry angle is
perpendicular to an arbitrary polygon RF shape edge as shown in Figure 4-37.

Figure 4-37. Default Entry Angle for Arbitrary Polygon
Entry angle is 45°

The default entry angle is
perpendicular to the RF shape edge.

During rotation, the entry angle
remains the same.

\

The entry angle is perpendicular to a microstrip curve as shown in Figure 4-38 or a custom RF
shape as shown in Figure 4-39.
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Figure 4-38. Default Entry Angle for Microstrip Curve (RF Shape/Meander)

If the custom RF shape edge cannot be used to determine the entry angle, the entry angle is set
to Free (Figure 4-40).
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Figure 4-40. Custom Shape Free Connections

i i Cannot determine which edge
to use for an entr
Y Node on a Corner

calculation.

O 0O Cannot determine an edge to
reference for the angle

calculations for the floating
O O nodes. Nodes Not on the Edge

o 0O

Cannot determine an edge to
reference. The angle rule

defaults to Free. Nodes on Arc or peek
Related Topics
Adding an Edge Node Editing Existing RF Shapes
Creating and Modifying Nodes Auto Arranger
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Clearance Editor Dialog Box

To access:

* With the RF Toolkit (£,) active, click Clearance rules (i3 ) (RF Toolkit Toolbar).

® Choose Setup > RF > Clearance Rules.

® Select an RF segment or RF shape and choose RF > Clearance Rules.
Description

Define RF shape and segment clearances with the Clearance Editor dialog box.

Figure 4-41. Clearance Editor Dialog Box

Cie-arance"Edit.or

Shape

Shape: |RF10 >
Segment:

Clearance
Type: |Segment to plane Ll

—_
Yalue: | { i)

_Cle_,arancg _rules-
[+ SRR B R s b

Display [ Index | Twpe |

Uniform mode -
[ Uniform
Corner bype: =1

Shape orientation
* fsis
" Mon Mirrored | Rotated

Fit: wigmw

' Seqment " Shape

Apphye Close | @

Table 4-15. Clearance Editor Dialog Box Contents

Field Element Description

Shape Defines the selected RF shape and segment.
* Shape — Displays the name of the selected RF shape or segment. Select
RF shapes from the dropdown list (RF Shape Clearance).

* Segment — Displays the RF segment number of the selected RF shape.
Select the segment from the dropdown list (New Segment Clearance Rule).
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Table 4-15. Clearance Editor Dialog Box Contents (cont.)

Field Element Description

Clearance section — Defines the RF shape or segment clearance.

Type Defines the clearance type. The following types are available from the
dropdown list:

* All — Default value, which applies to all of the segment settings except for
the Segment to mask clearance.
Segment to plane — Defines the segment edge to plane clearance.
Segment to trace — Defines the segment edge to trace clearance.
Segment to via — Defines the segment edge to via clearance.
Segment to pad — Defines the segment edge to pad clearance.
Segment to mask — Defines the segment edge to mask clearance
(Soldermask Control).

Value Defines the clearance measurement value for the clearance type.

Clearance rules section — Defines the RF segment layer clearance rules (Setting Clearances,
Copying, and Creating Adjacent Layer Clearances).

New Click, adds a new clearance rule for the segment as defined by the Clearance
field Type selection (New Segment Clearance Rule). New table columns are:

* Display — Checked, RF shape or segment clearances display in the dialog
box viewer (RF Segment Clearance).

* Index — Defines the clearance layer. The segment layer has an index
value of 0. Negative numbers defines the layers above the segment layer.
Positive numbers defines the layers below the segment layer.

* Type — Defines the layer type as Signal, Plane and so on. Non-existent
layers are Unknown.

Copy Ezf Click, copies a Clearance field Type clearance to the clipboard (Related
Topics).

Click, copies all the clearance rules to the clipboard.
Note: You cannot copy a tapered clearance to an RF corner shape.

Click, applies the clipboard clearances to the same kind of RF segment
selection when the clipboard contains a Copy to Other Shape.

Click, applies the clipboard clearances to a clearance type when the clipboard
contains a Copy.

Increase Layer | Click, increments the Index value for layers below the RF shape. This enables
Index 4| a per layer clearance setting (Layer-to-Layer Clearance Rules). Use the layer
index to define a clearance setting on layers below the RF shape.

Decrease Click, decrements the Index value for layers above the RF shape. This enables
Layer Index a per layer clearance setting (Layer-to-Layer Clearance Rules). Use the layer
+/ index to define a clearance setting on layers above the RF shape.

Undo <3| Click, restores the last deleted clearance rule.
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Table 4-15. Clearance Editor Dialog Box Contents (cont.)

Field Element Description

Redo ¢ Click, reverses the Undo.

Delete | Click, Deletes the selected clearance rule.

Uniform Checked, displays all the RF shape or segment clearances in a message

window (Figure 4-47). The largest clearance value becomes the uniform
clearance for that clearance type (Uniform Mode). The clearance around the
RF shape become uniform.

Unchecked, enables per-side segment clearances. Each side of the segment can
have a different clearance.

Corner type Enabled with Uniform checked, defines the clearance corner as sharp (angle)
or rounded (radius).

Shape orientation — Defines the orientation of the selected shape in the dialog box viewer.

As is Selected, displays the selection in the dialog box viewer as it appears in the
layout tool.

Non Mirrored/ | Selected, displays the library orientation in the dialog box viewer.
Rotated

Fit view — Defines the view in the dialog box viewer.

Segment Selected, displays the selected segment in the dialog box viewer.

Shape Selected, displays the selected RF shape in the dialog box viewer.

New Segment Clearance Rule

The selected segment appears in the Clearance Editor Dialog Box with a red segment clearance
(Figure 4-42). Selecting New (E&) displays the default clearance as defined by the white border
around the RF segment. The white border, values, and handles (square blocks) indicate the
default segment clearance. Clearances for an RF segment can be per-side or uniform. A per-side
clearance means each side can have a different clearance value. A uniform clearance means all
sides have the same clearance value.

Non-node clearance edges have three handles which move the border perpendicular to the RF
segment edge. Node clearance edges have one handle, which moves the border perpendicular to
the RF segment edge.

Select the center handle to change the edge clearance uniformly. The white clearance edge turns
red, which enables you to move the clearance edge or enter a value in the Clearance Editor,
Clearance field, Value.

Select a corner handle to create a tapered clearance. The white clearance edge turns red, which
enables you to move the corner handle or enter a clearance in the Clearance Editor, Clearance
field, Value.
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Figure 4-42. RF Segment Clearance Handles

Selected RF segment New clearance rule

RF segment node
a N

N

Non-node edge

N S

RF segment clearance

RF Shape Clearance

When an RF Shape contains more than one segment, you can change the clearances of each
segment of the RF shape. The RF shape supports only a single clearance value. Each segment
within the RF shape can support a different value for each side of the segment (RF Segment
Clearance).

RF Segment Clearance

Figure 4-43 shows an RF shape with a uniform clearance because the clearance has radius
corners. Each segment and RF shape has a default clearance. An RF shape or segment with a
uniform clearances can have sharp (angle) or Rounded (radius) corners. An RF shape or
segment with a non-uniform clearance can only have sharp (angle) corners.

Figure 4-43. RF Segment Clearance
RF Shape

—_—_ —_ —_ —_ —_ —_ =

Each segment of an RF shape can have different set of clearances (Figure 4-44).
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Each side of an RF shape or segment can be set to a different clearance (Figure 4-45).

Figure 4-45. Clearance - Different RF Segment Rules

5th Effective clearance area or Clearance Obstruct

8th The clearance
intersecting point

from the node side
| and non-node side.

A tapered RF segment clearance value applies to the segment clearance and not the RF shape
rule (refer to RF Shape Clearance Restrictions and Exceptions). Figure 4-46 shows an RF
segment with tapered clearance. The different clearance values from the node and non-node
sides of the segment, determine the effective clearance.

Figure 4-46. Clearance Field Values
end=10th
start=0th
\

n=0th — n=5th

start=5th —— — ————— | _ end=I2th

Note
Obstructs are created for all RF shapes. One obstruct is created per clearance value and if
the clearance values are the same, only one clearance displays.

Related Topics

Setting Clearances, Copying, and Creating Using RF Groups
Adjacent Layer Clearances
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Editing Existing RF Shapes Creating and Modifying RF Shapes

Uniform Mode

The Clearance Editor Dialog Box Uniform mode field enables conversion from a per-side
clearance to a uniform clearance.

For example:

A segment has different per-side clearances and when you select Uniform in the Clearance
Editor Dialog Box and click Apply a message window displays as shown in Figure 4-47.

Figure 4-47. Uniform Message Window
[ Expedition PCE |22

G “-.I Warning! Existing per side clearances will change into uniform
¥ clearances as below, continue?

Segment to mask top : 2,000 th
Segment to plane 132678 th
Segment to via 1 25,000 th
Yes l ’ Mo

If you click Yes, the largest per-side clearance of the segment type becomes the uniform
clearance. In this example, a uniform clearance becomes 32.678th.

If you do not specify a specific corner type in the Clearance Editor, Clearance field, Value, the
RF group corner prevails. The RF Group Clearance Rules Dialog Box defines the segment
default corner.

Note
D A meander with multiple segments, can have a per-side and uniform clearances for each

segment.

Related Topics

Editing Existing RF Shapes Setting Clearances, Copying, and Creating
Adjacent Layer Clearances
Auto Arranger DRC RF Violations
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Soldermask Control

The Soldermask clearance can be set at the RF group, RF shape, or RF segment level.

The soldermask property appears in the RF Control Dialog Box, RF Design tab Properties field
with an RF group selected. Change the soldermask value with the Setting Clearances, Copying,
and Creating Adjacent Layer Clearances procedures.

You can set the soldermask value at the RF group level with the RF Group Clearance Rules
Dialog Box (Top Solder, Bottom Solder). You can set the soldermask value at the segment level
with the Clearance Editor Dialog Box, clearance type Segment to mask.

The soldermask:

® can be larger or smaller than the width of the RF segment.
* automatically adjusts to the RF shape segments width.
* follows the contour of the RF shape as shown in Figure 4-48.

* isnot affected by Push or Mirror operations.

Figure 4-48. Soldermask Opening

= e RF shape

/ . 2 I;Iodes

Solder mask
clearance

Note
D If the RF shape is pushed to an inner layer of the design, you must manually turn off the

soldermask clearance.

Note
D Soldermask clearances on an RF group, RF shape, or RF segment, move with the RF

shape.

The RF shape soldermask clearances have the following:

® A per-side control for the following RF shape types (RF Shapes):
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o Microstrip corner
o Microstrip line
o Microstrip taper
* A tapered soldermask for the following RF shape types (RF Shapes):
o Microstrip line
o Microstrip taper

Meanders can contain multiple microstrip RF shapes, while supporting the same per-side and
tapered soldermask clearances.

Related Topics

Clearance Editor Dialog Box RF Layout
RF Shape Clearance Checking

Trace Connection Clearance

A trace must clear an RF shape clearance area before it can change direction. This applies to all
traces that connect to RF shape nodes (RF Shape Node Types). Violations occur when a trace
re-enters the RF shape clearance area. A trace can only enter an RF shape clearance area once.

Figure 4-49. RF Shape/Segment to Trace
RF Shape

Clearance area

>

r

I Traces

Related Topics

Creating a Meander Adding a Stub
Adding a Segment DRC Node and Pad Entry Rules
Connecting RF Shapes by Moving Setting Clearances, Copying, and Creating

Adjacent Layer Clearances
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Setting Clearances, Copying, and Creating
Adjacent Layer Clearances

Use the following to set and define RF shape clearances:

* Setting RF Segment Clearance
* Copying
* Copying to Other Shape

® C(Creating Adjacent Layer Clearances

Related Topics

Creating and Modifying RF Shapes Editing Existing RF Shapes
Clearance Editor Dialog Box

Setting RF Segment Clearance

Use the following to set the RF segment clearance:

1. Click RF Toolkit (2,) to enable the RF toolbar (RF Toolkit Toolbar).
2. Select an RF segment in the Clearance Editor Dialog Box.

3. Select clearance type.

4. Click New ( E3J).
5

. Move the clearance handle, set the Value field, or check Uniform to change clearances
(New Segment Clearance Rule).

6. Click Apply.
Related Topics

Creating and Modifying RF Shapes Editing Existing RF Shapes

Clearance Editor Dialog Box Setting Clearances, Copying, and Creating
Adjacent Layer Clearances

Copying

Use the following to copy the current clearance of an RF shape or segment:

1. Click RF Toolkit (£,) to enable the RF toolbar (RF Toolkit Toolbar).

2. Select an RF segment in the Clearance Editor Dialog Box.
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3. Select clearance type.
4. Click New ( ERJ).

5. Move a clearance handle, set the Value field, or check Uniform to define a clearance
(New Segment Clearance Rule).

Note

Copy is active when an RF shape or segment has different clearance type clearances.

6. Click Copy (Ezf). The Copy clearance to dialog box displays with the current clearance
type grayed.

7. Check clearances as needed.
8. Click OK
9. Click Apply

Related Topics

Creating and Modifying RF Shapes Editing Existing RF Shapes

Clearance Editor Dialog Box Setting Clearances, Copying, and Creating

Adjacent Layer Clearances

Copying to Other Shape

Use the following to copy the RF shape clearance and apply the clearance to a similar RF shape.

1. Click RF Toolkit (£,) to enable the RF toolbar (RF Toolkit Toolbar).
2. Select an RF segment in the Clearance Editor Dialog Box.

3. Select clearance type.
4

. Move a clearance handle, set the Value field, or check Uniform to define a clearance
(New Segment Clearance Rule).

Click Copy To Other Shape (i0)).

Select a similar RF shape or segment.
Click Paste (4.
Click Apply.

o N W

Related Topics

Creating and Modifying RF Shapes Editing Existing RF Shapes
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Clearance Editor Dialog Box Setting Clearances, Copying, and Creating
Adjacent Layer Clearances

Creating Adjacent Layer Clearances

Use the following to create adjacent layer clearances for the selected RF shape:

1. Click RF Toolkit (£,) to enable the RF toolbar (RF Toolkit Toolbar).

2. Select an RF segment in the Clearance Editor Dialog Box.

3. Select clearance type.

4. Click New () (New Segment Clearance Rule).

5. Move a clearance handle, set the Value field, or check Uniform to define a clearance.
6

. Increase or Decrease Layer Index value to define a layer with the ( 4] ¥|) arrows
(Layer-to-Layer Clearance Rules).

7. Click Apply.
Related Topics

Setting Clearances, Copying, and Creating RF Shape Clearance Checking
Adjacent Layer Clearances

RF Shape Layer Change - Clearances Setting Clearances, Copying, and Creating
Adjacent Layer Clearances
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Group/Ungroup Dialog Box

To access:

With the RF Toolkit () active, click Group/Ungroup (§8) (RF Toolkit Toolbar).

Choose Setup > RF > Group/Ungroup.

Click action key 11 Group/Ungroup with an RF shape selected.

Choose RF > Group/Ungroup with an RF shape selected.

Choose RF > Group/Ungroup.

Description

Create RF groups containing RF shapes and non-RF shapes with the Group/Ungroup dialog

box.

Create RF groups by function and move members between RF groups as needed (Moving
Members Between RF Groups). RF groups with subgroups are sent to the RF simulator for
simulation (RF Group Elements Exported to RF Simulator and RF Simulator).

Figure 4-50. Group/Ungroup Dialog Box Selection
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Table 4-16. Group/Ungroup Dialog Box Contents

Field Description

Add Group Adds an RF group at the selected RF group level (Adding an RF Group or
RF Subgroup). The name of a frozen RF group is italicized
(Freeze/Unfreeze an RF Group). Choose an RF group to view (RF Group
Menu Selections).

éd Subgroup | Adds an RF subgroup under the selected RF group level (Adding an RF

B Group or RF Subgroup). The name of a frozen RF group is italicized
(Freeze/Unfreeze an RF Group). Choose an RF group to view (RF Group
Menu Selections).

Delete % Deletes the selected RF group and all the members are placed in the Default

group.

Treeview area

Displays the RF group structure. Click the plus-symbol to expand and
access subgroups. Choose RF groups to access the RF Group Menu
Selections.

Properties — Defines the reference point for the object selected.

Reference point

Displays the RF Group or Pick selection location. The RF group’s default
reference point is the board origin.

Pick reference

b

Click, enables you to define one of the following reference points:
* Location coordinates — Click Pick reference ( [; ) and click a point
in the work area. The location coordinates display.

* An RF group object — Click Pick reference ( [; ) and click an RF
group object. The location coordinates display. ~—

Note: The object is referenced, not the coordinates of the object. The
reference point of the RF group moves with the RF object.

Members
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Table 4-16. Group/Ungroup Dialog Box Contents (cont.)

Field

Description

Table columns

Displays the selected RF group members information.
Object — Displays the object type (Objects in RF Groups - Special
Conditions).

* Conductive — Conductive shape

® Group — RF group within an RF group (subgroups)

* Parts — Layout parts

®* Draw — Plane, Route obstructs

® Trace — Traces

® Vias — RF Vias
Name — Displays the objects name, subgroup name, or reference
designator. Non-named objects have the following displays:

®* Trace — Net name

® Vias — Padstack name

* Draw — Type of draw object, which are route obstructs, plane obstructs

and so on.

Description — Displays a description of the part or reference location.
Layer — Displays the part layer or via span.

items to group

Remove Click, removes selected members from the RF group (RF Group Contents)
and moves them to the Default RF group.
Add selected Click, adds selected design objects to the selected RF group (Adding

Members to an RF Group).

Fit view

Checked, magnifies the selected item to fill the layout tool view.

Select

Checked, enables crossprobing, select a member and it is highlighted in the
layout tool.

Related Topics
Using RF Groups

Editing Existing RF Shapes
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RF Group Contents

An RF group can contain a parts, fills, traces, vias, draw objects, as well as RF shapes. The RF
group objects are called members. Each RF group has a unique name, which displays in the

Group/Ungroup dialog box, treeview area (Figure 4-50).

An RF group can contain the following objects:

Conductive Shape

Group

Netline

Pad Obstruct
Part

Pin

Plane Obstruct
Plane Shape
RF Node

RF Segment
RF Shape
Route Obstruct
Trace

Via

RF groups are sent to the RF simulator with the dynamic-link (RF Simulator).

Note

Traces are only sent to the RF simulator if they are directly or indirectly connected to an
RF shape or meander (RF Group Elements Exported to RF Simulator).

Figure 4-51 shows a top level RF group border (white line), which encloses an RF group (RF
Group Clearance Rules Dialog Box). RF subgroups do not have a group border.

Note

D To select an RF group you check Group in the Selection Filter Dialog Box, Object tab.
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Figure 4-51. RF Group Border

Note
D RF groups created with the Group/Ungroup dialog box are only accessible through the

RF Toolkit. The Group/Ungroup dialog box defines the group as an RF Group.

The Default RF group members change when you:
® Add an RF part with no additional RF group.

® Delete members from an RF group.
® Delete an RF group that has members.

Related Topics

Using RF Groups Editing Existing RF Shapes

Moving Members Between RF Groups RF Group Menu Selections

RF Group Properties Selection Filter Dialog BoxGroup/Ungroup
Dialog Box

Group/Ungroup Dialog Box

RF Group Menu Selections

The following popup menu selections are available when you choose an RF group in the
Group/Ungroup Dialog Box treeview area.

®* Add group — Adds an RF group at the selected RF group level (Adding an RF Group
or RF Subgroup).

* Add subgroup — Adds an RF subgroup under the selected RF group (Adding an RF
Group or RF Subgroup).

* Delete — Deletes the selected RF group and moves them to the Default group.
* Rename — Enables renaming of the RF group.

* Freeze/Unfreeze — Enables Freezing and unfreezing of an RF group (Freeze/Unfreeze
an RF Group).
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® Generate netlist — Displays the RF group ASCII netlist file (Generating Netlist).

* Send netlist — Sends the RF group netlist file to the RF simulator (Sending Netlist -
Layout).

* Generate layout data — Displays the RF group ASCII layout data file (Generating
Layout Data).

* Send layout data — Sends the RF group layout data to the RF simulator (Sending
Layout Data).

* Generate Tune/Opt Data — Creates a Tune/Opt data file (.iff) in a location shown by
the message window (Generating Tune/Opt Data).

* Send Tune/Opt Data — Sends only RF elements (model) with parameters and breaks
down meanders into standard RF simulator models and parts (Sending Tune/Opt Data).

Related Topics

Group/Ungroup Dialog Box Freeze/Unfreeze an RF Group

Freeze/Unfreeze an RF Group

You can freeze an RF group when all the parts are placed in the layout tool. A frozen RF group
and its subgroups cannot be deleted or manipulated. You can move, rotate, or mirror a frozen
RF group.

Use the RF group dropdown list Freeze/Unfreeze to freeze or unfreeze an RF group. A frozen
RF group name displays in italics in the Group/Ungroup Dialog Box and in the RF Control
Dialog Box - RF Design tab treeview areas.

Related Topics

Moving RF Groups or Objects in RF Groups  Objects in RF Groups - Special Conditions

Objects in RF Groups - Special Conditions

The following RF group parts are treated in a special way when they are RF group members:

® Traces and Vias

® Parts

Traces and Vias

Traces and vias are locked when they are members of an RF group. The trace or segments of a
trace that are members, move with the RF group. A trace that is a member of the RF group

RF in DxDesigner - Expedition Flow Users Manual, EE 7.9.5 143



RF Layout
Group/Ungroup Dialog Box

cannot be manipulated, pushed, or shoved. Moving an RF group that contains a non-RF group
trace, causes the trace to disconnect from the RF group. Moving an RF group with an attached
non-RF group trace, causes the trace to disconnect from the RF group.

The trace rules apply to regular vias (vias created with the Padstack Editor). A via can only be
independently moved within an RF group when it is not connected to traces (stitched vias Vias
in RF Designs). Vias can be indirectly moved as described in Parts.

Figure 4-52 shows a trace (blue) that is part of an RF group, which prohibits trace manipulation.
Remove the trace from the RF group for trace manipulation (Group/Ungroup Dialog Box
Delete button).

Figure 4-52. Locked Traces in Groups
——————— Group bounding border

erzrrry Segment member of group

@@= Segment not member of group

If you move an RF group in Figure 4-52 and the orange trace segment is not part of the RF
group, that trace segment does not move with the RF group (Figure 4-53). Use Plow to
reconnect the broken trace without changing segment membership.

Figure 4-53. Trace Split After Group Move

——————— Group bounding border

errrre  Segment member of group

== Segment not member of graup

Parts

Moving an RF group part member that is connected to a non-RF group via disconnects as shown
in Figure 4-54. Move traces and non-stitched vias within an RF group only when you invoke
Circuit Move & Copy (CMC) with an active RF toolkit. Move a fanout part, via, and trace by
selecting CMC prior to layout selection. When you move a part, all the traces and vias
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connected to the pin (pad) or a branch move with the part. A branch is a trace T-junction, where
the trace segment is not a member of the RF group, via, or another pin (pad).

Figure 4-54. Move a Part in an RF Group

------- Group bounding border ==  Segment not member of group

ezzFrFs  Segment member of group

When you move a part, traces connected to the part or shape are treated as locked and you
cannot Push or Shove other objects.

If a via is only connected by a single segment (fanout), the via moves with the part
(Figure 4-55).

Figure 4-55. Move Part with Fanout Via

——————— Group bounding border e Segment not member of group

Segrnent member of group

This via and trace This via will
will use the current maove with
™ interconnect rules the part

Related Topics

Using RF Groups Editing Existing RF Shapes
Creating a Meander Using RF Groups

Moving RF Groups or Objects in RF Groups  Setting Clearances, Copying, and Creating
Adjacent Layer Clearances
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Using RF Groups

Use the following to create and manipulate RF groups:

Adding an RF Group or RF Subgroup
Moving Members Between RF Groups
Adding Members to an RF Group

Moving RF Groups or Objects in RF Groups
Placing RF Groups with Auto Arranger

Related Topics

Creating and Modifying RF Shapes Using Variables

Setting Clearances, Copying, and Creating Group/Ungroup Dialog Box
Adjacent Layer Clearances

146

RF in DxDesigner - Expedition Flow Users Manual, EE 7.9.5



RF Layout
Using RF Groups

Adding an RF Group or RF Subgroup

Add RF groups or RF subgroups to reduce the member count within an RF group or to group by
function (RF Simulator).

Use the following procedure to add an RF group or RF subgroup to the Group/Ungroup dialog
box treeview area.

Prerequisites

The design contains RF groups.

Procedure

1.

Click RF Toolkit (£,) to enable the RF toolbar (RF Toolkit Toolbar).

2. Select an RF group or RF subgroup in the treeview area (Meander Properties Dialog
Box).
3. Click Add group (E3) or Add subgroup (&3).
4. Select the new RF group name and choose Rename.
5. Type in an RF group name.
Results

A new RF group displays in the Group/Ungroup dialog box treeview area.

Related Topics

Using RF Groups Creating and Modifying RF Shapes
Using Variables Replacement and Repair
Selection Filter Dialog Box Group/Ungroup Dialog Box
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Moving Members Between RF Groups

Move members to different RF groups to maintain function, reduce member count, or for better
RF Simulator results.

Prerequisites

The design contains RF groups.

Procedure
1. Click RF Toolkit (£,) to enable the RF toolbar (RF Toolkit Toolbar).
2. Click Group/Ungroup (38).
3. Select the RF group having the member(s) to be moved.
4. Select member(s) to be moved. Use Ctrl or Shift to select more than one item.
5. Hold down the Ctrl key and drag-and-drop the member(s) to the new RF group in the
treeview area.
Results

Selected members belong to a different RF group.

Related Topics

Using RF Groups Creating and Modifying RF Shapes
Using Variables Replacement and Repair
Selection Filter Dialog Box Group/Ungroup Dialog Box
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Adding Members to an RF Group

Add additional parts, components, and so on to an existing RF group.

Prerequisites

® The design contains RF groups.

Procedure
1. Click RF Toolkit (2,) to enable the RF toolbar (RF Toolkit Toolbar).
2. Click Group/Ungroup (38).
3. Select the RF group.
4. Select objects in layout that you want to be members of the RF group.
5. Click Add Selected items to group.

Results

The selected objects are members of the RF group.

Related Topics

Using RF Groups Creating and Modifying RF Shapes
Using Variables Replacement and Repair
Selection Filter Dialog Box Group/Ungroup Dialog Box
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Moving RF Groups or Objects in RF Groups

Move an RF group or objects in an RF group before RF simulation. Moving an object within an
RF group does not affect its membership within the RF group. A member of an RF group
remains a member after a move, even if it is not physically connected to any object within an RF

group.
An RF group or individual objects within an RF group can be moved. The RF group border may

change depending on member placement (RF Group Contents).
Prerequisites

® The design contains RF groups.

Procedure
1. Click RF Toolkit (2,) to enable the RF toolbar (RF Toolkit Toolbar).
2. Click Group/Ungroup (38).
3. Select the RF group containing members (Adding Members to an RF Group).
4. Select the RF group or object (Selection Filter Dialog Box - Object tab, Group checked).
5. Select Action Key 2 Move.

The selected RF group or object attaches to the cursor. Change the Changing Snap
Points by pressing the Tab key.

6. Click to place the RF group or object.

Results

The RF group or object is in a new location.

Related Topics

Using RF Groups Creating and Modifying RF Shapes
Using Variables Replacement and Repair
Auto Arranger Group/Ungroup Dialog Box
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Placing RF Groups with Auto Arranger

RF groups in schematic capture are forward-annotated and placed in the layout tool.

Prerequisites

RF groups in schematic capture must be forward-annotated to layout.

Procedure
1. Click RF Toolkit (2,) to enable the RF toolbar (RF Toolkit Toolbar).
2. Choose Place > Place Parts and Cells and select RF Group from Criterion.
3. Select an RF group(s) and move them to the Active field ([¥][w).
4. Click the Method dropdown arrow and choose Automatic (Auto Arranger).
5. Expand the RF group and select the RF group seed.
The seed is the stationary RF group reference point during placement.
6. Click Apply.
A ghost image circuit attaches to the cursor at the seed point (Figure 4-56). Change the
seed during placement with the Tab key.
7. Click to place the RF group.

If you selected more than one RF group, the next RF group automatically attaches to the
cursor.

Figure 4-56. Auto-Arranger Ghost Image

Related Topics

Using RF Groups Creating and Modifying RF Shapes
Using Variables Replacement and Repair
Changing Snap Points Group/Ungroup Dialog Box
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RF Group Clearance Rules Dialog Box

To access:

® Choose Setup > RF > Group Clearance Rules
* With the RF Toolkit (®,) active, choose RF > Group Clearance Rules

Description

Use this dialog box to set the RF group level clearances for an RF shape to trace, pad, via, plane,
and top and bottom solder mask.

The RF group clearance rule is an RF group level rule defining the minimum distance from the
RF shape edge to a trace, pad, via, plane, and solder mask (Figure 4-57).

Figure 4-57. RF Group Clearance Rules Dialog Box
[~ RF Groups — -~ Clearances of selected groups —

# RFTransmission ﬂ_’jﬁ?—(]

Hbeak 1Layer relativel RE-5hape to I
- _Trace | Pad | Via | Plane | Top Solder | Bottor Solder |

Ni T

Tree View Area Group Level Clearance
Carner Type

¥ Fit view v Select Apply Close | &

Table 4-17. RF Group Clearance Rules Dialog Box Contents

Field Description

RF Groups | Displays all RF groups in the layout tool within the treeview area.
The treeview area displays the RF group hierarchy.

Clearances of selected groups section — Displays the selected RF group level clearances
(RF Shape Clearance Checking).

New Click, adds a new relative layer index rule.

Copy Click, copies the currently selected rule and creates a new relative layer index
rule.

Increase Click, increments the Index value so you can set clearance rules on adjacent

Layer Index | layers below the RF group. The relative layer of the RF group has an index

+ value of 0.
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Table 4-17. RF Group Clearance Rules Dialog Box Contents (cont.)

Field Description
Decrease Click, decrements the Index value so you can set clearance rules on adjacent
Layer Index | layers above the RF group. The relative layer of the RF group has an index
+ value of 0.
Delete Click, deletes the selected layer index rule.
Layer Defines the clearance rule layer. The RF group relative layer has an index
relative value of 0. Positive index values apply to layers below the RF group relative
index layer. Negative index values apply to layers above the RF group relative layer.
RF-Shape to | Displays the minimum clearance values from the RF shape to the following
elements:
* Trace — Defines the RF shape to trace distance (Trace, Via, and Pad
Clearances and Connections).
* Pad — Defines the RF shape to pad distance.
® Via — Defines the RF shape to via distance (Vias in RF Designs).
® Plane — Defines the RF shape to plane distance (RF Shape Clearance
Checking).
* Top Solder/Bottom Solder — Defines the RF shape solder-mask
clearance at the RF group level (Soldermask Control).
Type Defines the RF group corner type at the RF group level. The Type value
controls the RFGroupClearance value in the RF Group Properties dialog box.
Click the RF group level Type dropdown arrow and choose one of the
following RF group clearance corners:
Circular Square Octagonal
Fit view Checked, magnifies the selected item to fill the layout tool view.
Select Checked, selects the layout item.

Related Topics

Setting Clearances, Copying, and Creating

Using RF Groups

Adjacent Layer Clearances

Setting Clearances, Copying, and Creating

Editing Existing RF Shapes

Adjacent Layer Clearances

RF Shape Clearance Checking

Selection Filter Dialog Box
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Selection Filter Dialog Box
To access: With the RF Toolkit (£,) active, click Selection filter () (RF Toolkit Toolbar).

Description

The Selection Filter dialog box defines the selectable objects in the layout tool.

The following selections are applicable with RF designs:

Netlines

Pins

Group

RF Nodes
RF Segments
RF Shapes

Related Topics

Setting Clearances, Copying, and Creating Using RF Groups
Adjacent Layer Clearances

Creating and Modifying a Meander Editing Existing RF Shapes

Creating and Moditying Nodes

Vias in RF Designs

Vias in RF designs are of the following types:

RF via — Carefully modeled via that is a part including a reference designator of the circuit
simulation. Place the RF via part in the design with the schematic capture tool. RF vias have a
schematic representation and have simulation models available within the RF Simulator.

An RF via is like any other via with respect to object connections. Use the RF via to connect
traces, planes, or conductive shapes. The RF via has RF via entry and exit pad shapes. The RF
via has only two connections, the entry and exit layer.

Stitch via — Regular vias (standard), created with the Padstack Editor, are associated with a net
name. Use stitch vias to create ground shields, to ground an RF shape, or to connect RF shapes
on different layers. Stitch vias are placed in an exact position as required by the RF circuit. They
are not moved or removed by any optimization method unless explicitly requested.

The following via topics are available:
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* Standard Vias and RF Nodes
® Place Via Dialog Box
® Continuing a Meander on a Different Layer

Describe an RF Via as a pad stack part with an entry pad, exit pad, and drill hole. The RF via
drill hole only exists for manufacturing purposes. The RF simulator uses the RF via parameters
for simulation. RF via parameters are supported in the RF Shape Parameters Dialog Box. You
must back annotate any RF via changes.

Figure 4-58 is a schematic view of two striplines connected by an RF via (VIA2). The stripline
TL1 is on the top layer and stripline TL2 is on the bottom layer.

Figure 4-58. Schematic Capture RF Via

YTV e T
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NET]1 is the net between TL1 and the entry pad on VIA2. NET2 is the net between VIA2 exit
pad and TL2. In layout NET1 and NET2 appear as one net. In the RF simulator, the nets are
deconstructed into manageable pieces (NET1, NET2, and a drill hole with parameters).

Figure 4-59 and Figure 4-60 show an RF simulator view of an RF via.

Figure 4-59. Layout RF Via

MET1 (padstack?)

Mo connected
P —
(padstackd)

| Famm [NET2 (padstack2)

When you use the RF via to connect two striplines, the striplines and the RF vias entry/exit pads
belong to different nets as in Figure 4-60.

Figure 4-60. Layout RF Via with Nets
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Common for all RF vias is the layer span. The layer on which the pad is visible is controlled by
the RF via parameters. Drill holes are blind, buried, or through hole depending on the layer
span.

The RF via parameters are available from the library elements file as any other RF shape
(<project_dir>/RF/library elements).

The RF vias entry, exit, drill diameter, angle and material characteristics are common
parameters for all RF vias (RF Control Dialog Box). The CondILayer parameter specifies the
RF via entry pad. The Cond2Layer parameter specifies the RF via exit pad. The via hole size is
controlled by the D parameter.

The drill hole only spans the entry and exit layer as defined by the Cond1Layer and Cond2Layer
parameters. Figure 4-61 shows VIAFC RF vias with different parameters. For more information
on RF vias, refer to the RF simulator documentation (TLines-Microstrip).

Figure 4-61. RF Via Layer Span

6-layers Entry pad = CondlLayer

'/— W1
Exit pad = CondZLayer
R o Hole size =D
‘< I(_:ayzrzsl_gan = CondlLayerta
Exit pad = CondZLayer
N
Related Topics
Vias in RF Designs Objects in RF Groups - Special Conditions
Standard Vias and RF Nodes Changing an RF Net Name
Creating and Modifying a Meander Place Via Dialog Box
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Standard Vias and RF Nodes

A non-RF via (a via not in the schematic) is added in layout as any other via. Standard vias are
able to connect directly to a node (Figure 4-62). The via pad overlaps the RF shape when the
node and via have the same net.

You can only add the standard via when routing from the node or with the Place Via Dialog Box
(with the RF Toolkit active, select Edit > Place > Via).

Figure 4-62. Regular Vias on Nodes

Standard and stitch vias RF shape/meander Standard via
are placed at nodes with
traditional commands.

Related Topics

Vias in RF Designs Trace, Via, and Pad Clearances and
Connections

Creating and Modifying a Meander Objects in RF Groups - Special Conditions

Standard Vias and RF Nodes Changing an RF Net Name
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Place Via Dialog Box

To access:

* With the RF Toolkit (®,) active, click Place Vias (%) (RF Toolkit Toolbar)

* Edit > Place > Via (with RF Toolkit active)

Description

Place stitching vias around the contour of an object interactively or automatically with the Place

Via dialog box.

Stitching vias create a ground shield around a radiating object. The vias are standard vias (Vias
in RF Designs). The vias follow the contours of planes, conductive shapes, RF shapes and traces
as defined by the settings in Place Via dialog box tabs (Table 4-18).

Table 4-18. Place Via Dialog Box Tabs Contents

Dialog Tab Description

Place Via Dialog Box - The Interactive tab enables you to place regular vias

Interactive Tab interactively and define the span, net name, location, and
placement conditions for the vias.

Place Via Dialog Box - The Stitch Contour tab enables you to place rows of regular vias

Stitch Contour Tab that follow the contour of a plane, conductive shape, trace, or RF
shape.

Place Via Dialog Box - The Stitch Shape tab enables you to fill a plane or conductive

Stitch Shape Tab shape with regular vias.

Place Via Dialog Box - The Radial tab enables you to place regular vias in a circular

Radial Tab pattern with a start and end angle.

Place Via Dialog Box - The Array tab enables you to place an array of regular vias

Array Tab within a plane or conductive shape.
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Place Via Dialog Box - Interactive Tab

Description

The Interactive tab enables you to place regular vias interactively and define the span, net name,
location, and placement conditions for the vias.

Figure 4-63. Place Via Dialog Box - Interactive Tab
El Ijlan:&'i;';'ia -

Interactive | stitch Cantour | Stitch Shape | Radial | array |

Padstack: |Local: 026vIA v | Span: 14 -
et name; I$1N8|:| v]
Location

mi i (th)

Placerent Control
DR.C opti
@ Place legal
I ' DRC OfFF

[ apply ] [ Close J@

Table 4-19. Place Via Dialog Box - Interactive Tab Contents

Field Description

Padstack Defines the padstack to assign to the vias. For more information on creating
padstacks, refer to Using Padstack Editor in Library Manager in the Library
Manager Process Guide.

Span Defines the layer span for the vias.

Net name Defines the net name to assign to the vias based on the name of the plane or
conductive shape. You can also populate the Net Name field by clicking a trace,
pad, plane shape, RF node, or conductive shape that has an attached net.

Location Defines the via location. Type the X and Y coordinates in the text boxes.

RF in DxDesigner - Expedition Flow Users Manual, EE 7.9.5 159




RF Layout
Place Via Dialog Box - Interactive Tab

Table 4-19. Place Via Dialog Box - Interactive Tab Contents (cont.)

Field Description

Lock status | Defines the via status.

* None — Removes a lock or fix.

* Fixed — Temporarily fixes the via location.

* Locked — Permanently locks the via location.

DRC Options section

Place legal | Selected, places only those vias that do not cause a DRC violation (DRC RF
Violations and Design Rules Check).

DRC Off Selected, turns off DRC checking, enabling the placement of all vias.
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Place Via Dialog Box - Stitch Contour Tab

Description

The Stitch Contour tab enables you to place rows of regular vias that follow the contour of a
plane, conductive shape, trace, or RF shape.

Figure 4-64. Place Via Dialog Box - Stitch Contour Tab
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Table 4-20. Place Via Dialog Box - Stitch Contour Tab Contents

Field Description

Padstack | Defines the padstack to assign to the vias. For more information on creating
padstacks, refer to Using Padstack Editor in Library Manager in the Library
Manager Process Guide.

Span Defines the layer span for the vias.

Net name | Defines the net name to assign to the vias based on the net name of the plane or
conductive shape. You can also populate the Net Name field by clicking a trace,
pad, plane shape, RF node, or conductive shape that has an attached net.

RF in DxDesig

ner - Expedition Flow Users Manual, EE 7.9.5 161




RF Layout

Place Via Dialog Box - Stitch Contour Tab

Table 4-20. Place Via Dialog Box - Stitch Contour Tab Contents (cont.)

Field

Description

Placement

Control section — Defines via placement parameters.

Algorithm

Defines the placement algorithm. The placement of the first row of stitch vias is
independent of the algorithm. The first row of stitched vias is placed using
calculations based on the Distance and Via spacing values. The start and end
points of the first stitch via row uses the minimum Via spacing value.

Select a placement algorithm from the dropdown list:
® Triangulation - 1 Algorithm — Creates two or more via rows with staggering
vias that start with the second via row.
® Triangulation - 2 Algorithm — Creates three or more via rows with staggering
vias that start with the second via row and additional vias.
* Stagger Algorithm — Creates two or more staggered via rows that are placed
perpendicularly.

Distance

Defines the distance between the plane or conductive shape and the first row of the
stitch vias. The Distance value can be:
® 0 — Placement occurs on the edge of the plane or conductive shape.
* Positive — Placement of the first via row occurs the Distance value outside
the plane or conductive shape.
* Negative — Placement of the first via row occurs the Distance value inside the
plane or conductive shape.

Plane or conductive

A negative Distance value places shape border

the via row inside the plane or A zero (0) Distance value places
conductive shape. the via row on the edge of the

\ lane or conductive shape.

o o
0o 00 O o

e e e A positive Distance value places

o - the via row outside the plane or
©o0o0 o009

Rows

conductive shape.
Defines the number of via rows.

Via
spacing

Defines the center-to-center spacing between the vias of a row.

Row

spacing

Defines the distance between the via rows.
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Table 4-20. Place Via Dialog Box - Stitch Contour Tab Contents (cont.)

Field Description
Stagger Defines the stagger distance for the next via row.
Rows
—>| <« Stagger distance
Row Spacing 000000
4 Columns
Via Spacing

Min Defines the minimum distance between vias in different rows. With more than one

distance | via row, the via spacing value only applies to the first row. For every consecutive
via row, the via position is triangulated. If two vias are closer than the minimum
distance, only one via is inserted.

Variance | Defines the value used to vary the via placements to avoid symmetrical via
patterns. The variance value is randomly added to or subtracted from the via
placement coordinates. All via rows are adjusted by the variance value. A variance
value of zero does not alter the placement coordinates, and thus maintains a
symmetrical via pattern.

Lock Defines the via status.

status * None — Removes a lock or fix.

* Fixed — Temporarily fixes the via location.
* Locked — Permanently locks the via location.

Group section

Only vias | Selected, creates a new RF group that contains only stitch vias. The center of the
first via is the default reference point for the new RF group. If a new RF subgroup
is created, it adopts the reference point of the main RF group to which it belongs.

Vias and | Selected, creates a new RF group that contains the stitch vias and the associated

objects object. If the associated object is a member of an existing RF group, the vias
become an RF subgroup of that RF group.
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Table 4-20. Place Via Dialog Box - Stitch Contour Tab Contents (cont.)

Field Description

DRC options section — Enables you to set Design Rule Check (DRC) options (Design Rules
Check).

Place Selected, places only vias that do not cause a DRC violation (DRC RF Violations).
legal

All or Selected, places all vias if no DRC violation occurs, otherwise does not place vias.
nothing

DRC Off | Selected, turns off DRC, enabling the placement of all vias.
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Triangulation - 1 Algorithm

Use the Triangulation - 1 algorithm to create two or more regular via rows. The second and
subsequent via rows are staggered by half the Via spacing value. The via placement in the

second and subsequent rows is perpendicular to the row spacing while maintaining the previous
value (Figure 4-65 and Figure 4-66).

Figure 4-65. Triangulation - 1 Algorithm Display

2nd Row staggered by
1/2 via spacing

1st Row .

Row Spacing value

Via Spacing

Figure 4-66. Triangulation - 1 Algorithm Row Display

Iriteractive  Stitch Cantour lStitch Shape ] Radial ] Array ]

Padstack: [Central: 026V1A x| Span: |18

Net narne: %$1N1

I ER S

Placemenit Contral
Algorithm: | Triangulation -1 = ¥ Group
]_.1—0 o % Onily vias
Distance: [
d " Wias and object
Rows: |4
Yia spacing: | 50 (b ~DRC options
" Place legal
Fow spacing: | 50 (th)
’ /o ’ © all or nothing
s i i i Stagger: | (th) * DRC OFf
e d S eesews Min diskance: (kh) =
L .
T . B eEeEseww 0000 ‘Wariance: (b
@
. PRERwwe - Lock status:  |Mone v]

RF in DxDesigner - Expedition Flow Users Manual, EE 7.9.5 165



RF Layout
Place Via Dialog Box - Stitch Contour Tab

Triangulation - 2 Algorithm

Use the Triangulation - 2 algorithm to create three or more regular via rows. The second and
following via rows are staggered by half the Via spacing value. The algorithm optimizes the
number of vias by adding more vias if the distance between two existing vias is at least twice the
Via spacing value (Figure 4-67 and Figure 4-68).

Figure 4-67. Triangulation - 2 Algorithm Display
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Stagger Algorithm

Use the Stagger algorithm to create two or more regular via rows. The via placement is
perpendicular to the row spacing while maintaining the Row spacing value. The vias in the
second and subsequent rows are offset by the Stagger value in the direction parallel to an
imaginary line connecting the two vias from the previous row.

For via placement around the corners of the second and subsequent rows, the algorithm places
additional vias on an imaginary concentric arc derived from the arc formed by the two vias from
the previous row. To find the via insertion point, the algorithm uses an intersection circle that is
tangent to the previous arc with a radius equal to the Via spacing value (Figure 4-69 and
Figure 4-70). The algorithm maintains the specified via spacing for all via placements.

Figure 4-69. Stagger Algorithm Display
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Figure 4-70. Stagger Algorithm Row Display
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Place Via Dialog Box - Stitch Shape Tab

Description

The Stitch Shape tab enables you to fill a plane or conductive shape with regular vias.

Figure 4-71. Place Via Dialog Box - Stitch Shape Tab
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Table 4-21. Place Via Dialog Box - Stitch Shape Contents

Field Description

Shape Displays the name, location, and net of the plane or conductive shape selected by
Pick (Example: User 1 at 113, -112 Net: (§1N2)). You cannot edit the Shape field.

Pick Click, enables you to select a plane or conductive shape. Click Pick reference

reference | ( M), then click a plane or conductive shape to populate the Shape field.

1

Net name | Defines the net name to assign to the vias based on the name of the plane or
conductive shape.
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Table 4-21. Place Via Dialog Box - Stitch Shape Contents (cont.)

Field Description
Same as | Checked, assigns the net name to the vias.
shape Unchecked, assigns vias net name to the selection in the Net name field.
Padstack | Defines the padstack to assign to the vias. For more information on creating
padstacks, refer to Using Padstack Editor in Library Manager in the Library
Manager Process Guide.
Span Defines the layer span for the vias.
Placement Control section — Defines the via placement parameters.
Distance | Defines the distance between the plane or conductive shape and first row of the
stitch vias. The Distance value can be:
® 0 — Placement occurs on the edge of the plane or conductive shape.
* Positive — Placement of the first via row occurs the Distance value away from
the plane or conductive shape.
* Negative — Placement of the first via row occurs the Distance value inside the
plane or conductive shape.
Plane or conductive
A negative Distance value places shape border
& e P A zero (0) Distance value places
the via row inside the plane or }
. the via row on the plane or
conductive shape .
\ conductive shape
A positive Distance value places
9 9 © (o) - the vial row outside the plane or
o o o o o conductive shape.
Via Defines the center-to-center spacing between the vias of a row.
spacing
Row Defines the distance between the via rows.
spacing
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Table 4-21. Place Via Dialog Box - Stitch Shape Contents (cont.)

Field

Description

Stagger

Defines the stagger distance for the next via row.
Rows (positive or negative)

—>| <« Stagger distance

0000000
000000

Row Spacing Columns

‘4— Via Spacing

Variance

Defines the value used to vary the via placements to avoid symmetrical via
patterns. The variance value is randomly added to or subtracted from the via
placement coordinates. All via rows are adjusted by the variance value. A variance
value of zero does not alter the placement coordinates, and thus maintains a
symmetrical via pattern.

Lock
status

Defines the via status.
* None — Removes a lock or fix.
* Fixed — Temporarily fixes the via location.
* Locked — Permanently locks the via location.

Group section

Only vias

Selected, creates a new RF group that contains only the stitched vias. The default
RF group reference point is at the center of the first via inserted.

Note: The new via RF group uses the center of the RF group as the default
reference point. The new RF subgroup uses the RF group reference point.

Vias and
object

Selected, creates a new RF group that contains the stitched vias and the associated
object. If the object is an RF group member, the vias become an RF subgroup of
that RF group.

Note: The new via RF group uses the center of the RF group as the default
reference point. The new RF subgroup uses the RF group reference point.
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Table 4-21. Place Via Dialog Box - Stitch Shape Contents (cont.)

Field Description

DRC options section — Enables you to choose a Design Rule Check (DRC) option (Design
Rules Check).

Place Selected, places only vias that do not cause a DRC violation (DRC RF Violations).
legal

All or Selected, places all vias if no DRC violation occurs, otherwise does not place vias.
nothing

DRC Off | Selected, turns off DRC, enabling the placement of all vias.
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Place Via Dialog Box - Radial Tab

Description

The Radial tab enables you to place regular vias in a circular pattern with a start and end angle.

Figure 4-72. Place Via Dialog Box - Radial Tab
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Table 4-22. Place Via Dialog Box - Radial Contents

Field Description

Padstack

Manager Process Guide.

Defines the padstack to assign to the vias. For more information on creating
padstacks, refer to Using Padstack Editor in Library Manager in the Library

Span Defines the layer span for the vias.

Net name

Defines the net name to assign to the vias based on the net name of the plane or
conductive shape. Select the net name from the dropdown list. You can also
populate the Net Name field by clicking on a trace, pad, plane shape, RF node or
conductive shape that has an attached net.
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Table 4-22. Place Via Dialog Box - Radial Contents (cont.)

Field Description
Location section — Enables you to define the center of the circle.
X, Y Defines the center location of the placement circle. Enter a location or use the Pick
option.
Pick Click, enables you to select a location or object in the layout tool, which populates
reference | the Location fields. Click Pick reference ( M) and then select a location or
M object in layout.
Placement Control section — Defines via placement parameters.
Radius Defines the distance of the placement radius.
Radius
Location
—0
Start angle
End angle
Start angle | Defines the start angle, which determines the location of the first via on the arc or
circumference. You can leave the Start and End angle blank for prompting. Create
a full circle with a start angle 0° and an end angle 360°.
End angle | Defines the end angle, which determines the location of the last via on the arc or
circumference. You can leave the Start and End angle blank for prompting. Create
a full circle with a start angle 0° and an end angle 360°.
Increment | Selected, defines the angle increment for placing vias on the arc or circumference.
If you select Increment you cannot select Nr of vias.
Nr of vias | Selected, defines the number of vias to place on the arc or circumference.
Distributes the number of vias evenly. If you select Nr of vias you cannot select
Increment.
Lock Defines the via status.
status * None — Removes a lock or fix.
* Fixed — Temporarily fixes the via location.
® Locked — Permanently locks the via location.
Create Checked, creates an RF group for the inserted vias. The RF group default name is:
group radialVias<n>, where <n> is the next available integer. The default RF group
reference point is the center of the first via inserted.
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Table 4-22. Place Via Dialog Box - Radial Contents (cont.)

Field Description

DRC options section — Enables you to choose a Design Rule Check (DRC) option (Design
Rules Check).

Place legal | Selected, places only those vias that do not cause a DRC violation (DRC RF

Violations).
All or Selected, places all vias unless a DRC violation occurs, in which case the via
nothing placement process aborts.

DRC Off | Selected, turns off DRC checking, enabling the placement of all vias.
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Place Via Dialog Box - Array Tab

Description

The Array tab enables you to place an array of regular vias within a plane or conductive shape.

Figure 4-73. Place Via Dialog Box - Array Tab
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Table 4-23. Place Via Dialog Box - Array Contents

Field Description

Padstack | Defines the via padstack. Select a padstack from the dropdown list. For more
information on creating padstacks, refer to Using Padstack Editor in Library
Manager in the Library Manager Process Guide.

Span Defines the via layer span. Select a span from the dropdown list.

Net name | Displays the net name of the array. Select a net name from the dropdown list. You
can also populate the Net name field by clicking on a trace, pad, plane shape, RF
node or conductive shape that has an attached net.

Location section — Enables you to define the start location of the array.

X, Y Defines the start location of the array. Enter the X, Y coordinates for the location
point or use the Pick option.
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Table 4-23. Place Via Dialog Box - Array Contents (cont.)

Field Description
Pick Click, enables you to select a location or object in the layout, which populates the
reference | Location fields. Click Pick reference ( M) and then select a location or object in
M layout.
Placement Control section — Defines the via placement parameters.
Columns | Defines the number of via columns.
Rows Defines the number of via rows.
Via Defines the center-to-center spacing between the vias of a row.
spacing
Row Defines the distance between the via rows.
spacing
Stagger Defines the stagger distance for the next via row.
Rows (positive or negative)
—>| <« Stagger distance
Row Spacing o o o o o o
4 Columns
‘4— Via Spacing
Array Defines the angle of rotation (counter-clockwise).
angle
00
Lock Defines the via status.
status * None — Removes a lock or fix.
* Fixed — Temporarily fixes the via location.
* Locked — Permanently locks the via location.
Create Checked, creates an RF group containing the inserted vias. The default RF group
group name is: array Vias<n>, where <n> is the next available integer. The default RF
group reference point is at the center of the first via inserted.
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Table 4-23. Place Via Dialog Box - Array Contents (cont.)

Field Description

DRC options section — Enables you to choose a Design Rule Check (DRC) option (Design
Rules Check).

Place legal | Selected, places only those vias that do not cause a DRC violation (DRC RF
Violations).

All or Selected, places all vias if no DRC violation occurs, otherwise does not place vias.
nothing

DRC Off | Selected, turns off DRC, enabling the placement of all vias.

Related Topics

Creating and Modifying RF Shapes Editing Existing RF Shapes

Auto Arranger

To access:

* Setup > RF > Auto Arranger
* RF Shape Parameters Dialog Box

* With RF Toolkit active, choose Place > Place Parts and Cells and then choose
Automatic from the Method field dropdown list (Placing RF Groups with Auto
Arranger).

* RF Control > RF Design tab, select an RF group and choose Auto Arrange (RF Control
Dialog Box).

* With the RF Toolkit active, choose RF > Auto Arranger.

The auto arranger command automatically moves RF shapes and non-RF shapes in the selected
RF group using connectivity, angle, node to node, and node to pad rules.

Moving RF shapes or parts and changing RF shape parameters may disconnect the RF shapes
and parts. Use the Auto Arranger to reconnect the RF shapes and parts.

The following applies when you move or connect shapes/parts with Auto Arranger:

Invoke auto arranger with nothing selected — Select the shape or part seed when prompted.
The seed point remains stationary and all members of the RF group move to meet the rules.

Invoke auto arranger with one shape/part selected — Selection of the shape or part becomes
the seed point. All members of the RF group move to meet the rules, while the seed remains
stationary.
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Invoke auto arranger with 2 or more shapes/parts selected — Select the shape or part seed
when prompted. The seed point remains stationary and only the selected shapes/parts connect to
the seed if the rules apply.

Figure 4-74 shows an RF group imported from schematic capture and the results of placing the
RF group in layout with the automatic selection in the Place Parts and Cells dialog box (Placing
RF Groups with Auto Arranger).

Figure 4-74. Auto Arrange Before and After
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The RF group maintains the relative angle between the connected RF shapes or parts
(members). The relative angle maintains the RF group member position during moves and
rotation (Replacement and Repair).

Figure 4-75 shows the basic functionality of the Auto Arranger on a node-to-node circuit having
two microstrip lines and one microstrip bend (RF Entry Rules Dialog Box).
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Figure 4-75. RF Circuit Schematic to Layout
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The Auto Arranger uses the default node-to-node angle rules for initial placement.

Nodes determine the placement and connectivity for regular parts in an RF group (RF Shape
Node Types).

Figure 4-76. RF Circuit Layout - Default Nod-to-Pad Rules
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C1 is the seed, TL1 and TL2 rotate 180° to maintain node-to-pad rules.

Related Topics

Placing RF Groups with Auto Arranger Changing Snap Points
Using RF Groups Creating and Modifying RF Shapes
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RF Shape Parameters Dialog Box

To access:

* With the RF Toolkit (®,) active, click Parametric Parameters (=) (RF Toolkit
Toolbar)

* Double-click an RF shape

¢ Setup > RF > RF Parameters

® Select an RF shape and choose RF > RF Parameters
Description

Alter RF shapes and define Var block variable parameters with the RF Shape Parameters dialog
box.

You can use the Var block properties to define other RF shape parameters (Adding a Varblock).
Parameter changes are transferred to the schematic capture tool during back annotation.

Figure 4-77. RF Shape Parameters Dialog Box
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Table 4-24. RF Shape Parameters Dialog Box Contents

Field

Description

Instance name

Displays the reference designator of the RF shape or the meander name. If
you select more than one RF shape, this field displays the number of parts
selected (Example: 2 parts selected).

Select
parameter

Displays the RF shape parameters for the selected object, which enables you
to change the values. Change parameter values by selecting the parameter
and changing the value in the Parameters Value field.
* RF REGION and Subst have dropdown lists.
® Changing the RF_ REGION, removes the RF shape from the RF group
and moves the RF shape to the chosen RF_ REGION (RF group).

Note: You cannot delete or add properties to an RF shape. You can only
change the active parameters.

Refer to the RF simulator documentation for descriptions of RF shape
parameters.

Add

Adds a variable name and value to the Var block (Creating Var Block
Variables).

Cut

Removes the selected variable from the Var block (Creating Var Block
Variables).

Paste

Restores the Cut Var block variable (Creating Var Block Variables).

Parameters section — Enables parameter changes to RF shapes and the creation of variables
in the Var block (Var Block).

Name Displays the name of the selected parameter (refer to Meander Segment and
the RF simulator documentation for parameter descriptions).
Defines the variable name.
The Name field accepts all alphanumeric characters (a-z, A-Z, 0-9) with no
spaces.
Value Defines the parameter value. You can change the value as required:
® Real numbers must be in the format 0.0.
* Expressions that require evaluation must be in parentheses “()” (Var
Block Calculations).
® Supported arguments are listed in Equation Editor Expressions.
Unit Defines the parameter units.
Equation Editor | Opens the RF Equation Editor Dialog Box.
Information Displays the selected RF shape parameter description.
Banner
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Table 4-24. RF Shape Parameters Dialog Box Contents (cont.)

Field Description

Toggle Values | Checked, displays the parameter Value in decimal point format (Example:
30.000000mil).

Unchecked, displays the parameter Value in a format you can edit
(Example: 30mil).

Auto Arranger | Checked, automatically arranges the RF group using connectivity, angle
rule, and changes to RF shape parameters (Auto Arranger).

Related Topics

Editing Existing RF Shapes Using RF Groups
Changing RF Shape Parameter Values Replacement and Repair

Creating and Modifying RF Shapes

Use the following to create and modify RF shapes:

® Changing RF Shape Parameter Values

® C(Creating a Substrate Automatically

® C(Creating a Custom RF Shape

* Connecting Nodes and Pads with an RF Shape
* Replacement and Repair

* Creating a Custom RF Shape

Related Topics

Using RF Groups Using Variables

Setting Clearances, Copying, and Creating Editing Existing RF Shapes
Adjacent Layer Clearances
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Changing RF Shape Parameter Values

RF shapes may require parameter changes during layout development.

Procedure
1. Click RF Toolkit (£,) to enable the RF toolbar (RF Toolkit Toolbar).
2. Click Parametric Parameters ([=).
3. Select an RF shape.
4. Select the parameter you want to change.
The Parameters field is populated with the Value selected.
5. Alter the Parameters Value field as needed.

On the RF _ REGION and Subst parameters, use the Value dropdown list to choose your
selection.

6. Click Apply.

Related Topics

Replacement and Repair Adding a Varblock
Using RF Groups Using Variables

Setting Clearances, Copying, and Creating Editing Existing RF Shapes
Adjacent Layer Clearances

Creating and Modifying RF Shapes
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Creating a Substrate Automatically
The layout tool automatically creates a substrate when:

® A push occurs on a component that requires a substrate.

* A component resides on a load that does not match its substrate parameters.

When you create a substrate automatically, the components Substrate value becomes

MSub1 undefined (Figure 4-78). The Analysis > Review Hazards > Batch > RF Violations
provides additional information.

Figure 4-78. Substrate Value
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Prerequisites
® Forward Annotation has occurred (Setup > Project Integration)

®* A MSubl undefined substrate is available.

Procedure
1. Click RF Toolkit (2,) to enable the RF toolbar (RF Toolkit Toolbar).
2. Click Parametric Properties ().
3. Click the Substrate value (MSub1_undefined) dropdown arrow.
4. From the dropdown list, choose a Substrate value.

If no substrate is applicable, create a substrate and use it for the Substrate value
(Substrates).

5. Click Apply.
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Results

The undefined substrate is defined.

Related Topics

Replacement and Repair Adding a Varblock

Using RF Groups Using Variables

Creating a Library Part Editing Existing RF Shapes
Creating and Modifying RF Shapes Creating a Custom RF Shape

Creating a Custom RF Shape

Create custom RF shapes with meanders and RF shapes.

When you convert an RF shape to a custom RF shape, a reference designator is automatically
generated as referencing layer 1. The physical RF shape does not change to layer 1, only the
reference layer for the RF shape is layer 1.

Note

O

If you apply boolean operators to the conductive shape in Draw mode, it loses its relation
to the RF shape. Use the Convert RF Shape command to re-associate the conductive
shape to an RF shape.

Procedure

1. Click RF Toolkit (£,) to enable the RF toolbar (RF Toolkit Toolbar).

2. Create a conductive shape on layer 1. Use the Draw mode or import a conductive shape.

3. Create an RF group, not a subgroup with the new part name (Adding an RF Group or RF
Subgroup).

4. Select the conductive shape.

5. Click Convert RF shape (B+f).
The RF shape becomes a member of the active RF group. The RF shape requires one or
more nodes.

6. Add RF nodes to the conductive RF shape:

o Adding an Edge Node
o Adding a Floating Node
o Adding a Stub
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7. Set all RFPort pins to True.

10.
11.

d.

.

Click the Control pane (&).

Click the RF Design tab.

Expand the RF group containing the RF shape.
Expand the RF shape and select a pin.

Use the dropdown menu to set the RFPort pin True.

Generate RF shape library symbol (Creating a Library Part).

Delete the custom RF shape in the layout tool.

Place the RF custom symbol in the schematic (Placing RF Symbols).

Forward annotate the schematic capture design (Layout tool - Setup > Project
Integration).

12. Place the custom RF shape in the layout tool (Placing RF Groups with Auto Arranger).

Results

The custom RF shape becomes part of the layout design.

Related Topics

Replacement and Repair Adding a Varblock

Using RF Groups Using Variables

Creating a Library Part Editing Existing RF Shapes
Creating and Modifying RF Shapes Creating a Custom RF Shape

Connecting Nodes and Pads with an RF Shape

All the pads and nodes of a conductive RF shape create an electrical RF net (Multiple Nets and
Pad Connections). Nodes and pads with different nets are connected with the RF shape
(Multiple Nets and Pad Connections).

Procedure

1.
2
3.
4. Click Convert RF shape (5+f).

Create a conductive shape that encloses the pads and nodes as shown in Figure 4-79.

. Click RF Toolkit (£,) to enable the RF toolbar (RF Toolkit Toolbar).

Select the conductive shape.

The RF shape becomes a member of the active RF group.
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Figure 4-79. Conductive Shape and Nodes

Connect Nodes and Pads

Create Conductive Shape

Convert Conductive Shape to RF Shape Part Properties
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RFHode NodePiningle:0

RFHode HodeFindngle: 0

RFFloatingHode: 1,2

EFShape Instancelodification: TRUE
RFParanetric: COMP=Fized RF_EEGION=C
EFNodeEntryRules: [Hode2Node=[ ]][Nod =
RFLayvoutComponent : TRUE

¥
< | 2

5. Review that the Part Properties dialog box, Other field lists the RF shape nodes.
Related Topics

Replacement and Repair Adding a Varblock

Using RF Groups Using Variables

Creating a Library Part Editing Existing RF Shapes
188

RF in DxDesigner - Expedition Flow Users Manual, EE 7.9.5



RF Layout
Creating and Modifying RF Shapes

Creating and Modifying RF Shapes Creating a Custom RF Shape

Replacement and Repair

After placing an RF group, you change the size of an RF shape by interactive editing or by
updating parameters. If any changes break a circuit connection, use one of the following
methods to repair the circuit.

® Choose RF > Auto Arranger and select the seed.
* Select Setup > RF > Auto Arranger.

® Select the RF in the RF Control Dialog Box, (Control pane (")), select the RF group
and choose Auto Arranger.

The Auto Arranger stretches, reduces, and shoves the RF shapes to meet the parametric changes
with the RF shapes connectivity and angle rules.

When you invoke Auto Arranger and multiple RF shapes are involved, you are prompted to
select the seed part. If the circuit cannot be repaired due to violations, the Auto Arranger
terminates.

To prevent Auto Arranger termination, set the interactive Design Rule Check (DRC) to off. Use
the Analysis > Batch DRC to run DRC (DRC RF Violations).

In Figure 4-80 TL1 is the seed RF shape for both sides because it is the shape being edited. In
the left side, TL1 length is decreased by half the original length. When you invoke the Auto
Arranger, it moves B1 and TL2 to maintain the connectivity and angle rules. In the right side,
TL1 length is increased by half its length. When you invoke the Auto Arranger, it moves B1 and
TL2 to maintain the connectivity and angle rules.

Figure 4-80. Repair Circuit after Shape Edit

TLZ TL?

TL2
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Related Topics

Auto Arranger Editing Existing RF Shapes
Using RF Groups Creating a Custom RF Shape
Creating a Library Part Creating and Modifying RF Shapes

Creating a Library Part

During project development you may need to create an RF shape and place it in the schematic
capture design. Create a custom RF shape in the layout tool or import an RF shape from the RF
simulator into the layout tool and place it in the library. You can instantiate the custom RF
shape in the schematic capture tool as you do with any other RF shape.

Note
D If you are using Agilent ADS RF simulator to create the RF shape, you need to add the

ADS MODEL property to the part. You add the ADS MODEL_ LIBRARY property for
vendor RF parts that are outside the current project directory.

Custom RF shapes can contain the following:

® Conductive shapes * Fixed shapes ® Pad obstructs

*® Plane obstructs * Plane shapes * Standard RF shapes
* Stitch contour property ® Trace obstructs ® Trace-via obstructs
® User vias (with ® Via obstructs

component vias)

Note
The custom RF shape is project specific. To use this shape in a different design, copy the
library _elements file to the new project (<project_dir>/RF/library elements).

Prerequisites
* The RF shape must be part of an RF group (Group/Ungroup Dialog Box).
* The RF shape must have at least one node (RF Shape Node Types).
® The RFPort property must be set to True for each RF shape node (RF Control Dialog
Box, RF Design tab).
Procedure
1. Click RF Toolkit (2,) to enable the RF toolbar (RF Toolkit Toolbar).
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Click Control pane ().
Select the RF Design tab.

Select the RF group that contains the new library part.

A

Choose Generate Library Symbol.
The Create Schematic Symbol dialog box displays (Figure 4-82).
If the RF group contains unsupported elements, a warning message displays.
6. Fill in the information in the Create Schematic Symbol Dialog Box.
7. Click OK.
The custom RF shape definition is stored in the RF library elements file and the
schematic symbol is stored in ...\SymbolLibs\<partition>\sym in the library.
Results
The RF shape is listed in the RF Control Dialog Box, RF Library Shape tab - User
folder.

Related Topics

Using RF Groups Editing Existing RF Shapes
Creating and Modifying RF Shapes Creating a Custom RF Shape
RF Shape Clearance Checking
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Equation Editor Dialog Box
To access: With the RF Toolkit (2,) active, click Parametric properties > Select parameter >
Click Equation Editor (RF Shape Parameters Dialog Box)
Description
Use this dialog box to create variables and to create an RF shape parameter equation.
Refer to Equation Editor Expressions for supported functions.
Refer to the RF simulator documentation for more information on mathematical operators.

Note
Only real numbers are supported.

Figure 4-81. Equation Editor Dialog Box

Farameter Wariables

10 | [ << Insert

[ (64 ] [ Cancel ] @

Table 4-25. Equation Editor Dialog Box Contents

Field Description

Parameter Defines the variables or parameter equation (Var Block Calculations).

<< Insert Copies the selected variable in the Variables field (Var block variables) to
the Parameter field.

Variables Displays the Var block variables.

Related Topics
Using Variables Var Block
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Using Variables

Use the following to create variables for an RF group:

® Var Block

®* Adding a Varblock

® Creating Var Block Variables

® C(Creating Variables for RF Shape Parameters

* Var Block Calculations

Related Topics

Using RF Groups Editing Existing RF Shapes

Var Block

A Var (variable) block contains variables and/or simulation equations. The Var block can
contain absolute values or reference variables, which may contain one or more functions (Var
Block Calculations).

The Var block is a member of an RF group and the variables only apply to that RF group and
subgroups. The Var block symbol has no graphical representation in the layout tool.

Select the RF group in the RF Control Dialog Box, RF Design tab. The Var block popup menu
enables you to:

* Edit Var Block — Opens the RF Shape Parameters Dialog Box
® Cut Var Block — Deletes the Var Block so you can paste it to another RF group.
* Delete Var Block — Removes the Var block from the RF group.

Related Topics

Using Variables Creating and Modifying RF Shapes

Adding a Varblock

The varblock enables you to create variables. You can use the variables to define RF shape
parameters. When you change a variable, all the RF shapes parameters with that variable
change.
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Procedure
Click RF Toolkit (£,) to enable the RF toolbar (RF Toolkit Toolbar).

1.

2. Click Control pane ().
3. Select the RF Design tab.
4,
5

Select the RF Group.

. Choose Add Var Block from the popup.

The RF Shape Parameters Dialog Box appears with a default instance name (RF-

<groupname>-varblock).

Related Topics

Using Variables

Creating and Modifying RF Shapes

Creating Var Block Variables
Define the RF shape parameters with Var block variables (Adding a Varblock).

The Equation Editor Expressions enables creation of variables and/or simulation equations. You
create variables to define RF shape parameters (RF Shape Parameters Dialog Box).

Prerequisites
The RF group must have a Var block (Adding a Varblock).

Procedure
Click RF Toolkit (£) to enable the RF toolbar (RF Toolkit Toolbar).

I.

2
3
4.
5

L ® =N

. Click Control pane (¢).
. Select the RF Design tab.

Expand the RF group that contains the Var block.

. Select the Var block and then choose Edit Var Block from the popup.

The RF Shape Parameters Dialog Box appears.

Type in the variable Name, Value, and select Unit in the Parameters field.

Click Add. The Select parameters field lists the new variable.

Add additional variables or simulation equations as needed.

Click OK.
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Related Topics

Using Variables Creating and Modifying RF Shapes

Creating Variables for RF Shape Parameters

Define RF Shape parameters with Var block variables within an RF group.

Prerequisites

® The RF shape must be a member of an RF group containing a Var Block (Adding a
Varblock).

® The Var block must contain variables (Creating Var Block Variables).

Procedure
1. Click RF Toolkit (2,) to enable the RF toolbar (RF Toolkit Toolbar).
2. Select an RF shape.
3. Click Parametric Properties () of the RF toolbar.
4. Select a parameter in the Select parameter field.
The Equation Editor button becomes active.
5. Click Equation Editor.

6. Change or alter the parameter value and click << Insert to insert a selected variable
from the Variables field. The Variables field contains the Var block variables.

Expressions that require evaluation must be in parentheses “()” (Var Block

Calculations).
7. Click OK.
Results

RF Shape parameter displays the new parameter value.
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Related Topics

Var Block Replacement and Repair
Adding a Varblock

Var Block Calculations

An RF shape parameter can contain variables (expressions), which require calculation. An
expression must be evaluated to create the correct value. Expressions that require evaluation
must be in parentheses “()”.

The schematic capture or layout tools evaluate expressions with mathematical operators
(Equation Editor Expressions). Advanced RF simulator expressions are sent to the RF simulator
for evaluation.

Note
You must have an active link to the RF simulator to check the advanced RF simulator
expressions (Connecting Layout to RF Simulator Server).

For example, the following parameter requires evaluation:

* [=(Lin/2+1.25*3) mm, where Lin is a variable defined by the Var instance.

Related Topics

Using Variables Creating and Modifying RF Shapes
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Create Schematic Symbol Dialog Box

To access: RF Control Dialog Box, RF Design tab, select the RF group, and choose Generate
Library Symbol.
Description

Use this dialog box to define the symbol name and to designate the location for the symbol in
the Central library. Creating a symbol for the RF shape in the central library enables you to
instantiate the symbol in the schematic capture tool.

Figure 4-82. Create Schematic Symbol Dialog Box

Create Schematic Symbol
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Table 4-26. Create Schematic Symbol Dialog Box Contents

Field Description

Name Defines the symbol name. The RF group name is the default name.
If the name matches a current RF shape name, “ 0 appends to the name
(Example: my group, my_group 0).

Scale Defines the symbol display size in the schematic capture tool. The
schematic symbol defaults to the display size of the RF group layout tool.
The scale factor (0.2 to 20) is a multiplier of the original RF group size. In
this example, the area in units has the following scaling factors:

® Scale 0.2 =10 unit

® Scalel =50 unit

® Scale 20 = 1000 unit

Central Library | Defines the Central Library.

Partition Defines the Central Library partition for the symbol.

Related Topics

Creating a Library Part Editing Existing RF Shapes
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Creating and Modifying RF Shapes

RF Shape Clearance Checking

RF Shapes from different RF groups are checked against each other using the RF-shape-to-trace
clearance. Checking does not occur between RF shapes in the same RF group. Clearance checks
of RF shapes use the largest RF shape-to-trace clearance value (Figure 4-83). A violation occurs
when an RF shape clearance touches or overlaps a segment of another RF group (Layer-to-
Layer Clearance Rules).

Regardless of RF group membership, if an RF segment violation occurs between RF groups, it
is flagged as an error by DRC (Design Rule Checking) unless the RF segment has a common
shape or is directly connected by a node pair (DRC RF Violations).

RF Shapes (even within the same RF group) must maintain RF shape clearance rules to design
objects. The RF shape clearance is controllable in all directions including tapered clearances
(Clearance Editor Dialog Box). The clearance rules are hierarchical; the RF group has the
lowest priority and segments has the highest priority. The RF group clearance is the same as the
RF shapes clearances within the RF group. All RF shapes within the RF group use the RF group
rules (RF Group Clearance Rules Dialog Box).

Figure 4-83. RF Group to RF Group Clearance

Mixer-1 (RF Group)

Mixer-2 (RF Group)

Refer to RF Group to RF Group Clearance Check for clearance details for nested RF groups.

No checking occurs between RF nodes within an RF group or between RF groups. In addition
no checking occurs between RF nodes and any obstructs as long as the node and the obstruct are
members of the same RF group.

The following RF Group (top level) to RF Group (top level) clearances are supported:
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Trace, Via, and Pad Clearances and Connections
RF Group to RF Group Clearance Check
Layer-to-Layer Clearance Rules

Overlap Check

RF Shape Clearance Restrictions and Exceptions

Figure 4-84 gives an overview of the different rules you can set between RF shapes. Traces,
vias, pads, and planes use the netclass clearances even if they belong to an RF group.

Figure 4-84. Clearance Model - Overview

A — RF shape-to-Pad F — Trace-to-Trace (netclass)

B — RF shape-to-Trace G — Pad-to-Trace (netclass)

C — RF shape-to-Via H — RF shape-to-Plane

D — Pad-to-Pad (netclass) [ — Trace-to-Plane (netclass)

E — Pad-to-Plane (netclass) J — RF shape-to-RF shape (with the

trace obstruct from TL2)

Related Topics

DRC RF Violations Setting Clearances, Copying, and Creating

Adjacent Layer Clearances

Using RF Groups Editing Existing RF Shapes

Creating and Modifying RF Shapes
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Trace, Via, and Pad Clearances and Connections

The Clearance Editor Dialog Box enables you to set per side clearances. The clearance of one
RF segment or shape can prevent the connection of a different RF segment or shape. This is
illustrated in Figure 4-85. The clearance of TL1 encompasses TL2 open node, which prevents
any connection.

Figure 4-85. Clearance - Route Clearances

j‘/ TL1 large clearance

\
: \ .

| | TL1 clearance encloses TL2 open node. This
\

\

- / prevents connection to a trace unless the
| condition in the note is applied.

Note: A trace can connect to a node only if the trace and node belong to the
same net. However, you cannot use a single node net to create a net exception.

A trace can violate multiple clearances if:

* All RF shape clearances belong to the same RF group (Figure 4-87).

® The connecting trace to a node must have the same net. Only the connecting segment
can violate the RF shape clearances (RF Entry Rules Dialog Box).

® The trace clearance overlaps the node clearance.

Figure 4-86 shows the open node of TL3 being overlapped by two different RF shape
clearances.

Figure 4-86. Clearance - RF Shapes in Different RF Groups

Different net traces  — — — — RF Group 2

-

L
\

RF Group 1 No connection is possible

because TL3 and TLS5 belong to
different RF groups.

To enable a node-trace connection, the RF shapes must belong to the same RF group when the
RF shape clearance overlaps a node (Figure 4-87).
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Figure 4-87. Clearance - RF Shapes within an RF Group

All shapes are in the same RF group. The blue
trace is allowed to connect even if the shapes are
not physically connected.

A trace is allowed to connect because TL1
and TL2 belong to the same RF group.

If all RF shapes belong to the same RF group, a trace is allowed to violate the RF shapes
clearances and connect to a node (Figure 4-88).

Figure 4-88. Clearance - Shapes in Same Group

Traces connect to nodes when they belong to the
same net. The blue and green nets are allowed to
violate multiple clearances because the clearances
belong to RF shapes within the same RF group.

A trace segment clearing an RF shape clearance cannot enter another RF shape clearance unless
it connects to the RF shape node. Figure 4-89 shows a trace violation until you connect the trace
to the TL2 node.

Figure 4-89. Clearance - Trace in Violation

A trace segment is invalid if it enters a
new RF shape clearance without
connecting to TL2 RF shape node.

A trace connecting to an RF shape cannot re-enter the same RF shape clearances again. When
multiple RF shape clearances overlap, they are treated as a single RF shape clearance (Trace
Connection Clearance). Traces TL1 to TL2 and TL1 to TL3 in Figure 4-90 are in violation. The
traces are not in violation when they connect to the nodes (TL1 to TL2 and TL1 to TL3).
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Figure 4-90. Clearance - Overlapping
TL1, TL2, and TL3 belong to the same RF group

The trace is invalid because it re-
enters the clearances. The trace is invalid until it

connects to TL3 node.

TL3 clearances are not merged
because TL3 is not overlapping

TL1 or TL2 clearances.
TL1 and TL2 clearances are

merged and treated as one
clearance.

Note
D The same rules apply to pad and via clearances.

A plane clearance always clears the RF shapes unless you set the RF shapes node Connect to
plane property to Connect (RF Control Dialog Box). Plane shapes are not allowed to violate
multiple RF shape clearances.

For example in Figure 4-91 let TL2 be an open node with a Connect-to-plane setting Connect.
On the left side of Figure 4-91, the RF Shape-to-Plane clearance of TL1 prevents the plane
connection to TL2 open node. The right side of Figure 4-91 shows a TL1 RF Shape-to-Plane
clearance reduction. This enables the TL2 open node to connect to the plane (Node Properties).

Figure 4-91. Clearance - Plane Obstructs

Related Topics

DRC RF Violations Setting Clearances, Copying, and Creating
Adjacent Layer Clearances
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Using RF Groups Editing Existing RF Shapes
Creating and Modifying RF Shapes RF Shape Clearance Checking

RF Group to RF Group Clearance Check

Clearance checking occurs between RF shapes and meanders when they belong to separate RF
groups. Clearance checking occurs between only top-level RF groups. RF group clearance
checking uses the RF groups largest RF shape to trace clearance value (RF Group Clearance
Rules Dialog Box).

Note
RF Group checking only occurs between RF shapes. Other design objects are not

included in this check.

Figure 4-92 shows two top-level RF groups with pads and RF shapes. A pad uses the RF-Shape-
to-Pad rule against all shapes (RF Group Clearance Rules Dialog Box).

Figure 4-92. Clearance - RF Group to RF Group Clearance

Sroup-z2

A — RF Shape to pad clearance C — RF Shape to pad clearance

B — Pad to pad clearance (netclass) D — RF group to RF Group clearance
(RF shape-to-trace value)

Related Topics

DRC RF Violations Setting Clearances, Copying, and Creating
Adjacent Layer Clearances

Using RF Groups Editing Existing RF Shapes

Creating and Modifying RF Shapes RF Shape Clearance Checking
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Layer-to-Layer Clearance Rules

An RF shape may require clearances on adjacent layers. Create layer to layer clearance rules
with the RF Group Clearance Rules Dialog Box. You create adjacent layer clearances by
creating a new clearance rule and specifying the layer with the Increase/Decrease Layer Index
( 4| #]) arrows (Setting Clearances, Copying, and Creating Adjacent Layer Clearances).

Figure 4-93 shows an RF segment with layer to layer clearance rules. The physical layer of the
RF shape is Index 0. Positive Index values (+1) define layers below the RF shape. Negative
Index values (-1) define layers above the RF shape. The clearance rules follow the RF shape as
the shape moves in the stackup (RF Shape Layer Change - Clearances).

Figure 4-93. Clearance - Layer to Layer Rules
=== Area fills/metal objects RF shape #=» (learance area

RF shape to any object Substrate
clearance for layer 1

_"z‘izzz“_ Index 0
Layer 1 Index +1
Layer 2 Index +2
Layer 3 Index +3
Layer 4 Index +4
Layer 5

VI T IVIIITS

1T

J

Layer 6

Layer 1 through 4 define RF
shape to plane clearances

Figure 4-94 shows clearance layer rules above and below the RF shape (RF Shape Layer
Change - Clearances).

Figure 4-94. Clearance - Relative Z-axis
=== Area fills/metal objects

RF shape
rz#: (Clearance area
Substrate
<« Signal 1  RF shape-to-plane, Index -1 = 5th
T 72 oy e—-— Slgnal 2 Index O

| s sssssrss B B Slgnal 3 RF shape-to-plane, Index +1 = 10th
e Slgnal 4
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Related Topics

DRC RF Violations Setting Clearances, Copying, and Creating
Adjacent Layer Clearances

Using RF Groups Editing Existing RF Shapes

Creating and Modifying RF Shapes RF Shape Clearance Checking

RF Shape Layer Change - Clearances

The Figure 4-95 (left) shows the RF shape that has layer clearances on Signal 1 and Signal 3
(Layer-to-Layer Clearance Rules). Figure 4-95 (right) shows the results after pushing the RF
shape to Signal 3. The RF shape layer clearances applying to Signal 2 and Signal 4.

Figure 4-95. Layer Clearances Shift on Push

=== Area fills/metal objects === RF shape Clearance area
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Figure 4-96 (left) shows an RF shape that has layer clearances on Signal 1 and Signal 3.
Figure 4-96 (right) show the results after pushing the RF shape to Signal 1. The RF shape layer
clearance only applies to Signal 2 after the push. The layer clearance above the RF shape
becomes inactive. The layer clearance above the RF shape remains inactive as long as the RF
shape remains on the top layer of the stackup. Pushing the RF shape down into the stackup,
causes the layer clearance above the RF shape to become active. Pushing the RF shape to Signal
5, would inactivate the bottom RF shape layer clearance.

Figure 4-96. Inactive Layer Clearance

=== Area fills/metal objects The top clearance is
made inactive as it is

RF shape pushed outside the board
r#z= (learance area stackup.
Index Srrrrrrrsi Index
] sy m———-—— Slgnal 1 — o —— trr. | 0
0 — 4 (2 2 r—— S gnal 2 o esmsrrrrrrrs e ]

_|_1 [ v sssssssss B B Slgnal3 —
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<«— Signal5 —»
Before Push After Push Up

Note
D CES layer and RF shape rules apply to RF shapes.

Related Topics

DRC RF Violations Setting Clearances, Copying, and Creating
Adjacent Layer Clearances

Using RF Groups Editing Existing RF Shapes

Creating and Modifying RF Shapes RF Shape Clearance Checking
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Overlap Check

During creation of the RF circuit, DRC checking may be inhibited, which enables RF shape
overlapping or edge to edge placement. Overlapping RF shapes are flagged as a DRC violation
regardless of RF group membership.

Note
D The non-connected node violation occurs in DRC unless you have defined the node as a
no-connect node (RF Control Dialog Box).

Figure 4-97 shows two separate top-level RF groups. Trace 1 RF group has RF shapes having
only one open node. DRC does not post any edge to edge violations. Trace 2 RF group has an
RF shape with two open nodes. DRC posts an edge to edge violation. The edge to edge violation
enables you to evaluate the connection.

Figure 4-97. Clearance - Overlap Check

# Un ted =

MLIM

RF shapes not sharing a common RF shape (through connectivity) can have an edge to edge
DRC violation posted. Figure 4-98 shows RF shapes sharing a common RF shape (CR1)
through connectivity. No DRC violations are posted.

Figure 4-98. Overlapping Not in Error

All these edge to edge connections
have a common RF shape connection
(CR1). No DRC violations are posted.
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Related Topics

DRC RF Violations Setting Clearances, Copying, and Creating
Adjacent Layer Clearances

Using RF Groups Editing Existing RF Shapes

Creating and Modifying RF Shapes RF Shape Clearance Checking

RF Shape Clearance Restrictions and Exceptions

Not all RF shapes in the library support a unified clearance around the RF shape. For example,
an inductor only supports RF group and shape rules.

All RF shapes supporting a per-side clearance use the Clearance corner type defined in the RF
Control Dialog Box.

Related Topics

DRC RF Violations Setting Clearances, Copying, and Creating
Adjacent Layer Clearances

Using RF Groups Editing Existing RF Shapes

Creating and Modifying RF Shapes RF Shape Clearance Checking

Adding and Deleting RF Elements

Add or delete RF elements from a design with the layout tool. You can also increase the Pin
Spacing in the AutoPlacer dialog box (Expedition PCB User’s Guide). This moves pin-to-pin
connections for elements further apart, which enables disconnecting, deleting, adding, or
connecting RF elements easier.

Note
RF port elements (those on the border of a design) cannot be deleted. You must set up

context editing prior to deleting RF elements (Expedition PCB User’s Guide).

Related Topics

Creating and Modifying RF Shapes Editing Existing RF Shapes

Setting Clearances, Copying, and Creating Using RF Groups
Adjacent Layer Clearances

Replacement and Repair Reusing RF Schematic Capture Blocks
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Reusing RF Schematic Capture Blocks

When you make changes to a replicated block, those changes are reflected in all occurrences of
that block. This includes any changes you make in the layout tool to objects, nets, or their
parameters.

Figure 4-99 illustrates a system level schematic and the related layout representation for an RF
region (block) instantiated multiple times. This provides a secure way to keep design databases
synchronized, while reducing the overall work required to make changes.

When you finish your changes in layout, update the schematic sheets by synchronizing the
design (Back Annotation). Synchronization modifies only one schematic capture model because
the RF regions are identical and they refer to the same schematic.

Note
D The process of reusing RF Blocks is not the same as the PCB Reuse facility.
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Figure 4-99. Reuse Blocks
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Related Topics

Placing RF Groups with Auto Arranger
Adding and Deleting RF Elements
Creating and Modifying RF Shapes

Setting Clearances, Copying, and Creating
Adjacent Layer Clearances

Auto Arranger

Design Rules Check
Editing Existing RF Shapes
Using RF Groups
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Replacement and Repair

Design Rules Check

Design Rules Check (DRC) settings control several aspects of both interactive and automatic
routing in the layout tool. Design rules form the basis for checking the connections created by
the router in layout.

Within an RF group or multiple RF regions, the following DRCs are ignored.
Placement DRCs for parameterized components:
* Pin to pin.

* Component type to component type (RF Specific Component to Component Checking).
Routing DRCs:

® Trace to polygon, if the net connects to the same component pin.
* Viato polygon, if the net connects to the same pin.

DRC checking affects all components that are part of an RF group. Components that are not part
of an RF group receive the full layout DRC checking for placement and routing. Figure 4-100
shows the ignored DRC checks for an RF group.

Figure 4-100. RF DRC Checks Ignored
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Related Topics

RF Shape to Element Rules RF Shape Clearance Checking
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Design Rules Check

RF Specific Component to Component Checking

Distributed and discrete RF components within an RF group are checked with RF specific rules.
These rules apply rather than the standard Design Rules Check (DRC).

RF components are:

* Distributed RF elements such as transmission lines, stubs, and couplers which are
etched copper and are part of the PCB.

* Discrete components or packaged parts such as resistors, capacitors, and Op Amps
which are placed on either the top or bottom side of the PCB.

DRC checking for RF specific rules enables the following:

® Placement of RF components on inner layers.
® Multi-layered RF components having different geometries on individual layers.
® Placement outlines that intersect provided the metal does not touch.

With DRC active, RF specific rule checking displays error messages about component
violations during interactive placement. RF specific checking occurs during batch mode
checking.

When you use RF Specific component-to-component checking, DRC settings are modified as
follows:

* Component geometries on different layers can have polygon intersections. These
violations are not considered errors.

* Two or more components can each have a node (pin) on the same net without causing a
violation.

® The DRC check includes any violations between two RF distributed components and
between an RF distributed component and a packaged part.

Related Topics

Design Rules Check RF Specific Component to Component
Checking

RF Shape Clearance Restrictions and DRC RF Violations

Exceptions
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DRC RF Violations

DRC RF Violations

RF DRC violations may occur during design development. Run Analysis > Batch DRC and
view the following RF error and warning messages:

* RF Shape to Element Rules

®* DRC RF Clearance and Overlap
* DRC Node and Pad Entry Rules
* RF Expired Nodes

* DRC RF Connectivity

Related Topics

Design Rules Check RF Shape Clearance Checking
Creating and Modifying RF Shapes Editing Existing RF Shapes

RF Shape to Element Rules

Click the Analysis > Batch DRC > Advanced Element to Element Rules button, the Element
to Element dialog box appears (Figure 4-101). The RF Shapes row defines element to element
rules.

Figure 4-101. Element to Element Dialog Box
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DRC RF Violations

Related Topics

Design Rules Check
Creating and Modifying RF Shapes
DRC RF Violations

RF Shape Clearance Checking
Editing Existing RF Shapes

DRC RF Clearance and Overlap

The RF Shape Clearance Checking violations appear in Proximity Hazards (Analysis > Review
Hazards > Batch > Proximity) (Figure 4-102). The types of violations include:

* RF Groups

* RF Shape to RF Shape
* RF Shape to Trace

* RF Shape to Pad

® RF Shape to Via

® RF Shape to Plane

® Overlap Check

Figure 4-102. DRC Proximity Dialog Box
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RF component violations are listed in the Components Hazard (Analysis > Review Hazards >

Online > Components).
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DRC RF Violations

Related Topics

Design Rules Check RF Shape Clearance Checking
Creating and Modifying RF Shapes Editing Existing RF Shapes
DRC RF Violations

DRC Node and Pad Entry Rules

The RF connectivity violations for node and pad entry rules are listed as Open Netlines Hazards
(Analysis > Review Hazards > Online > Open Netlines).

The RF net or partial net violations are listed as Unrouted / Partial Nets Hazards (Analysis >
Review Hazards > Batch > Unrouted / Partial Nets).

Violations to node entry rules defined in the RF Entry Rules Dialog Box are listed as Node
Entry Hazards (Analysis > Review Hazards > Online > Node Entry) and have the following
violation types:

* Node-to-trace entry angle violation. The trace entry/exit is in violation (RF Shape Node
Entry Angle).

* Node-to-trace escape violation. The trace changed direction before it cleared the shape
(Trace Connection Clearance).

* No connection from Node-to-trace. The trace is not truly connected to the node (Node-
to-Node and Node-to-Trace Rules).

* Node-to-trace unknown violation. None of the above violation types apply.

Related Topics

Design Rules Check RF Shape Clearance Checking
Creating and Modifying RF Shapes Editing Existing RF Shapes
DRC RF Violations
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RF Expired Nodes

When updating RF shapes, the RF design nodes in violation are written in the RF Violation
ASCII file (Analysis > Review Hazards > Batch > RF Violations).

The file lists all floating nodes in violation (Figure 4-103). You must manually change the
Expired property to True in the RF Control Dialog Box, RF Design tab, Node Properties field,
to remove the floating node violation.

Additional violation information appears in the RF Violations file.

Figure 4-103. RF Violations Display
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Related Topics
Design Rules Check RF Shape Clearance Checking
Creating and Modifying RF Shapes Editing Existing RF Shapes

DRC RF Violations
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DRC RF Violations

DRC RF Connectivity

RF design connectivity errors are reported in Analysis > Review Hazards > Online > Open
Netlines and Analysis > Review Hazards > Batch > Unrouted / Partial Nets.

Related Topics

Design Rules Check RF Shape Clearance Checking
Creating and Modifying RF Shapes Editing Existing RF Shapes
DRC RF Violations
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Chapter 5
Generating Manufacturing Data

Post Processing an RF Design

Before you generate manufacturing data for a PCB design that contain RF circuits, you must
make sure the data is precise. Typically, RF circuit dimensions are much smaller that those of
analog or digital designs and require a more accurate format.

Make sure to review hazards before generating output. For more information on reviewing
hazards, refer to the PCB Verification Guide.

For more information on generating manufacturing outputs, refer to Manufacturing Inputs and
Outputs Guide.

Note
The RF-specific DRC checks and the clearance values that you set in PCB Layout are

honored in FabLink XE Pro. These values are only viewable in FabLink XE Pro.

Related Topics

RF Layout
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Chapter 6
Importing a Design

You can import your design from the Advanced Design System (ADS) RF simulator into the
schematic capture tool in the IFF (Intermediate File Format). Schematic RF elements created in
non-Mentor Graphics schematic capture tools are not imported. RF shapes are added within the
schematic capture tool and meanders are added in layout.

Importing ADS Data into Layout

You can update placement and parameter settings in ADS and import them into the layout tool.

Meander lines (traces) and floating metal are imported from ADS into the layout design as area
fills. Figure 6-1 shows the ADS layout toolbar that you use to create objects and text to be
imported. All of these previously listed elements (except polylines) import as floating metal,
which are area fills not connected to a net. The imported area fills are associated with an RF
group which you can rotate and move with the components in the RF group.

Figure 6-1. ADS Layout Toolbar

Create A New Rectangle
Create A New Polygon l Add Text
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Create A New Polyline Create A New Circle

Figure 6-2 shows the ADS Create A Trace icon. It creates meander lines, which connect
component pins to existing meander lines. You import these ADS traces into the layout design
as meander lines. You can also create an ADS trace that starts and stops on another trace and is
not supported in the layout tool.

Figure 6-2. ADS Create Traces Icon Layout Toolbar

m | '_' : Nﬁ Create A Trace

Use the following procedure to import a RF simulator design into layout.
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Importing ADS Data into Layout

Prerequisites

There is a design in the RF simulator. (Refer to RF simulator documentation).

Procedure

. (Optional) enter an area fill aperture size in board units.

The aperture size affects floating meander lines and meander traces. If you do not
specify a value, the software assignes a small aperture value to attempt to make the
actual shape close to the input shape of the area fill. The default values are: 0.001 mm,
0.05 mils, and 0.00005 inches.

Create an IFF file.
Click OK to import the IFF data into the Mentor Graphics layout tool.

When the import process is finished, all modified parameters are updated. The new
shapes appear on the board, and the correct placement is updated.

During import, the layout, X/Y location, orientations, and RF instance parameters
(including hierarchical parameters) are read in for all instances. These instances map to
equivalent instances already present in the Mentor Graphics design. The software
generates a warning message for any elements that cannot be mapped to an equivalent
element in the Mentor Graphics layout tool and maintains RF region information, such
as rotation and parameter changes, for successive imports. For connectivity changes,
you must synchronize with and translate from the schematic.

Results

The RF simulator design displays in the layout tool.

Related Topics

IFF Import Dialog Box
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Chapter 7
Exporting an RF Design

Use the following to export schematic capture and layout design data IFF (Intermediate File
Format) files.

* Exporting an RF Design from Schematic Capture

* Exporting an RF Design from Layout

Related Topics

Importing a Design RF Layout

Exporting an RF Design from Schematic Capture

Agilent IFF syntax requires you to specify variable definitions in the schematic .iff files only.
Any changes to variables (including the addition of new variables) requires a schematic IFF
transfer of Agilent EEsof data followed by a transfer of layout IFF data.

Use the following procedure to create an IFF file from the schematic capture tool.

Prerequisites

® A schematic must contain an RF group (Creating an RF Group).

Procedure
1. Select the RF Groups tab in the Navigator window.
2. Select an RF group for exporting.
3. Choose Generate Schematic Data.
The software generates an .iff file at:
<project directory>\RF\netlist\iff\<project name> <group name> <current date
(yyyymmdd)> <current time (hhmmss)>.iff
Results

The project directory contains the .iff file with the correct time stamp.
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Exporting an RF Design from Layout

Related Topics

Exporting an RF Design from Layout Exporting an RF Design

Exporting an RF Design from Layout

When you export a design you can export the entire design or only a selected area. All
components on the board that are part of the RF group are included in the export. The resulting
.iff file includes information such as locations, orientations, and RF instance parameters
(including hierarchical paramaters).

Note
D Agilent IFF syntax requires you to specify variable definitions in the schematic .iff files

only. Any changes to variables (including the addition of new variables) requires a

schematic IFF transfer of Agilent EEsof data followed by a transfer of layout IFF data.

Use the following procedure to export an RF design from the layout tool to an RF simulator.

Prerequisites
* The layout tool must contain an RF design.

® The schematic capture and layout tools must be synchronized. (The design data has been
forward and back annotated.)

Procedure
1. Select the area to simulate in the layout tool.

2. Open the IFF Export Dialog Box (File > Export > IFF) - Figure 7-1.
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Exporting an RF Design from Layout

Figure 7-1. IFF Export Dialog Box
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3. Type the name for the IFF file.

4. Select layers, areas and plane data as needed.

Caution
When you export IFF files, the existing IFF files are overwritten.

5. Click OK.

The software outputs design data to the file
<design_name>\pcb\EE\Output\<filename>/.iff.

Results

The contents of the .iff files contain the selected layout design objects.
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Chapter 8
RF Simulator

RF Simulator Tool

The RF simulator provides a server to which the schematic capture and layout tools connect.
This connection acts as a dynamic-link, which enables bidirectional data transfers.

Schematic capture and layout tools use the RF simulator to simulate RF groups. RF groups are
sent to the RF simulator over the dynamic-link. The portion of the RF group sent to the RF
simulator with the layout tool is described in RF Group Elements Exported to RF Simulator.

The following procedures apply to the schematic capture and layout tools after the RF simulator
server is active (Launching the ADS Server or Launching MWO Server):

® Connecting Schematic Capture to RF Simulator Server
® Connecting Layout to RF Simulator Server
® RF Group Elements Exported to RF Simulator

® Post Back Hierarchical Symbols

Related Topics

RF Layout RF Simulator
MWO RF Simulator
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RF Simulator
RF Connect Dialog Box (Schematic Capture)

RF Connect Dialog Box (Schematic Capture)

To access: With the RF Toolbar active, click RF Connect =

Description

Use this dialog box to connect the schematic capture tool to the RF simulator server.

When you connect the schematic capture tool to the RF simulator server, you create a dynamic-
link, which enables bidirectional data transfers.

The schematic capture RF Connect dialog box has the following tabs:

® RF Connect Dialog Box (Schematic Capture) - Connections Tab — use this tab to
connect to the RF simulator server.

® RF Connect Dialog Box (Schematic Capture) - Configuration Tab — use this tab to
define the layout connection information.
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RF Simulator
RF Connect Dialog Box (Schematic Capture) - Connections Tab

RF Connect Dialog Box (Schematic Capture) - Connections Tab

To access: With the RF Toolbar active, click RF Connect | , select the Connections tab

Description

Use the Connections tab to connect (or disconnect) the schematic capture tool and the RF
simulator server.
Figure 8-1. RF Connect Dialog Box (Schematic Capture) - Connections Tab
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Log

Clear log
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Table 8-1. RF Connect Dialog (Schematic) - Connections Tab Contents

Field Description

Connect on | Checked, automatically creates a connection to the RF simulator server
design load | when you load a design in the schematic capture tool.

Unchecked, does not automatically connect the schematic capture tool
to the RF simulator server (Connecting Schematic Capture to RF
Simulator Server).

J Populates the table with active RF simulator server information. This
also enables you to connect to or disconnect from the RF simulator
server via the dynamic link.

ﬂ Deletes the selected RF simulator server from the list.

Machine Defines the machine name or IP address of the RF simulator server.
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RF Simulator
RF Connect Dialog Box (Schematic Capture) - Connections Tab

Table 8-1. RF Connect Dialog (Schematic) - Connections Tab Contents (cont.)

Field Description

Port Defines the connection port of the machine.

connect/ Connects to or disconnects from the RF simulator server.

disconnect

Regions Defines the RF simulator workstation location to which the RF data is
sent. If you have several RF servers, each can simulate a different RF
group.

Clear log Clears the log field.

Log field Displays a connection transcript.

Related Topics

RF Simulator Tool RF Connect Dialog Box (Schematic Capture)
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RF Simulator
RF Connect Dialog Box (Schematic Capture) - Configuration Tab

RF Connect Dialog Box (Schematic Capture) - Configuration Tab

To access: With the RF Toolbar active, click RF Connect £ , select the Configuration tab

Description
Use the configuration tab to define the schematic capture tool connection information
(Figure 8-2).
Figure 8-2. RF Connect Dialog Box (Schematic Capture) - Configuration Tab
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Table 8-2. RF Connect Dialog (Schematic) - Configuration Tab Contents

Field Description

Server Defaults section — Defines the default values of the RF simulator server selected on
the Connections tab.

Name Defines the machine name or IP address of the RF simulator server.

Timeout Defines the maximum time allotted to connect to the RF simulator
server.

Port Defines the port address of the RF simulator server.

Port Range Defines the number of alternate ports.

Tune/Optimization section — Determines the tune/optimization data that is imported to
ADS.
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RF Simulator
RF Connect Dialog Box (Schematic Capture) - Configuration Tab

Table 8-2. RF Connect Dialog (Schematic) - Configuration Tab Contents

Field Description

Include default Specifies that ADS uses the default layer stackup from ADS for
layers (ADS only) | tuning/optimization. If you do not specify this option, ADS uses only
the layer information exported from Expedition to tune/optimize.

Include component | Specifies that tune/optimization information for components (pin

definition for position, geometry, and so on) is included in the data imported to ADS.
components (ADS | This allows ADS to create compatible library parts. This option is
only) useful if there is no compatible ADS design kit available for packaged

parts. If you do not specify this option, component information from
Expedition is not included in the tune/optimization data that is
imported to ADS.

Related Topics

Connecting Schematic Capture to RF RF Connect Dialog Box (Schematic Capture)
Simulator Server

RF Simulator Tool

Connecting Schematic Capture to RF Simulator Server

Connect the schematic capture tool and the RF simulator server with the RF Connect dialog
box. The connection creates a dynamic-link, which enables bidirectional data transfers.

Note
The schematic capture and layout tools can connect simultaneously to the same RF

simulator server.

Prerequisites

® The RF simulator server must be active (Launching the ADS Server or Launching
MWO Server).

® The schematic capture tool displays the RF Toolbar.

Procedure

1. Open the RF Connect Dialog Box (Schematic Capture) (click RF Connect ' on the
RF Toolbar) and select the Connections tab.

2. Click j to populate the table with all the available RF simulator servers.
The Configuration tab default values correspond to the RF server default values.

3. Click connect to connect the schematic capture tool to the RF simulator.
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RF Simulator
RF Connect Dialog Box (Schematic Capture) - Configuration Tab

Results
The Log field displays an ok, indicating that the connection has been made successfully.
Related Topics

RF Simulator Tool Getting Started
RF Connect Dialog Box (Schematic Capture)
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RF Simulator
RF Connect Dialog Box (Layout)

RF Connect Dialog Box (Layout)
To access: With the RF Toolkit (£,) active, click RF Connect £ on the RF Toolkit Toolbar.

Description

Use this dialog box to connect the layout tool to the RF simulator server. When you connect the
layout tool to the RF simulator server, you create a dynamic-link, which enables bidirectional
data transfers.

The RF connect dialog box has the following tabs:

® RF Connect Dialog Box (Layout) - Connections Tab — use this tab to connect to the RF
simulator server.

® RF Connect Dialog Box (Layout) - Configuration Tab — use this tab to define the RF
simulator server and layout configuration information.

* RF Connect Dialog Box (Layout) - Extended Configuration Tab — use this tab to define
a specific portion of an RF group to be sent to the RF simulator.

Related Topics

Connecting Layout to RF Simulator Server RF Simulator Tool
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RF Simulator
RF Connect Dialog Box (Layout) - Connections Tab

RF Connect Dialog Box (Layout) - Connections Tab

To access: With the RF Toolkit () active, click RF Connect £ on the RF Toolkit Toolbar,
select the Connections tab.

Description

Use this tab to connect (or disconnect) the layout tool and the RF simulator server.

Figure 8-3. RF Connect Dialog Box (Layout) - Connections Tab
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Table 8-3. RF Connect Dialog Box (Layout) - Connections Tab Contents

Field Description
Connect on Checked, creates an automatic connection to the RF simulator server when
design load | you load a design in the layout tool.
Unchecked, does not create an automatic connection between the layout tool
and the RF simulator server (Connecting Layout to RF Simulator Server).
Add Populates the table with active RF simulator server information. This also
connection enables you to connect to or disconnect from the RF simulator server via the
dynamic link.
Delete Deletes the selected RF simulator server.
X
Machine Defines the machine name or IP address of the RF simulator server.
Port Defines the connection port of the machine.
connect/ Connects to or disconnects from the RF simulator server.
disconnect
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RF Simulator
RF Connect Dialog Box (Layout) - Connections Tab

Table 8-3. RF Connect Dialog Box (Layout) - Connections Tab Contents

Field Description

Regions Defines the RF simulator workstation location to which the RF data is sent. If
you have several RF servers, each can simulate a different RF group.

Clear log Clears the log field.

Log field Displays a connection transcript.

Related Topics

Connecting Layout to RF Simulator Server RF Simulator Tool

RF Connect Dialog Box (Layout)
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RF Connect Dialog Box (Layout) - Configuration Tab

RF Connect Dialog Box (Layout) - Configuration Tab

To access: With the RF Toolkit () active, click RF Connect £ on the RF Toolkit Toolbar,
select the Configuration tab.

Description
Use this tab to define

the RF simulator server and layout tool connections and create a mapping

file for the ADS RF simulator (RF Mapping rflayermap.xml Dialog Box).

Figure 8-4. RF Connect (Layout) - Configuration Tab
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Table 8-4. RF Connect Dialog Box (Layout) - Configuration Tab Contents

Field Description

Server Defaults section — Defines the default values of the RF simulator server selected on

the Connections tab.

Name Defines the machine name or IP address of the RF simulator server.

Timeout Defines the maximum time allotted to connect to the RF simulator
server.

Port Defines the port address of the RF simulator server (matches the port
number of the RF simulator server).

Port Range Defines the number of alternate ports.

Localhost Defaults section — Defines the default connection values for the layout tool.

Listening Port

Defines the listening port address.

Port Range

Defines the port address range.

RF in DxDesigner - Expedition Flow Users Manual, EE 7.9.5 237



RF Simulator

RF Connect Dialog Box (Layout) - Configuration Tab

Table 8-4. RF Connect Dialog Box (Layout) - Configuration Tab Contents

Field

Description

Layout Data section — Defines the design data being transferred.

Arc Defines the level of segmentation in the RF simulator in terms of the
Approximation tolerated distance from the arc to the cord. Used by the RF simulator to
Factor control the accuracy of arcs in the data.

Cord Arc Approximation Factor
Include Pads Checked, sends non-RF part data to the RF simulator.

Invert Plane Data

Checked, sends negative plane data to the RF simulator.

Export Board Checked, sends board outline data to the RF simulator.

Outline

Show mapping Checked, opens the RF Mapping rflayermap.xml Dialog Box when you
dialog during import an RF simulator design or RF group.

import

Set mapping Opens the RF Mapping rflayermap.xml Dialog Box, which enables you

to define the ADS RF simulator notations for layers, pins (Ports - ADS),
and vias that are mapped to the layout tool.

Related Topics

Connecting Layout to RF Simulator Server

RF Simulator Tool

RF Connect Dialog Box (Layout)

238

RF in DxDesigner - Expedition Flow Users Manual, EE 7.9.5



RF Simulator
RF Connect Dialog Box (Layout) - Extended Configuration Tab

RF Connect Dialog Box (Layout) - Extended Configuration Tab

To access: With the RF Toolkit () active, click RF Connect £ on the RF Toolkit Toolbar,
select the Extended Configuration tab.

Description

Use this tab to define the portion of the RF Group that is transmitted to the ADS RF simulator.

Figure 8-5. RF Connect Dialog Box (Layout) - Extended Configuration Tab

= : - [B]%]

Connections ] Configuration  Extended Configuration l
RF Group Cut
I” Enable Cutting

Default Clearance: 0

Layer Gen. Clr
1 v Plane Shapes

2 Conductive Shapes

3 Components

4 Wiaz

Traces

Per Ly Ch| Ower | Under

Selections Types

a4

Table 8-5. RF Connect Dialog Box (Layout) - Extended Configuration Tab

Contents

Field

Description

RF Group Cut section — Defines the information that is sent to the ADS RF simulator.

Enable Checked, restricts the RF group simulation to only those items that are selected
Cutting in the Selections table and Types table.

Unchecked, sends the entire RF group data to the RF simulator.
Default Defines the default clearance values for all RF Types sent to the RF simulator.
Clearance You can override the default clearance for a particular layer by specifying a per

layer clearance in the Selections table (Using Extended Configuration, Enable
Cutting and Default Clearance).

Selections section — Defines the options that are exported to the RF simulator.

Layer Checked, exports the layer to the RF simulator.
General Defines the oversize value used to expand the RF group size. This overrides the
Clearance Default Clearance value.
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Table 8-5. RF Connect Dialog Box (Layout) - Extended Configuration Tab
Contents (cont.)

Field Description

Per Layer Defines the oversize value used on the layer to expand the RF group size. This
Clearance overrides the Default Clearance and General Clearance values.

Over Checked, applies the clearance values to layers above the selected layer.
Under Checked, applies the clearance values to layers below the selected layer.
Types Checked, exports the RF group items to the RF simulator.

Related Topics

Connecting Layout to RF Simulator Server RF Simulator Tool

RF Connect Dialog Box (Layout)

Connecting Layout to RF Simulator Server

Connect the layout tool and the RF simulator server with the RF Connect Dialog Box (Layout).
The connection creates a dynamic-link, which enables bidirectional data transfers.

Prerequisites

* The RF simulator server is active (Launching the ADS Server or Launching MWO
Server).

* The RF Toolkit (®,) is active in the layout tool (Opening the RF Toolkit).

Procedure

1. Open the RF Connect Dialog Box (Layout) (Click RF Connect ), and select the
Connections tab.

2. Click to populate the table. The Machine column displays the localhost. (The RF
simulator and the Mentor Graphics tool can reside on the same workstation.)

Note
If the RF simulator server is not listed, type the name or IP address of the remote server in
the Machine column.

3. Click connect.

Note
D If no connection is made through the port or IP address, check your firewall.
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Results

The Log field displays an ok, indicating that the connection has been made successfully.

Related Topics

RF Simulator Tool RF Connect Dialog Box (Layout)

RF in DxDesigner - Expedition Flow Users Manual, EE 7.9.5 241



RF Simulator
RF Group Elements Exported to RF Simulator

RF Group Elements Exported to RF Simulator

From the layout tool, you can export selected RF groups to the RF simulator. Non-RF traces and
vias are exported only if they are:

* Directly connected to an RF shape or meander.

® Indirectly connected through one or more (5 pin max) device(s) that are connected to an
RF shape or meander.

If non-RF traces and vias are required for analysis, you can use Extended RF Simulation. You
can also export non-RF traces and vias to the RF simulator with an .iff file (Exporting an RF
Design from Layout).

For example, Figure 8-6 shows an RF Group that was exported from the layout tool to the RF
simulator with either the Send netlist, Send layout data, or Send Tune/Opt Data menu
selections (RF Group Menu Selections).

The following RF and non-RF parts are sent to the RF simulator.

® Trace connections A, B, and E are exported because they are directly or indirectly
connected to RF shapes or meanders.

® Trace connections C, D, and F are not exported because they do not meet the
requirements. An error message displays listing the removed traces or vias.

Figure 8-6. Trace Via Export

Meander
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Related Topics

Connecting Layout to RF Simulator Server RF Simulator Tool

Post Back Hierarchical Symbols

When you create RF designs in the RF simulator, you can use an electrical equivalent of a
simulation equivalent circuit for passive or active parts. The underlying circuit represents
package parameters, non-linear models, and other simulation items. This circuit has no physical
meaning, so the hierarchical symbol for the part needs to be updated for the packaged part.

To import such a design into the DxDesigner-Expedition flow from the RF simulator, modify
the Central Library (CL) symbol file. Edit the hierarchical symbol file before you import the
IFF file. The CL hierarchical symbol name must be the same as the RF simulator symbol file. A
hierarchical symbol has the Symbol Type set to Composite and ForwardPCB set to True.

Related Topics

Connecting Layout to RF Simulator Server RF Simulator Tool
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ADS RF Simulator

Note

Linux - On a Linux platform, in order to use the ADS RF simulator, you must add the
following at the beginning of the ADS start up script:

LD_LIBRARY_PATH=${SDD_HOME} /common/linux/1lib:${LD_LIBRARY_PATH}

The script is located at SHPEESOF _DIR/bin/ads.

The schematic capture and layout tools use the RF simulator Advanced Design System (ADS)
to simulate RF groups.

When you create a design in the schematic capture tool and send the schematic data to ADS, all
port numbers are set to 0 (Num=0). You must incrementally renumber all of the ports, starting
at 1 (Num=1) in order to simulate the RF group.

The software preserves ADS port numbers when you send the design to the schematic capture
tool. When you use the schematic capture tool to create additional ports for a simulated RF
group, you must renumber the new ports.

The following sections address specific ADS functionality:

Adding ADS RF Shapes to Central Library
Layout Tool and ADS Workflow

Installing the MentorDA DK Design Kit
Launching the ADS Server

Connecting Schematic Capture to RF Simulator Server
Send Design Data to ADS Simulator

Generate Data

Sending ADS Design to Schematic Capture Tool
Sending ADS RF Design to Layout Tool

RF Mapping rflayermap.xml Dialog Box
Creating an ADS Mapping File
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® Using Extended Configuration, Enable Cutting and Default Clearance

® Post Back to Schematic Capture and Layout

Related Topics

RF Simulator RF Flow Introduction

Layout Tool and ADS Workflow

Data flow between ADS and the layout tool is bi-directional. When you send an ADS design to
the layout tool, the RF group contains only the ADS design. When you send a non-hierarchical
RF group with meanders to ADS, ADS creates a hierarchal design in which each meander is a
subdesign. Figure 9-1 shows the design creation flow between ADS and the layout tool.
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Figure 9-1. ADS and Layout Tool Flow
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Send an ADS design to the layout tool (Importing from ADS
Design).

The ADS design and layout tool RF group are at the same level.

Send a meander to the layout tool Only the meander parametric

(Importing from ADS Subdesign). properties are updated in the
L layout tools RF group.
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design in ADS.

* Data not compatible between the two tools are not maintained.
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When you create a design in ADS layout and import the design data into the layout tool, a new
RF group (including elements) is created. After importing the ADS data set, the contents match
that of the ADS design.

When you send an ADS design to layout, the RF group is frozen with an initial reference point
of (0,0). On subsequent imports, the ADS design is tagged as an imported group. You can
move, rotate, and connect the RF group to other objects (meanders) in the layout tool.

The ADS design is the master design for the RF group. When you send an ADS design as an
update to a layout design, it replaces the contents of the RF group each time. After you send the
ADS design to the layout tool, the contents match the contents of the ADS design. RF groups
being updated by the ADS design maintain their RF group properties (Figure 9-1).

The following conditions apply when you change or unfreeze an RF group in the layout tool:

* ADS contains the master RF design and updates the RF group with the ADS data set.
Refer to Importing from ADS Design and Importing from ADS Subdesign.

® The layout RF group becomes the “target group” (Importing from ADS Design
Component Creation).

A “target group” is an existing RF group in the layout tool being updated with the ADS
data set contents.

® You can update the ADS design with your layout RF group changes using Send Design
Data to ADS Simulator. You can re-send the ADS design into the layout tool.

Related Topics

ADS RF Simulator RF Simulator
Post Back to Schematic Capture and Layout RF Flow Introduction
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Importing from ADS Design

Note

O

Unless otherwise stated, designs are sent from the top of the ADS hierarchy.

When you send an ADS design, the top level ADS design data is sent to the layout tool, where it
creates or updates an RF group (target group). When you send a top level ADS design, the
following restrictions and conditions:

The ADS design must have a name other than “Default”.

The ADS design component properties apply to the target group after import.

If the target group objects cannot be moved to the Default group, the import is aborted.
If ADS design cannot update a target RF group meander, the import is aborted.

All objects of type “layout only” (conductive shapes, plane shapes, obstructs, vias and
so on) in the target RF group are replaced by the imported design.

All existing schematic objects (library parts and RF elements) in the target RF group are
moved to the Default group and unplaced. User data such as entry rules, RF clearances,
edge nodes, RFPorts, and so on, are contained in the Default group.

All RF group meanders that have matching reference designator property values remain
in the RF group. All other meanders are deleted.

Related Topics

RF Simulator Auto Arranger

Post Back to Schematic Capture and Layout RF Flow Introduction

Importing from ADS Subdesign

When you import from the ADS subdesign you send an ADS meander to an RF group. RF
groups containing meander(s) create hierarchical designs in ADS. Each meander becomes a
subdesign of the top-level ADS design. You push into an ADS subdesign to send the meander to
the layout tool.

Importing an ADS meander subdesign to the layout tool only updates parametric properties and
has the following ramifications:

Nothing is deleted from the target group.

The target group meander reference designators are updated with the ADS design
parametric properties and re-synthesized.

All user data (entry rules, RF clearances and others) are preserved.
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® Only one meander can be sent at a time.

Related Topics

RF Simulator Auto Arranger
Post Back to Schematic Capture and Layout RF Flow Introduction

Importing from ADS Design Component Creation

When you import a top ADS design into the layout tool:

* All layout objects are created on the design.

Note
D If a component cannot be created in the RF group, an error message is posted and the
import continues.

* All schematic objects and elements are placed on the RF group/target.
* All existing meanders are updated with new parametric properties and re-synthesized.

* All new RFShapes are created as “layout only” elements.

Note
D If the RF group/target group cannot be frozen after import, the import is aborted and no
changes are made to the RF group/target group.

Related Topics

RF Simulator Auto Arranger
Post Back to Schematic Capture and Layout RF Flow Introduction

Installing the MentorDA_DK Design Kit

The MentorDA DK (Mentor Dynamic Access Design Kit) creates the ADS MentorDA menu
selection (MentorDA Dropdown Selections).

Use the menu to open the ADS server, enabling a bidirectional dynamic-link between the ADS
server and the schematic capture and layout tools.

Note
D The MentorDA menu is supported only on Windows platforms with Agilent’s ADS2009
or newer software.
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Use the following procedure to install the Advanced Design System (ADS) MentorDA DK
software.
Prerequisites

* ADS must be open.

Procedure
1. Click DesignKit > Install Design Kits.
The Install ADS Design Kit dialog box displays (Figure 9-2).

Figure 9-2. Install ADS Design Kit Dialog Box.

1. Unzip Design Kit
This step may be skipped if the Design Kit is already unzipped.

Unzip Design Kit Mow. ..

2. Define Design Kik
Enter full Path to the directory of the desired Design Kit,

If available, the remaining info will be automatically filed in.

Path

| $HPEESOF_DIR/pcb_cannect/MentorDa_DK/ |

Name
‘MentorDA ‘

Boot File (optional)
T |

Versian
‘Dynami: Access (DA) For Mentor - July 2008 ‘

3. Install Design Kit

Select Installation Level : |USER LEVEL ~

[ [a]:4 ] [ Cancel ] [ Help ]

2. Select the Browse button for the Path field.

Navigate to SHPEESOP_DIR\pcb connect\MentorDA DK, where SHPEESOP_DIR is
the ADS 2009 installation directory (example
C:\ADS2009\pcb_connect\MentorDA_DK).

3. Select design_kit (Figure 9-3).
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Figure 9-3. Select Design Kit

& Select Design Kit Directory
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4. Click Choose.

5. Select the applicable level with the Select Installation Level field dropdown arrow
(USER LEVEL, STARTUP LEVEL, or PROJECT LEVEL)

6. Click OK.

Note
For additional information on the ADS RF simulator, access the ADS documentation at

C:\ADS2009\doc\mentorlink.

Results
The MentorDA menu is added to the Advanced Design System (Main) dialog box.

Related Topics

Launching the ADS Server Connecting Schematic Capture to RF
Simulator Server

Connecting Layout to RF Simulator Server ADS RF Simulator

MentorDA Dropdown Selections

The MentorDA dropdown menu enables you to open and close the ADS MentorDA server
(Figure 9-5).
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Figure 9-4. ADS/MentorDA
2008 Update 2 (Main)
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| — Start MentorDa S
@ E‘ @ B rrl ? rt MentorDa Server

=

About MertorDia

Table 9-1. MentorDA Dropdown Selections

Selection Description

Start MentorDA Server Opens Advanced Design System (ADS) Mentor Dynamic
Access_Design Kit server.

Show Server Connections | Displays server connection information.

Stop MentorDA Server Terminates the MentorDA server.

Usage Notes

You must open the ADS server before the schematic capture or layout tools can connect to the
server (Launching the ADS Server). When the server terminates, any active connection to the
schematic capture or layout tool terminate as well.

Related Topics
ADS RF Simulator

Launching the ADS Server

For interactive operation between schematic capture, layout tools, and Advanced Design
System (ADS), you must open the ADS RF server.

Use the following to open the ADS server.

Prerequisites
* ADS must be open.

Procedure
1. Choose MentorDA > Start MentorDA Server.

The default values in Start MGC Link Server match the schematic capture and layout
tools default values (Figure 9-5).
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Figure 9-5. Start MGC Link Server Dialog Box

I Start MGC Link Server, |Z||E|E|
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2. Click OK.

The schematic capture and layout tools can connect to any number of ADS servers. This

enables you to send an RF group from the schematic capture or layout tools to any ADS
workstation.

Use the following to establish a dynamic-link:
® Connecting Schematic Capture to RF Simulator Server

® Connecting Layout to RF Simulator Server.

Results

The ADS Connect dialog box displays.

Related Topics

RF Group Elements Exported to RF Simulator Layout Tool and ADS Workflow
ADS RF Simulator

Send Design Data to ADS Simulator

Sending design data requires an active dynamic-link between the Advanced Design System
(ADS) RF server and the schematic capture and/or layout tools.

Use the following to transfer data between schematic capture and ADS or layout and ADS.

® Launching the ADS Server
® Connecting Schematic Capture to RF Simulator Server,
® Connecting Layout to RF Simulator Server

® Sending Netlist - Schematic Capture

® Sending Netlist - Layout
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* Sending Layout Data
* Sending Tune/Opt Data

Related Topics

Generate Data ADS RF Simulator

Sending Netlist - Schematic Capture

Use the following procedure to send schematic capture netlist to the ADS simulator.

Prerequisites
* An ADS schematic must be open.

* A dynamic-link must be established between the ADS server and the schematic capture
tool.

o Launching the ADS Server

Connecting Schematic Capture to RF Simulator ServerProcedure
1. Click Group/Ungroup (38).
2. Select an RF group.
3. Choose Send netlist.

Results

The schematic capture RF group netlist is active in ADS schematic.

Related Topics

Send Design Data to ADS Simulator ADS RF Simulator

Sending Netlist - Layout

Use the following procedure to send a layout RF group netlist to the ADS simulator.

Prerequisites
* An ADS schematic must be open.

® A dynamic-link must be established between the ADS server and the schematic capture
tool.

o Launching the ADS Server
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o Connecting Layout to RF Simulator Server

Procedure
1. Click Control pane ( ") and click the RF Design tab or Group/Ungroup (23).
2. Select an RF group.
3. Choose Send netlist.

The generated .net and .iff files are stored in the following locations:

<design_name>\RF\netlist\html\<project_name>_yyyymmdd_ hhmmss.html
<design_name>\RF\netlist\xml<project_name>_yyyymmdd_hhmmss.xml
<design_name>\RF\netlist\<project_name>_yyyymmdd_hhmmss.net

The generated schematic files are stored in the following locations:

<design_name>\RF\xml\<project_name>_yyyymmdd_ hhmmss.xml
<design_name>\RF\iff\<project_name>_yyyymmdd_hhmmss.iff

Results
The layout RF group netlist is active in ADS layout.
Related Topics

Send Design Data to ADS Simulator ADS RF Simulator

Sending Layout Data

Note
D Simulation results may require design changes (Layout Tool and ADS Workflow).

Use the following procedure to send a layout RF group to the ADS simulator.

Prerequisites
* An ADS layout design must be open.

* A dynamic-link must be established between the ADS server and the schematic capture
tool.

o Launching the ADS Server

o Connecting Layout to RF Simulator Server
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Procedure

1. Click Control panel ( ") and click the RF Design tab or Group/Ungroup (35).
2. Select an RF group.
3. Choose Send layout data.

Results
The layout RF group data is active in ADS layout.
Related Topics

Send Design Data to ADS Simulator ADS RF Simulator

Sending Tune/Opt Data

Note
Simulation results may require design changes (Layout Tool and ADS Workflow).

Use the following procedure to send layout RF group to the ADS simulator.

Prerequisites
* An ADS Project Open must be open.

* A meander instance name or symbol name within an RF group cannot have the same

name as the RF group.

* A dynamic-link must be established between the ADS server and the schematic capture
tool.

o Launching the ADS Server

o Connecting Layout to RF Simulator Server

Procedure
1. Click Control pane ( &) and click the RF Design tab or Group/Ungroup (33).
2. Select an RF group.
3. Choose Send Tune/Opt Data.

Note
Refer to the ADS online documentation for additional information.
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In order to simulate meanders, the software must convert them to ADS models (MLIN,
MCURVE, MBEND, and so on). When you send updates back to layout, these models
are converted back to meanders for the layout tool.

ADS parameter updates occur manually or through the tuning/optimization routine.
ADS tuning/optimization routines require you to create a schematic with the
Generate/Update Schematic option.

Results

The layout models display in ADS project.

Related Topics

Send Design Data to ADS Simulator Generate Data
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Generate Data

You can view the design data without enabling an active connection.
Use the following to generate design data:

® Generating Netlist
® Generating Layout Data

® Generating Tune/Opt Data

Related Topics

RF Simulator Send Design Data to ADS Simulator
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Generating Netlist

The Generating Netlist selection creates a netlist of the RF groups in multiple file formats.

Use the following procedure to generate a layout netlist file.

Prerequisites
* An ADS Project Open must be open.

* A dynamic-link must be established between the ADS server and the schematic capture
tool.

o Launching the ADS Server

o Connecting Layout to RF Simulator Server

Procedure
1. Click Control pane ( ¢7), and click the RF Design tab or Group/Ungroup (33).
2. Select the RF group.
3. Choose Generate Netlist.
® Generates a compatible netlist for the RF group and subgroups.
* Displays the netlist file in an ASCII viewer (Figure 9-6).
* Creates the following files in the netlist folders:

<project_directory>\RF\netlist\html\<design name>_<group_name>_<yyyymmdd>
\<hhmmss>.html

<project_directory>\RF\netlist\xml\<design_ name>_<group_name>_<yyyymmdd>\
<hhmmss>.xml

<project_directory>\RF\netlist\<design_name>_<group_name>_<yyyymmdd>\<hhm
mss>.net

Figure 9-6. Generate Netlist Data

define BFLineInput({ "$1H30" "RFInA" '"¥CC' |
g

HL INZ : RF2 "§IN35" SupsST="MSuh1" L=100 wil Mod=1 §=25 mil Walll=1.00002+030 wil GallZ=1.00008+030 mil

C:C2 "TEIN3ST rEiMzgn

HLOCZ:MLOC 1 "AN3ET Fubst="M3ubl" L=25 mil Mod=1 W=Z5 wil Walll=1.0000e+030 mil WallZ=1.0000e+030 mil

NLINZ :RF9 ngiN2Z " LERNEL=L Subst="HSub1" L=100 mil Mod=1 W=25 mil Walll=1.0000e+030 mil Wall2Z=1.0000e+030 mil
NCROSO:RF12 MEINLT LERNR =L rgiNaa" LERL il Subst="MSub1" F1=25 wil W2=50 mil W3=25 mil U4=50 mil
NLINZ:RF11 "R Ina" "IN Subst="HSub1” L=100 mil Mod=1 W=25 mil Walll=1.0000e+030 mil Wall2=1.0000=+030 mil
ML INZ :RF8 TYCCT  UEIN1GT SupsST="MSus1" L=100 wil Mod=1 U=25 mil Walll=1.00002+030 wil GallZ=1.00008+030 mil

model MSubl MSUB Cond=1.0E+306 Er=5.6 H=10 mil Hu=1.0000e+030 wil Mur=1 Rough=0 mil T=0 mil TanD=0

end RFLineInput

Results

Creation of the netlist folder and files.
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Related Topics

Generate Data Send Design Data to ADS Simulator

Generating Layout Data

The Generating Layout Data selection generates iff and momentum folders.

Use the following procedure to generate layout data.

Prerequisites
* ADS Project Open must be open.

* A dynamic-link must be established between the ADS server and the schematic capture
tool.

o Launching the ADS Server

o Connecting Layout to RF Simulator Server

Procedure
1. Click Control pane ( ), and click the RF Design tab or Group/Ungroup (33).
2. Select an RF group.
3. Choose Generate Layout data.
® Generates iff and momentum folders for the RF group and subgroups.
* Displays momentum _a file in the ASCII default viewer (Figure 9-7).
* Creates the following files in the momentum and iff folders:
Momentum files (passive circuit analysis):

<project_directory>\RF\momentum\html\<design_ name>_<group_name>_<yyyymmdd
>\<hhmmss>.html

<project_directory>\RF\momentum\xml\<design name>_<group_name>_<yyyymmdd>
\<hhmmss>.xml

<project_directory>\RF\momentum\<design_name>_<group_name>_<yyyymmdd>\<hh
mmss>_a.
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Figure 9-7. Generate Layout Data Text File

IFF file (export design data):

<project_directory>\RF\i1ff\<design name>_<group_name>_<yyyymmdd>\<hhmmss>
Jiff

Results

Creation of the iff and momentum folders and files.

Related Topics

Generate Data Send Design Data to ADS Simulator
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Generating Tune/Opt Data

Use the following to generate the tune/opt data.

Prerequisites
* An ADS Project Open must be open.

* A dynamic-link must be established between the ADS server and the schematic capture
tool.

o Launching the ADS Server

o Connecting Layout to RF Simulator Server

Procedure
1. Click Control pane ( &), and click the RF Design tab or Group/Ungroup (32).
2. Select an RF group.
3. Choose Generate Tune/Opt Data.
® Generates .iff file for the RF group and subgroups.
® Creates the following files in the iff folder:

<project_directory>\RF\iff\<design name>_<group_name>_<yyyymmdd>_<hhmmss>
L1ff

Results
Creation of the iff folder and .iff file.

Related Topics

Generate Data Send Design Data to ADS Simulator
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Adding ADS RF Shapes to Central Library

The ADS RF shape library at %SDD_HOME%\standard RF\ShapesLibrary is a subset of the
ADS REF library. The ShapesLibrary contains symbols that are identical to the ADS symbols
and pertain to RF/Microwave designs.

You must merge the ADS Shapes Library into your Central Library (CL). Merge the libraries
with a <file_ name>.bat file or command line.

Use the following procedure to merge the ADS library with your design library.

Procedure
1. Type the following in a command prompt window:

%$SDD_HOME\common\win32\bin>RFSymMergeUtility

Command and options display:

RFSymMergeUtility [-ads | awr] [-rfcl <path to RF CL/Source CL>]
[-all | (list of partition names) ] [-update | overwrite] -userCL
<customer-CL/Destination CL>

2. Enter command and options on a command line or in a <file_name>.bat file.

Example of a .bat file:

Note
D The command must be on one line ,or must use the ” continuation character.

C:\MentorGraphics\<EE_software>\SDD_HOME\common\win32\bin\RFSymMergeUtili
ty.bat -ads -rfcl ©
C:\MentorGraphics\<EE_software>\SDD_HOME\standard\RF\ShapesLibrary\Shapes
Library.lmc -all -update -userCL *
U:\Design_Central_Library\Central_Library.lmc

1. Save <file_name>.bat file.

2. Double-click <file name>.bat file.

Results

The command prompt window displays information about the merge as shown below.

C:\MentorGraphics\7.9.2EE\SDD_HOME\common\win32\bin>C:\MentorGraphics\7.9
.2EE\SDD_HOME\common\win32\bin\RFSymMergeUtility.bat -ads -rfcl
C:\MentorGraphics\7.9.2EE\SDD_HOME\standard\RF\ShapesLibrary\ShapesLibrar
yv.lmc -all -update -userCL U:\Design_Central_Library\Central_Library.lmc
Source
CL:C:\MentorGraphics\7.9.2EE\SDD_HOME\standard\RF\ShapesLibrary\ShapesL
ibrary.lmc
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Destination CL:U:\Design_Central_Library\Central_Library.lmc
Patitions to update:

-all

mode: append

Copying
Copying
Copying
Copying
Copying
Copying
Copying
Copying
Copying
Copying
Copying
Copying
Copying
Copying
Copying
Copying
Copying
Copying
Copying
Copying
Copying
Copying
Copying
Copying
Copying
Copying

partition
partition
partition
partition
partition
partition
partition
partition
partition
partition
partition
partition
partition
partition
partition
partition
partition
partition
partition
partition
partition
partition
partition
partition
partition
partition

RF_Data_Items
RF_Devices_BJT
RF_Devices_GaAs
RF_Devices_JFET
RF_Devices_Linear
RF_Devices_MOS
RF_Egn_Based_Nonlinear
RF_Filters_Lowpass
RF_Linear_Data_File
RF_Lumped_Components
RF_Lumped_With_Artwork
RF_Passive_RF_Circuit
RF_Simulation_AC
RF_Simulation_DC
RF_Sources_Time_Domain
RF_System_PLL_components
RF_TLines_Finline
RF_TLines_Ideal
RF_TLines_Microstrip
RF_TLines_Multilayer
RF_TLines_Printed_Circuit_Board
RF_TLines_Stripline
RF_TLines_Suspended_Substrate
RF_TLines_Waveguide
RF_UTILS

RF_Varblocks

C:\MentorGraphics\7.9.2EE\SDD_HOME\common\win32\bin>

Related Topics

Sending ADS Design to Schematic Capture
Tool

Connecting Schematic Capture to RF
Simulator Server

Send Design Data to ADS Simulator

RF in DxDesigner - Expedition Flow Users Manual, EE 7.9.5

265



ADS RF Simulator
Sending ADS Design to Schematic Capture Tool

Sending ADS Design to Schematic Capture Tool

Designs are sent to ADS from the schematic capture tool over the dynamic-link. You can
modify ADS RF groups and update the schematic capture design.

Caution
When you create your design in ADS, you must use a net to connect the parts. Part-to-
part connections are not supported in the schematic capture tool (RF Simulator Design
Generation).

Prerequisites
* A schematic must be open in the schematic capture tool.

®* You must connect the schematic capture tool to the RF simulator server (Connecting
Schematic Capture to RF Simulator Server).

* Each ADS port must have a unique number, starting at 1 and incrementing.

Use the following to send ADS data to the schematic capture tool.

Procedure

1. Choose MentorDA > Send ADS Schematic.
The ADS schematic attaches to the schematic capture tool cursor.

2. Click to place the schematic.

Results
The ADS schematic appears in the schematic capture tool.
Related Topics

ADS RF Simulator Send Design Data to ADS Simulator
Launching the ADS Server
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Sending ADS RF Design to Layout Tool

Use the following procedure to send an ADS design to the layout tool.

Prerequisites
* ADS must have a layout design open (refer to ADS documentation).
® The layout tool must have an open design.
® You must connect the layout tool to the RF simulator (Connecting Layout to RF
Simulator Server).
Procedure
1. Select the RF group in ADS Layout.
2. Choose MentorDA > Send ADS Layout.
The RF Mapping rflayermap.xml Dialog Box opens in the layout tool.

3. Select RF Mapping rflayermap.xml dialog box fields as required (Creating an ADS
Mapping File).

4. Click OK. The software does the following:
* Freezes the RF group in the layout tool (Freeze/Unfreeze an RF Group).

* Assigns the GROUP IMPORTED property to the RF group (RF Control Dialog
Box, RF group tab).

® Unfreezes the RF group so you can make changes.

Note
If you import the ADS group again, a messages appears warning you that your RF group
layout tool changes will be lost if you continue.

* Updates a frozen GROUP_IMPORTED RF group in the layout tool, by making
modification in ADS and resending the RF group to the layout tool. When you send
the ADS RF group to the layout tool, the software unfreezes, updates the RF group
with the ADS changes, and refreezes the RF group.

Results

The RF group in layout reflects the ADS layout RF design.

Related Topics

Send Design Data to ADS Simulator Sending ADS RF Design to Layout Tool
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Using Extended Configuration, Enable Layout Tool and ADS Workflow
Cutting and Default Clearance

RF Mapping rflayermap.xml Dialog Box
To access:

* Click Set mapping button in the RF Connect - Configurations tab (RF Connect Dialog
Box (Layout) - Configuration Tab).

* Send ADS data to the layout tool. By default, the Show mapping dialog during input
option is checked in the RF Connect Dialog Box (Layout) - Configuration Tab.

Map the ADS layers, vias, and pins to the layout design with the RF Mapping rflayermap.xml
dialog box (Figure 9-8).

Caution
D In ADS, any shape that is on a via layer and mapped to a padstack in the RF Mapping

rflayermap.xml dialog box, becomes a via in the layout tool (Creating an ADS Mapping
File).
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Figure 9-8. RF Mapping rflayermap.xml Dialog Box

Layers mapping
Ext.name [ MGC name MGC type | Shapetypa| Met name |

*+_ Add to symbol

Wia mapping
Ext.name| Padsta.. | Padsta..| MGCla... | M&Cla... |  Metname

Pins mapping
Ext,name [ MGC layer number i Mentor port name Met name

+ addto symbiol

Load mapping | Save mapping| (o] | Cancel | @

Table 9-2. RF Mapping rflayermap.xml Dialog Box Contents

Field Description

Layers section — Maps ADS layer names to the layout tool layer names

Ext. name | Defines the RF simulator layer name. When you send an ADS design with the
(External | dynamic-link, the RF simulator layer names automatically populate this column.
name)

MGC name | Defines the layout tool layer name. Use the dropdown list to select the layout
layer number and description.
All physical and user layers are available in the list, with the following options:

No Mapping — The data on the external layer is ignored.

Automatic — Generates a user layer with the same name as the external layer,
and all data is imported as user data.

MGC Type | Defines the layer type as Signal or Plane.
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Table 9-2. RF Mapping rflayermap.xml Dialog Box Contents (cont.)

Field

Description

Shape type

Defines the type of shape.

Plane — Polygons on the external layer (Ext. name) are imported as plane
shapes on the MGC layer and assigned to the net in the net column.
Conductive — Polygons on the external layer are imported as conductive
shapes. You can assign a net in the net name column.

Placement Obstruct Top/Bottom — Polygons on the external layer are
imported as placement obstructs on the top or bottom layer.

Route Obstruct — Polygons on the external layer are imported as route
obstructs.

RF Shape —Polygons on the external layer are imported as a custom RF
Shape.

Plane Obstruct: Polygons on the external layer are imported as plane
obstructs.

Pad Obstruct — Polygons on the external layer are imported as Pad
obstructs

Net name

Defines the net associated with the MGC Type.

Via mapping section — Maps ADS via names to the layout tool via names.

Ext. name | Defines the RF simulator via name.

(External

name)

Padstack Defines the layout tools padstack name. Use the dropdown list to select a
name padstack.

Padstack Defines the layer span of the padstack in the layout tool.

span

MGC layer | Defines the start layer for a via in the layout tool

start

MGOC layer | Defines the end layer for a via in the layout tool.

end

Net name | Defines the net name assigned to the via. Use the dropdown list to select a net

name in the layout tool.

Pins mapping section — Maps ADS pin names to the layout tool pin names

Ext. name | Defines the name of the port or pin in the RF simulator design.
(External
name)
MGC layer | Defines the pin layer in the layout tool. This can be any physical layer in the
number current design. Use the dropdown list to select the layer number.
MGC port | Defines the port name for the pin in the layout tool. Use the dropdown list to
name select the layout tool port name.
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Table 9-2. RF Mapping rflayermap.xml Dialog Box Contents (cont.)

Field Description

Net name | Defines the net name in the layout tool. Use the dropdown list to select a net in
the layout tool.

Add to Checked, enables column data to be included in schematic capture symbol

Symbol generation, which enables placement of custom RF shapes in a schematic. This
option is enabled when you assign a layout layer or pin (port).

Load Loads an existing RF Mapping file. Rows not mapped are yellow.

mapping Creates an rflayermap.xml file in the <design name>\RF directory.

Save Saves your RF Mapping file in the <design _name>\RF directory.

mapping

Related Topics

ADS RF Simulator Creating an ADS Mapping File
Post Back to Schematic Capture and Layout Auto Arranger

Creating an ADS Mapping File

Create a mapping file with the RF Mapping rflayermap.xml Dialog Box. You can define the
ADS-to-layout tool relationship for layers, vias, and pins with the RF Mapping rflayermap.xml
dialog box.

Use the following procedure to create an RF Mapping rflayermap when you send ADS data to
the layout tool.
Prerequisites
* ADS must have a layout design open (refer to ADS documentation).
® The layout tool must have a design open (RF Toolkit Toolbar).

® A dynamic-link must be established between the ADS server and the schematic capture
tool (Connecting Layout to RF Simulator Server).

* “Show mapping dialog during input” must be checked in the RF Connect Dialog Box
(Layout) - Configuration Tab.
Procedure
1. Select MentorDA > Send ADS Layout in the RF simulator Layout main menu.

When you send the design to layout, the RF Mapping rflayermap.xml dialog box
automatically appears (Figure 9-9). If no mapping file is found, the Ext.name (External
name) column appears yellow.
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Figure 9-9. RF Mapping First Time

RF Mapping RF_TEST_GroupTest_20071.

~Layers mapping
ExE name MGC narme MGC bype Met name |
[ IC_pin1_marker |Mo mapping {Pet0) =
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Microstrip_4 Mo mapping {Pet0)
Flane_2 Mo mapping {Pet0)
Flane_3 Mo mapping {Pet0)
bond Mo mapping {Pet0) |
1t add to symbal
— ¥ia mapping
Ext name | Padsta.. | Padsta..| MGCla..| MGCla... | Metname| a |
pCvia7 o mapping -1 -1 (MetD) |
ports o mapping -1 -1 (MetD)
resi o mapping -1 -1 (MetD)
silk_screen Mo mapping -1 -1 (MetD)
silk_screenz Mo mapping -1 -1 (MetD)
solder_mask| Mo mapping -1 -1 (MetD)
symbal Mo mapping -1 -1 {Met) i|
text Mo mapping -1 -1 (Mekd) |
Pins mapping
ExE name M layer number | Mentor port name Met name |
1 Mo mapping 13 {Pet0) =
10 Mo mapping 4 {Pet0) =
z Mo mapping 12 (Met) 1
3 Mo mapping 11 {Pet0) —
4 Mo mapping 10 {Pet0)
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T Addto symbol
Load mapping | Save mapping (o4 Cancel |Q|
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2. Use the dropdown list to assign mapping for layers, vias, and pins, as shown in
Figure 9-10.

Figure 9-10. RF Mapping to Layout

Layers mapping Layers mapping
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rxlayerZJIane Automatic I\.(’E\'f'ér_éjﬁlane Z - Plane Signal =
¥ layard_planeftiail Mi: 3-Flane  |Signal 'le ShaDEt e
- Flane T [aCenmen SCrUCE o]
3 - Plane gléyer‘ljlane!:l . St”p"ne Sl Flacemerit Obstruck Botptom
4 = Stripline Lapi] {27 AR {Route Obstruct
% |5 - atripline 2 il Flane Obstruck e
1 add to symbiol “t_ add ko symbol
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D26V1A |-1 {Mekd) - condl MO Mapping -1 -1 L1NZ53
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3. Click Save mapping.

The software creates a <design_name>\Pcb\<map _file name>.xml file.

4. Place the ADS design in the layout tool.

Results

The ADS design appears in the layout tool.

Related Topics

Post Back to Schematic Capture and Layout Layout Tool and ADS Workflow
Adding ADS RF Shapes to Central Library
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Using Extended Configuration, Enable Cutting
and Default Clearance

Use the Enable Cutting selection on the RF Connect Dialog Box (Layout) - Extended
Configuration Tab to define an area within an RF group to be sent to the RF simulator.

The RF_SIMULATION OUTLINE polygon defines the region sent to the RF simulator. When

you select the Enable Cutting option, the objects within the polygon are sent to the RF simulator
(Cutting).

The Default Clearance value defines the clearance area of the objects within the polygon. Use
the RF_SIMULATION_ OUTLINE to increase the clearance area (Clearance).

Note
The RF_SIMULATION OUTLINE draw object must be part of the RF group.

Related Topics

Sending Layout Data MentorDA Dropdown Selections
RF Simulator RF Flow Introduction
Layout Tool and ADS Workflow RF Connect Dialog Box (Layout) - Extended

Configuration Tab

Cutting

The RF_SIMULATION_ OUTLINE polygon defines the objects within the RF group to send to
the RF simulator when you select Enable Cutting (RF Connect Dialog Box (Layout) -
Extended Configuration Tab).

Figure 9-11 shows an RF_SIMULATION OUTLINE draw object polygon (yellow)
encompassing part of a meander (red). When you use the Send layout data command for the
RF group, the RF simulator receives only the area within the polygon.

Figure 9-11. Specific Area Sent to RF Simulator

Layout selection sent RF simulator receives
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Related Topics

Using Extended Configuration, Enable Post Back to Schematic Capture and Layout

Cutting and Default Clearance

Clearance MentorDA Dropdown Selections
Clearance

The RF_SIMULATION_ OUTLINE polygon for a meander is shown in Figure 9-12 (Cutting).

The meander has two vias, 1:2 and 2:3 in the layout tool (layer 1 blue, layer 2 pink, and layer 3
green).

Figure 9-12. Layout Meander on Planes 1, 2, and 3

Figure 9-13 displays the layout region sent to the RF simulator with Enable Cutting defaults.

Figure 9-13. RF Simulator Display of Meander

Using Figure 9-12 as a reference, the following examples demonstrates the Enable Cutting
option:

® Default Clearance and Layer Example
® Layer Clearance Example

® Layer Clearance and Over/Under Example

Default Clearance and Layer Example

In this example, the layout meander shown in Figure 9-12 has the following Enable Cutting
selections as shown Figure 9-14.

Clearance — 50
Selections — Layer - 1, 2, and 3 checked

Types — Components
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Figure 9-14. Meander with Default Clearance

RE Connect E]@‘E\
Connections | Configuration  Extended Configuration }
RF Group Cut
¥ Enable Cutting Defaul Clearance: 50
Layer| Gen. i | Per. Lyr, Ci_Over | Under] |
1 T | [T Flane Shapes
[ 2 | | | Canductive Shap
I EN I (¥ Component
4 i
T
e

Figure 9-15 displays the ADS results after you send the layout data to ADS simulator.

Figure 9-15. RF Simulator Results with Default Clearance

Figure 9-16 shows an ADS 3D representation of the meander. The default clearance value
specifies the meanders clearance display within the polygon region. The meander and default
clearances for the selected layers display because of the Layer sections.

Figure 9-16. 3D Representation of Layer and Default Clearance

Figure provided by Advanced Design System (copyright 2008 Agilent
Technologies

Layer Clearance Example

In this example, Figure 9-12 has the following Enable Cutting selections as shown Figure 9-18:
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Clearance — 50
Selections — Per-layer clearance, layer 1 - 50, layer 2 - 75, layer 3 - 50
Types — Components

Figure 9-17. Trace with Clearance

RE Connect Q@E‘
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BF Group Cut
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Figure 9-18 shows the results after you send layout data to the ADS simulator.

Figure 9-18. RF Simulator Results with Clearance

Figure 9-19 shows an ADS 3D representation of the meander. No Layers are checked, therefore
only the meander’s per-layer clearance values display on each layer.
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Figure 9-19. 3D Representation for Clearance

Figure provided by Advanced Design System
(copyvright 2008 Agilent Technologies

Layer Clearance and Over/Under Example

In this example, Figure 9-12 has the following Enable Cutting selections as shown Figure 9-20:
Clearance — 50

Selections — Per-layer clearance, layer 1 - 50, layer 2 - 75, layer 3 - 50

Selections — Layer 2 with Over and Under

Types — Components

Figure 9-20. Trace with Over and Under
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Figure 9-21 shows a 3D representation in the RF simulator. Layer 2 becomes the reference layer
displaying the meander. The Over and Under sections enables you to view the area over and
under the layer 2 meander with the per layer clearance.

Figure 9-21. 3D Representation for Trace Over and Under

Figure provided by Advanced Design System
(copyright 2008 Agilent Technologies

Related Topics

Using Extended Configuration, Enable Clearance
Cutting and Default Clearance

Post Back to Schematic Capture and Layout

Post back enables you to send designs in the RF simulator to the schematic capture or layout
tool. Use the following procedures.

® Posting Back to Schematic Capture
® Posting Back to Layout

Note
D When you send a top level schematic back to schematic capture, you can only update the

parameters.

After posting back a design, the Central library SymbolLibs contains updated RF_* files. which
Mentor Graphics tools use.

Related Topics

Launching the ADS Server MentorDA Dropdown Selections
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Auto Arranger User-defined RF Shapes
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Posting Back to Schematic Capture

Post Back enables you to send an RF simulator schematic design to a Mentor Graphics
schematic capture tool. The Post Back process flow is shown in Figure 9-22. In order to Post
Back a design, it must:

* Be created in RF simulator schematic with symbols in the Central Library (Adding ADS
RF Shapes to Central Library).

* Be Flat or Flattened to avoid hierarchy.

* Be a design that was sent from the schematic capture tool to the RF simulator, altered in
RF simulator, and sent back to the schematic capture tool.

Figure 9-22. Circuit Created in RF Simulator Flow

¢

Schematic capture Schematic sent to RF
design .iff file simulator with dynamic-

¢ link *

Schematic imported
to RF simulator with
View > RF > IFF |=

Update Transmission
lines and simulate

Import ¢
* or
RF simulator Schematic . ¢
ideal parts Capture RF simulator layout RF
replaced with Connect
Library parts MGC Mentor > Send
Update to Mentor Part parameters
(parameters only) are sent to all
systems
- connected by
layout RF
No y Connect
Verify > Go to layout
Yes

To post back a design from the RF simulator layout tool to the schematic capture tool, use the
following procedure.
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Prerequisites

The design must be open in the schematic capture tool.

The design must be open in ADS.

Procedure

Note

If you are using ADS, all shapes must be filled. To fill a shape, select the shape in ADS,
then right-click Modify > Join.

1.

4,

5.

Choose File > Export and create an .iff (Interchange File Format) file in the RF
simulator schematic window.

Choose View > RF > IFF Schematic in the Mentor Graphics schematic capture tool.
Select the .iff file generated by the RF simulator in the Open dialog box.

If the schematic capture tool already contains a design with the same name as the .iff file
(for example balmix in Figure 9-23), select one of the following from the IFF Import
dialog box:

a. Update parameters — Only updates the RF parameters on existing shapes in the
current schematic.

b. Replace — Replaces the existing schematic with the schematic from the .iff file.

Figure 9-23. IFF Import Dialog Box

IFF Import

Schematic "balmix" already exists,

{(#) Update parameters () Replace

i oK i I Cancel l

Import the .iff file into schematic capture. You must replace the symbols with schematic
capture Central Library parts.

Replace parts and send the schematic back to the RF simulator for re-evaluation with RF
connect.

Note

D

Only capacitors, resistors, transistors, and diodes are supported with the RF Connect link.

282

RF in DxDesigner - Expedition Flow Users Manual, EE 7.9.5



ADS RF Simulator
Post Back to Schematic Capture and Layout

In the schematic capture tool, you can also generate an .iff file by selecting Generate
Schematic Data. The location of the generated .iff file is:

<project directory>\RF\iff\<project name>_<current_date>_ <current
time>.iff

You can also generate an .iff file that can be imported into the RF simulator. In the
schematic capture tool, choose Generate Schematic Data. File location is:

6. Choose File > Import and open the schematic capture .iff file in the RF simulator.
7. Modify the transmission line RF symbols to those used in the RF simulator.

8. Post Back parameter changes for capacitors, resistors, transistors, and diodes, by
performing a .iff file transfer, or choose MentorDA > Send Update to Mentor in the
RF simulator.

The RF simulator can update the parameters only if the schematic capture and layout
tools are connected through the RF Connect link.

The RF simulator and schematic capture and layout flow is shown in Figure 9-22.

Results

The RF simulator design appears in the schematic capture tool.

Related Topics

Post Back to Schematic Capture and Layout Posting Back to Layout

Sending ADS Design to Schematic Capture
Tool

Posting Back to Layout

Post Back enables you to send an RF simulator layout design to the Mentor Graphics layout tool
where you can finalize and save it as a custom RF shape. If you do not save the design as a
custom RF shape, it only exists in the current layout.

The RF simulator MentorDA > Send Layout Update to Mentor selection enables you to use
the custom shape in another design by generating a symbol for it, instantiating it in a schematic,
and forward annotating.

The Post Back layers, vias, and ports are controlled by a mapping file (Creating an ADS
Mapping File).

Use the following procedure to Post Back a design in the RF simulator to the layout tool.
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Procedure

1.

Create an RF connection between the RF simulator and the Mentor Graphics layout tool
(Connecting Layout to RF Simulator Server).

Select the design to be posted back in the RF simulator layout window.
Choose MentorDA > Send Layout Update to Mentor.

You can use a mapping file to control the mapping of the RF simulator layers and vias to
the Mentor Graphics layout tool (RF Mapping rflayermap.xml Dialog Box).

The RF simulator design is imported into an RF group, using the name assigned to the
the RF simulator project. The group is initially located at the origin, and you can move it
as with any other group. If the procedure is repeated after the group has been moved, the
last location of the shape is preserved.

Create the library symbol (Creating a Library Part).

The shape definition is stored in the library elements file, and the symbol is stored in the
$MGC_ADSLIB directory.

Results

The RF Control dialog box, RF Library Shape tab - User directory, lists the new RF shape.

Related Topics

Send Design Data to ADS Simulator Sending ADS RF Design to Layout Tool
Adding ADS RF Shapes to Central Library Posting Back to Schematic Capture
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MWO RF Simulator Introduction

The schematic capture and layout tools use the RF simulator named Applied Wave Research
(AWR) Microwave Office (MWO) to simulate RF groups.

Caution
Install all Mentor Graphics software and relevant patches before you install AWR/MWO
and AWRConnect MentorSetup software. If you install Mentor Graphics tools after
installing AWRConnect MentorSetup software, remove the AWRConnect MentorSetup
software and reinstall (Installing MWO Connected MentorSetup).

Use the following procedures as needed:

Installing MWO Connected MentorSetup

Adding AWR/MWO RF Shapes to Central Library
Synchronizing AWR/MWO and Central Library Libraries
Launching MWO Server

Sending Schematic Capture RF Shapes

Sending an MWO Design to Schematic Capture

Sending Layout Data

Posting Back MWO Updates to Layout

Related Topics

RF Simulator RF Layout

Getting Started Schematic Capture

Installing MWO Connected MentorSetup

The AWRConnected MentorSetup wizard creates a menu selection, enabling you to launch the
AWR/MWO RF simulator server (Launching MWO Server). The schematic capture and layout
tools use RF Connect to connect to the AWR/MWO server creating the dynamic-link.
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(Connecting Schematic Capture to RF Simulator Server and Connecting Layout to RF
Simulator Server).

Note

D When you install AWR, schematic capture, and layout on different workstations, the
schematic capture and layout tools workstation must have the environment variable
AWRD LICENSE FILE set to the remote AWR license file. For more information
about the environment variable, refer to the AWR documentation.

Use the following procedure to install AWRConnected MentorSetup software.

Prerequisites

Caution
If you update the Mentor Graphic software after installing the AWRConnected
MentorSetup wizard, uninstall and then reinstall the wizard.

® Mentor Graphics schematic capture and layout tool must be installed.

* AWR/MWO software must be installed.

Procedure

Note
D The AWRConnected MentorSetup wizard is only supported on Windows platforms.

1. Unzip the AWRConnectedMentorSteup xxx.zip file.
Open the AWRConnected MentorSetup.msi file.
Click Next.

Define Folder and set to Self or Everyone.

Click Next.

Click Next to confirm installation.

Click Close in the Installation Complete window.

S B AR S o

Confirm that the menu is available, choose View > Project Browser > Wizard >
AWRConnected Mentor menu selections.

Related Topics

Adding AWR/MWO RF Shapes to Central Launching MWO Server
Library
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RF Layout RF Simulator

Adding AWR/MWO RF Shapes to Central Library

The AWRShapesLibrary contains a subset of the AWR/MWO REF shape library. The
AWRShapesLibrary contains symbols that are identical to AWR/MWO symbols, which pertain
to RF/Microwave designs.

Y ou must merge the AWRShapesLibrary into your Central library (CL) to place RF symbols in
the schematic capture tool (Placing RF Symbols).

Use the following procedure to merge the AWR/MWO library into your Central library.

Procedure
1. Open a Command Prompt window.
2. Type the following command in a Command Prompt window:

%$SDD_HOME\common\win32\bin>RFSymMergeUtility

The following command and options display:
RFSymMergeUtility [-ads | awr] [-rfcl <path to RF CL/Source CL>]

[-all | (list of partition names) ] [-update | overwrite] -userCL
<customer-CL/Destination CL>

3. Enter the command and options on a command line or in a <file_name>.bat file.

Example:

Note
D The command must be on one line or use the ” as a continuation character.

C:\MentorGraphics\<EE_software>\SDD_HOME\common\win32\bin\RFSymMergeUtili
ty.bat -awr -rfcl *
C:\MentorGraphics\<EE_software>\SDD_HOME\standard\RF\AWRShapesLibrary\AWR
ShapesLibrary.lmc -all -update -userCL *
U:\Design_Central_Library\Central_Library.lmc

4. Save <file name>.bat file.
5. Double-click <file_name>.bat file.

The Command Prompt window displays information about the merge.

C:\MentorGraphics\2007.6EE\SDD_HOME\common\win32\bin\RFSymMergeUtility.ba
t —awr -rfcl
C:\MentorGraphics\2007.6EE\SDD_HOME\standard\RF\AWRShapesLibrary\AWRShape
sLibrary.lmc RF* -update -userCL

U:\Central_Library_Vidar_ RF\Central_Library.lmc
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Source

CL:C:\MentorGraphics\2007.6EE\SDD_HOME\standard\RF\AWRShapesLibrary\AWRS

hapesLibrary.lmc
Destination CL:U:\Central_Library Vidar_RF\Central_Library.lmc
Patitions to update:

RE*

mode:
Copying
Copying
Copying
Copying
Copying
Copying
Copying
Copying
Copying
Copying
Copying
Copying
Copying
Copying
Copying
Copying

append

partition
partition
partition
partition
partition
partition
partition
partition
partition
partition
partition
partition
partition
partition
partition
partition

RF_MWO_Microstrip_Bends
RF_MWO_Microstrip_Components
RF_MWO_Microstrip_Coupled_Lines
RF_MWO_Microstrip_Jdunctions
RF_MWO_Microstrip_Lines
RF_MWO_Microstrip_Other
RF_MWO_Simulation_Control
RF_MWO_Stripline_Bends
RF_MWO_Stripline_Components
RF_MWO_Stripline_Coupled_Lines
RF_MWO_Stripline_Junctions
RF_MWO_Stripline_Lines
RF_MWO_Stripline_Other
RF_MWO_Substrates

RF_UTILS

RF_Varblocks

C:\Documents and Settings\jminor>

Results

When the command completes, the RF simulator and Central library are synchronized.

Related Topics

Launching MWO Server

RF Simulator

Getting Started

Send Design Data to MWO Simulator
RF Layout
Schematic Capture
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Synchronizing AWR/MWO and Central Library Libraries

After you add RF shapes to the MWO Elements Browser selection, you must add the shapes to
the Central library.

Use the schematic capture tool to update the Central library with the new AWR RF shapes.

Prerequisites
® The schematic capture tool and AWR must have an active dynamic-link (Launching
MWO Server and Sending Schematic Capture RF Shapes).
Procedure
1. Open the RF Group/Ungroup Dialog Box in schematic capture tool.
2. Select an RF group.
3. Choose Import Library.

Results

When Import Library completes, the RF simulator and Central library are synchronized.

Related Topics

Launching MWO Server Send Design Data to MWO Simulator
RF Simulator RF Layout
Getting Started Schematic Capture

Launching MWO Server

When you launch the AWR/MWO server, you enable the schematic capture and layout tools to
connect to the RF simulator server.

Use the following procedure to launch the AWR/MWO server.
Prerequisites

*  AWR software must be installed (Installing MWO Connected MentorSetup).

®*  AWR must have an open schematic.

Procedure

1. Select View > Project Browser in the MWO window.
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2. Expand the Wizards directory.
Figure 10-1. Path to AWRConnected Mentor

Project fz]
Design Motes
Project Options
[x=1] Global Definitions
[C= Data Files

= Circuit Schematics

Annatations
[*=2] schematic 1
[ Schematic 2
= EM Struckures
Annokations
[x_ﬂ Cubput Equations
Graphs
[<3] optimizer Goals
Yield Goals
=3 Cukput Files

=5 Wizards

AWR Filker Synthesis Wizard

AWR Load Pull Wizard

3. Choose AWRConnected Mentor. The AWRConnected Mentor Wiz window appears.

Figure 10-2. AWRConnected Banner
AWRConnected Mentor, Wiz E|

Welcome to AWRConnected for
Mentor Graphics
This wizard will guide yau thraugh the steps required zet up a

connhection between a Microwave Office schematic and
tentor graphics design.

G

Click Mext to continue or Cancel to exit the Mentor Graphics
connection wizard.

| Mest > |[ Cancel

4. Click Next and the window in Figure 10-3 appears.
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Figure 10-3. Schematic Selection
AWRConnected Mentor, Wiz E|

Schematic Selection
Select the schematic that will be used for synchronization from Mentor Graphics. pLLN

Select the schematic that will be uzed far synchronization.

| 3

Mentor schematic name the same as MwC
[ Awsto-Simulate after update of MwO,

Wersion: 1.0.0.2000

[ < Back H Hest » I[ Cancel

5. Select a schematic from the dropdown list.
6. Click Next and Figure 10-4 appears.
Select one of the following:
o Set Action Connection Only — Launches only the AWR/MWO server.

o Create/Update Schematic (DX) — Transfers design data from AWR to the
schematic capture tool.

o Update Layout (Expedition) — Transfers design data from AWR to the layout
tool.

Figure 10-4. Current Connection

AWRConnected Mentor, Wiz FX|

Select 'Finish' to set this as the
current connection to Mentor
Graphics.

Thiz completes the connection wizard, you may select 'Back!
to change your settings, or you may press finish to make this

the currently active connection to Mw 0. The connection
A WR should show up in spnchorization tool that will appear.

¢ || Open Dialog

() Update Layout [Expedition)

[ < Back ” Finizh ][ Cancel

7. Click Finish and Figure 10-5 appears.
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Figure 10-5. AWRConnected Mentor Dialog Box

A AWRConnected Mentor

Wiew  Help

Micrawave Office Connections: tentar Graphics Cannections:
| dv_to_mwo.emp

Current Schematic Connection

| d#_to_mwa.<nane> v|

[ Dump Rave ML

Canr

Ready

8. Connect the schematic capture and/or layout tool to the AWR/MWO server with the
following:

o Connecting Schematic Capture to RF Simulator Server

o Connecting Layout to RF Simulator Server

Results

You are now ready to connect the schematic capture and/or layout tool to the AWR/MWO
server.

o Connecting Schematic Capture to RF Simulator Server
o Connecting Layout to RF Simulator Server
Related Topics

Schematic Capture RF Layout
RF Simulator
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Send Design Data to MWO Simulator

You can send and receive design data between the MWO RF simulator and the schematic
capture or layout tools with the dynamic-link.

® Sending Schematic Capture RF Shapes

* Sending an MWO Design to Schematic Capture
* Sending Layout Data

® Posting Back MWO Updates to Layout

Related Topics

Schematic Capture RF Layout
RF Simulator

Sending Schematic Capture RF Shapes

Send schematic capture RF shapes to the MWO schematic tool and create your design.

Use the following to integrate schematic capture AWR RF library symbols into AWR/MWO
library.
Prerequisites

® The schematic capture tool must be connected to the AWR/MWO server (Connecting
Schematic Capture to RF Simulator Server).

® A schematic must be open in the AWR/MWO tool.

Procedure
1. Open a schematic in the Mentor Graphics’ schematic capture tool.
2. Select the RF shapes and create an RF Group (Creating an RF Group).
3. Click the RF Groups tab in the Navigator (Figure 10-6).
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Figure 10-6. Navigator, RF Groups Tab - RF Group Dropdown Menu

HEE|
%o Project | 13w RF Groups
=4 VidarParts ~
38 Default
38 RFLinet
38 RFLine2
38 vidaramp
38 vidarDxamp
=38

Expand all
Collapse all

GroupAngroup

Generate netlist

RF DRC

Send netlist

Generate Schematic Data

e

Send Schemafic Data

4. Select an RF group and choose Send Schematic Data from the popup.

Caution
Connect parts with a net when you create your design in the MWO schematic tool. A

part-to-part connection is not supported in the schematic capture tool (RF Simulator
Design Generation).

Result

The Mentor Graphic schematic capture RF shapes display in the RF simulator
schematic.

Related Topics

Send Design Data to MWO Simulator RF Simulator

Sending an MWO Design to Schematic Capture

After simulating your design and making design changes, update the design in the schematic
capture tool.

Use the following procedure to send the MWO RF simulator design to the schematic capture
tool.
Prerequisites
®* The AWR/MWO RF simulator must be launched with the schematic opened.

® The schematic capture tool must be connected to the AWR server (Connecting
Schematic Capture to RF Simulator Server).

® The schematic capture schematic name must be the same as the MWO schematic name.
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Procedure

1. Launch the AWR/MWO RF simulator and open the schematic.
Select Project Browser > Wizards > AWRConnected Mentor.
Click Next in the AWRConnected Mentor Wiz dialog box.
Select Create/update Schematic (DX) and Open Dialog check box.
Click Next.
Select the schematic.
Click Next.
Click Finish.

ol B A S T

Results

The MWO design appears in the schematic capture tool.

Related Topics

Send Design Data to MWO Simulator RF Simulator
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Sending Layout Data

Use the following procedure to send a layout RF group to the AWR/MWO RF simulator.

Prerequisites

The layout tool must be connected the RF simulator (Connecting Layout to RF
Simulator Server)

A design must be open in the AWR/MWO layout tool.

Procedure

1.

Open a design in the AWR/MWO layout tool.

2. Click Control pane ( ) or Group/Ungroup (35) (RF Toolkit Toolbar).
3. Select an RF group in the Navigator.
4. Choose Send layout data (RF Group Menu Selections).

Results

If the RF group exits in the AWR/MWO layout tool, the RF shapes parameters, stackup,
and locations of all elements in the RF group are updated.

The layout RF group appears in the AWR/MWO layout tool.

Related Topics

Send Design Data to MWO Simulator RF Simulator
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Posting Back MWO Updates to Layout

When you make design changes in the AWR/MWO RF simulator you can send them back to
update the layout design.

Use the following procedure to send an AWR/MWO design back to the layout tool.

Prerequisites
® The layout tool must be connected to an AWR/MWO server (Connecting Layout to RF
Simulator Server).
Procedure
1. Open your design in the layout tool.
2. Open your design in the AWR/MWO RF simulator.
3. Choose View > Project Browser > Wizards > AWRConnected Mentor.
4. Select Update Layout (Expedition) (Figure 10-7).

Figure 10-7. AWR Design to Layout

AWRConnected Mentor, Wiz

Select 'Finish' to set this as the
current connection to Mentor
Graphics.

This completes the cannectian wizard, pou may select 'Back’
ta change your settings, or you may press finish to make this

the currently active connection to MWO. The connection
A WR should show up in synchonization tool that will appear.

Action Upon Completion: Open Dislog
() Set Active Connection Only
() Create/Indate Schematic (03

< Back ” Finizh I[ Cancel

5. Click Finish.

Results
The AWR/MWO layout design displays in the layout tool.

Related Topics

Send Design Data to MWO Simulator RF Simulator
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Appendix A
Design Restrictions

The following design restrictions are known limitations.

The layout tool does not allow you to delete schematic driven RF shapes.

ADS design parameters that control the physical appearance of elements in the sub
circuit are not supported.

The RF elements RIBBON and WIRE are not currently supported in the ADS
integration. The RF elements, MLCLE, MLVIAHOLE, and MLVIAPAD are not
currently supported in ADS.

The ADS RF simulator schematic capture tool and the layout tool use the same design
unit.

You must specify a seed component when placing RF parts in the layout tool.

If you use any substrate other than the default, you must manually set up and maintain
identical copies of the substrate in both DxDesigner and ADS.

You cannot use the standard PCB reuse capabilities with RF designs.

You cannot change nets assigned to RF shapes if the shape was created in the schematic
tool. You can only assign existing nets to meanders and RF shapes if you create the
shapes in the layout tool.

AWR/MWO does not support connections with a net name in the Mentor Graphics
schematic capture tool. The nets disconnect when you transfer the design to
AWR/MWO schematic capture.

Components have to be graphically connected and there is no support for connections
between sheets. This restriction applies only to the AWR/MWO simulator.
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RF Simulator Design Generation

When you create a design in the RF simulator, connect all objects with a net. Connecting
objects with a net ensures object connection in the schematic capture tool. Refer to Figure A-1
and Figure A-2 for examples.

Figure A-1. Object to Net Connection
- MLIN - A G . T T SCCRNL: - [ It

ID=RF1 ¢ R - |D=RF2
WSO - - - - - - =10l
CL=100mH - - - e - L=100mid -
o B _._.T_.u._'_ A PRl (. T
MUN
ID=RFS7 No net, no
W=29.46 mil connection in
L=173.2 mijl .
P b R e schematic capture
4 using dynamic link
i MON:< % % % % o o 4 o 3w WLIN
. ID=RF58- - - - - - - - - - . . [D=RF59-
CWSIOmE - o - - oo W=A0-mil
CL=00mil o o - o o o L=100mil
i O 8- K
o e
| E s ow e owow s o oe v s e Anetadded for
connection in
WERE S S ® | ¢ | rw smeeo=s s e schemaliccapture
ID=RFBO | | " using dynamic link
W=29.46 mil
=732 mil . [
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Figure A-2. Object to Object Connection

CMUN - - ML

- ID=RFET - - - - - - ID=RFE3-
R L1 e I C W=Dl

- =0l - - - - o L=100-mil

f\ :::.......:::DaAnetaddedfor

o -

No net, no ..
. connection in
connection in .
wun | " echematic schematic capture
D=RFEY ' o . using dynamic link
JUERPBe . capture using ST <
=29 4B mil dynamic link -~ - ML
1L=173.2 mil _ .. . . . . |D=RFB4
S W=BEmil
o =732 mil

*

When you create a design in DxDesigner, make sure the nets or net segments do not overlay as
shown in Figure A-3 — A. The RF simulator connects the overlaid nets or net segments. Create
the DxDesigner design as shown in Figure A-3 — B.

Figure A-3. DxDesigner Nets

A - Segment overlay (Error) B - No segment overlay (Correct)

e
1e
HEUB-HELUB 1
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Appendix B
Equation Editor Expressions

Table B-1 and Table B-2 list the supported functions for the Equation Editor Dialog Box.
Scaling information is available in Scale Factor.

The schematic capture tool and the layout tool support the following single argument functions.

Table B-1. Equation Editor Single Arguments List

Argument | Description

abs() Returns the absolute value of the contents of the parentheses

acosh() Returns the inverse hyperbolic cosine

arctan() Returns the arc tangent of arg in radians; arctan() is the complementary
function of tan().

atan() Returns the inverse tangent, or arc tangent of arg in radians.

ceil() Returns the next highest integer value rounded up if required.

cos() Returns the cosine of arg in radians.

cosh() Ret'urns the inverse hyperbolic cosine or arg; the value whose hyperbolic
cosine is arg.

cot() Returns the cotangent of arg.

coth() Returns the hyperbolic cotangent of arg.

ctof() Converts Celsius to Fahrenheit returning a real number.

ctok() Converts Celsius to Kelvin returning a real number.

db() Returns the decibel measure of a voltage ratio of arg.

dbmtow() | Converts arg in dBm to watts.

deg() Converts arg in radians to degrees.

exp() Calculates the exponent of e to the power of arg.

floor() Returns the largest integer lowest value by rounding down arg if
necessary

ftoc() Converts arg in Fahrenheit to Celsius and returns a real number.

ftok() Converts Fahrenheit to Kelvin and returns a real number

int() Converts real number arg into an integer.

RF in DxDesigner - Expedition Flow Users Manual, EE 7.9.5

303



Equation Editor Expressions

Table B-1. Equation Editor Single Arguments List

ktoc() Converts arg in Kelvin to Celsius as real number.

ktof() Converts arg in Kelvin to Fahrenheit as real number.

In() Returns natural logarithm of arg.

log() Returns the natural logarithm of base 10 as an integer or real number.

log10() Calculates x (argl) raised to the power of y (arg2).

mag() Returns the magnitude of arg.

rad() Converts arg in degrees to radians.

sin() Returns the sine of arg in radians.

sinc() Computes the sine of arg divided by arg (sin(arg)/arg), where arg is in
radians.

sinh() Computes the hyperbolic sine of arg.

sqrt() Returns the square root of arg.

tan() Computes the tangent of arg, where arg is in radians.

tanh() Computes the hyperbolic tangent of arg in radians.

wtodbm() | Converts arg in Watts and returns the dBm as a real or complex number.

The schematic capture tool and the layout tool support the following double argument
functions.

Table B-2. Equation Editor Double Arguments List

Argument | Definition

atan2() Returns the inverse tangent, or arc tangent of arg which is the rectangular
coordinates y and Xx.

dbm() Returns the decibel measure of a voltage referenced to a 1 milliwatt
signal and a defined impedance.

dbmtoa() | Converts arg’s into short circuit current, given the reference impedance
and returns a real or complex number.

dbmtov() | Converts arg’s into open circuit voltage, given the reference impedance
and returns a real or complex number.

fmod() Returns the floating point remainder (modulo) of dividing argl by arg2

hypot() Calculates the hypotenuse of a right triangle with side 1 (argl) and side 2
(arg2).

jn() Computes the Bessel function of the first kind and returns a real number
of arg.

pow() Calculates x (argl) raised to the power of y (arg2).
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Table B-2. Equation Editor Double Arguments List

rem() Returns the remainder of argl divided by arg2 as a real number.

sgn() Returns the integer sign of an integer or real number, as either 1 or -1.
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abs()

abs()

Description

Returns the absolute value of the contents of the parentheses
Usage
p = abs(arg)
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acosh()

Description

Returns the inverse hyperbolic cosine
Usage

p = acosh(arg)
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arctan()

arctan()

Description

Returns the arc tangent of arg in radians; arctan() is the complementary function of tan().
Usage

p = arctan(arg)
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atan()

atan()

Description

Returns the inverse tangent, or arc tangent of arg in radians.
Usage

p = atan(arg)
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atan2()

atan2()

Description

Returns the inverse tangent, or arc tangent of arg which is the rectangular coordinates y and x.

Usage
p = atan2(argl, arg2)
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ceil()

ceil()
Description

Returns the next highest integer value rounded up if required.
Usage

p = ceil(arg)

RF in DxDesigner - Expedition Flow Users Manual, EE 7.9.5 31



Equation Editor Expressions
cos()

cos()

Description

Returns the cosine of arg in radians.

Usage
p = cos(arg)
312
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cosh()

cosh()

Description

Returns the inverse hyperbolic cosine or arg; the value whose hyperbolic cosine is arg.
Usage

p = cosh(arg)
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cot()

cot()

Description

Returns the cotangent of arg.

Usage
p = cot(arg)
314
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coth()

coth()

Description

Returns the hyperbolic cotangent of arg.
Usage

p = coth(arg)
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ctof()

ctof()

Description

Converts Celsius to Fahrenheit returning a real number.
Usage
p = ctoftarg)
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ctok()

ctok()

Description

Converts Celsius to Kelvin returning a real number.
Usage

p = ctok(arg)
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db()

db()

Description

Returns the decibel measure of a voltage ratio of arg.
Usage
p =db(arg)
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dbm()

dbm()

Description

Returns the decibel measure of a voltage referenced to a 1 milliwatt signal and a defined
impedance.

Usage
p =dbm(argl, arg2)
argl — voltage (peak voltage)

arg?2 — impedance
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dbmtoa()

dbmtoa()

Description

Converts arg’s into short circuit current, given the reference impedance and returns a real or
complex number.

Usage
p = dbmtoa(argl, arg 2)
argl — Value in dBm

arg2 — Reference Impedance
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dbmtov()

dbmtov()

Description

Converts arg’s into open circuit voltage, given the reference impedance and returns a real or
complex number.

Usage
p = dbmtov(argl, arg?2)
argl — Value in dBm

arg2 — Reference Impedance
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dbmtow()

dbmtow()

Description

Converts arg in dBm to watts.

Usage
p = dbmtow(arg)
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deg()

deg()

Description

Converts arg in radians to degrees.
Usage
p = deg(arg)
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exp()

exp()

Description

Calculates the exponent of e to the power of arg.
Usage
p = exp(arg)
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floor()

floor()

Description

Returns the largest integer lowest value by rounding down arg if necessary
Usage
p = floor(arg)
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fmod()

fmod()

Description

Returns the floating point remainder (modulo) of dividing arg! by arg?2
Usage
p = fmod(argl, arg2)
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ftoc()

ftoc()

Description

Converts arg in Fahrenheit to Celsius and returns a real number.
Usage
p = floc(arg)
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ftok()

ftok()

Description

Converts Fahrenheit to Kelvin and returns a real number
Usage
p = fiok(arg)
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hypot()

hypot()
Description

Calculates the hypotenuse of a right triangle with side 1 (argl) and side 2 (arg2).
Usage

p = hypot(argl, arg2)
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int()

int()

Description

Converts real number arg into an integer.
Usage
p = int(arg)
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in()

in()
Description
Computes the Bessel function of the first kind and returns a real number of arg.
Usage
p =jn(argl, arg2)
Set Type
argl — order

arg2 — the value for which the Bessel value is to be found
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ktoc()

ktoc()

Description

Converts arg in Kelvin to Celsius as real number.
Usage
p = ktoc(arg)
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ktof()

ktof()

Description

Converts arg in Kelvin to Fahrenheit as real number.
Usage
p = ktof(arg)

RF in DxDesigner - Expedition Flow Users Manual, EE 7.9.5 333



Equation Editor Expressions

In()

In()

Description

Returns natural logarithm of arg.
Usage
p = In(arg)
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log()

log()

Description

Returns the natural logarithm of base 10 as an integer or real number.
Usage
p = log(arg)
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log10()

log10()

Description

Returns the base-10 logarithm of

arg'
Usage
p = logl0(arg)
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mag()

mag()

Description

Returns the magnitude of arg.
Usage
p = mag(arg)
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pow()

pow()

Description

Calculates x (argl) raised to the power of y (arg?2).
Usage
p = pow(argl, arg2)
argl — real number

arg2 — exponent
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rad()

rad()

Description

Converts arg in degrees to radians.
Usage

p =rad(arg)

RF in DxDesigner - Expedition Flow Users Manual, EE 7.9.5 339



Equation Editor Expressions
rem()

rem()

Description

Returns the remainder of arg! divided by arg?2 as a real number.
Usage

p =rem(argl, arg2)
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sgn()

sgn()
Description

Returns the integer sign of an integer or real number, as either 1 or -1.
Usage

p =sgn(arg)
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sin()

sin()

Description

Returns the sine of arg in radians.

Usage
p = sin(arg)
342
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sinc()

sinc()
Description

Computes the sine of arg divided by arg (sin(arg)/arg), where arg is in radians.
Usage

p = sinc(arg)
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sinh()

sinh()

Description

Computes the hyperbolic sine of arg.
Usage
p = sinh(arg)
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sqrt()

sqrt()
Description

Returns the square root of arg.
Usage
p = sqri(arg)
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tan()

tan()

Description

Computes the tangent of arg, where arg is in radians.
Usage
p = tan(arg)
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tanh()

tanh()

Description

Computes the hyperbolic tangent of arg in radians.
Usage

p = tanh(arg)
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wtodbm()

wtodbm()

Description

Converts arg in Watts and returns the dBm as a real or complex number.

Usage
p = wtodbm(arg)
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Scale Factor

A scale factor is a number which scales, or multiplies a fundamental unit. You can use the scale
factor to define a parameter. A scale factor <word> begins with a letter or an underscore
character (_). The remaining characters, if any, are the <unit><prefix> values consisting of
letters, digits, and underscores.Values used for conversion from one unit of measure to another

are scale factors.
5KV
w <unit>

<word> <prefix>

Examples:
4°C

The <word> must match one of the words listed in Table B-3.

Table B-3. Word Scale Factor

Word Numerical Equivalent Definition
mil 2.54%10 7 mils
in 2.54%10 2 inches
ft 12#2.54%10 2 feet
mi 5280%12+2.54*10 miles
cm 1.0%10 2 centimeters
mm 1.0%10 3 millimeters
PHz 1.0%10 13 petahertz
dB 1.0 decibels
nmi 1852 nautical miles
C 1.0 Celsius
Prefixes are not allowed for mils, in, ft, mi, nmi.

A set of fundamental units is a set of units used to describe measurement quantities which are
equal to one. The case sensitive fundamental <unif>, must match the Unit listed in Table B-4.

Table B-4. Unit Scale Factor

Unit Definition
A Amperes
F Farads
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Table B-4. Unit Scale Factor (cont.)

Unit Definition
H Henries
Hz Hertz
meter meters metre metres | meters
Ohm Ohms Ohms

S Siemens
sec. seconds
\" Volts

W Watts

The fundamental scale factors <prefix> must match one of the prefixes listed in Table B-4.

Table B-5. Prefix Scale Factor

Prefix Numerical Equivalent | Definition
T 10 12 Tera

G 10° Giga

M 10°© Mega

K 103 kilo

k 103 kilo

_ (underscore) |1 (no scale)
m 103 milli

u 1076 micro

n 107 nano

p 1012 pico

f 1013 femto

a 10713 atto

Scale factor resolution, within the Equation Editor, is evaluated in the following sequence
<word> (Table B-3) <unif> (Table B-4) <prefix> (Table B-5). If the scale factors are not
recognized, an error message is posted and a scale factor of 1 is used.

Table B-6. Operators

+ | Addition

- | Subtraction
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Table B-6. Operators (cont.)

* | Multiplication

/| Division

(| Open parenthesis

) | Close parenthesis

, | Comma - separator for
arguments

= | Assignment

E | Exponent (as in 23.45E6

Equation expressions are evaluated, left to right. If parentheses are used, operation within the
parentheses occurs first.

The mathematical operators in order of precedence are:

Table B-7. Mathematical Operators

A Exponentiation

*,/ | Multiplication and division

+, - | Addition and Subtraction

Related Topics

Auto Arranger Var Block
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End-User License Agreement

The latest version of the End-User License Agreement is available on-line at:
www.mentor.com/eula

IMPORTANT INFORMATION

USE OF ALL SOFTWARE IS SUBJECT TO LICENSE RESTRICTIONS. CAREFULLY READ THIS LICENSE
AGREEMENT BEFORE USING THE PRODUCTS. USE OF SOFTWARE INDICATES CUSTOMER’S
COMPLETE AND UNCONDITIONAL ACCEPTANCE OF THE TERMS AND CONDITIONS SET FORTH IN
THIS AGREEMENT. ANY ADDITIONAL OR DIFFERENT PURCHASE ORDER TERMS AND CONDITIONS
SHALL NOT APPLY.

END-USER LICENSE AGREEMENT (“Agreement”)

This is a legal agreement concerning the use of Software (as defined in Section 2) and hardware (collectively “Products”)
between the company acquiring the Products (“Customer”), and the Mentor Graphics entity that issued the
corresponding quotation or, if no quotation was issued, the applicable local Mentor Graphics entity (“Mentor
Graphics”). Except for license agreements related to the subject matter of this license agreement which are physically
signed by Customer and an authorized representative of Mentor Graphics, this Agreement and the applicable quotation
contain the parties' entire understanding relating to the subject matter and supersede all prior or contemporaneous
agreements. If Customer does not agree to these terms and conditions, promptly return or, in the case of Software
received electronically, certify destruction of Software and all accompanying items within five days after receipt of
Software and receive a full refund of any license fee paid.

ORDERS, FEES AND PAYMENT.

1.1. To the extent Customer (or if agreed by Mentor Graphics, Customer’s appointed third party buying agent) places and
Mentor Graphics accepts purchase orders pursuant to this Agreement (“Order(s)”), each Order will constitute a contract
between Customer and Mentor Graphics, which shall be governed solely and exclusively by the terms and conditions of
this Agreement, any applicable addenda and the applicable quotation, whether or not these documents are referenced on the
Order. Any additional or conflicting terms and conditions appearing on an Order will not be effective unless agreed in
writing by an authorized representative of Customer and Mentor Graphics.

1.2. Amounts invoiced will be paid, in the currency specified on the applicable invoice, within 30 days from the date of such
invoice. Any past due invoices will be subject to the imposition of interest charges in the amount of one and one-half
percent per month or the applicable legal rate currently in effect, whichever is lower. Prices do not include freight,
insurance, customs duties, taxes or other similar charges, which Mentor Graphics will state separately in the applicable
invoice(s). Unless timely provided with a valid certificate of exemption or other evidence that items are not taxable, Mentor
Graphics will invoice Customer for all applicable taxes including, but not limited to, VAT, GST, sales tax and service tax.
Customer will make all payments free and clear of, and without reduction for, any withholding or other taxes; any such
taxes imposed on payments by Customer hereunder will be Customer’s sole responsibility. If Customer appoints a third
party to place purchase orders and/or make payments on Customer’s behalf, Customer shall be liable for payment under
Orders placed by such third party in the event of default.

1.3. All Products are delivered FCA factory (Incoterms 2000), freight prepaid and invoiced to Customer, except Software
delivered electronically, which shall be deemed delivered when made available to Customer for download. Mentor
Graphics retains a security interest in all Products delivered under this Agreement, to secure payment of the purchase price
of such Products, and Customer agrees to sign any documents that Mentor Graphics determines to be necessary or
convenient for use in filing or perfecting such security interest. Mentor Graphics’ delivery of Software by electronic means
is subject to Customer’s provision of both a primary and an alternate e-mail address.

GRANT OF LICENSE. The software installed, downloaded, or otherwise acquired by Customer under this Agreement,
including any updates, modifications, revisions, copies, documentation and design data (“Software”) are copyrighted, trade
secret and confidential information of Mentor Graphics or its licensors, who maintain exclusive title to all Software and retain
all rights not expressly granted by this Agreement. Mentor Graphics grants to Customer, subject to payment of applicable
license fees, a nontransferable, nonexclusive license to use Software solely: (a) in machine-readable, object-code form (except
as provided in Subsection 5.2); (b) for Customer’s internal business purposes; (c) for the term of the license; and (d) on the
computer hardware and at the site authorized by Mentor Graphics. A site is restricted to a one-half mile (800 meter) radius.
Customer may have Software temporarily used by an employee for telecommuting purposes from locations other than a
Customer office, such as the employee's residence, an airport or hotel, provided that such employee's primary place of
employment is the site where the Software is authorized for use. Mentor Graphics’ standard policies and programs, which vary
depending on Software, license fees paid or services purchased, apply to the following: (a) relocation of Software; (b) use of
Software, which may be limited, for example, to execution of a single session by a single user on the authorized hardware or for
a restricted period of time (such limitations may be technically implemented through the use of authorization codes or similar
devices); and (c) support services provided, including eligibility to receive telephone support, updates, modifications, and
revisions. For the avoidance of doubt, if Customer requests any change or enhancement to Software, whether in the course of
receiving support or consulting services, evaluating Software, performing beta testing or otherwise, any inventions, product



improvements, modifications or developments made by Mentor Graphics (at Mentor Graphics’ sole discretion) will be the
exclusive property of Mentor Graphics.

ESC SOFTWARE. If Customer purchases a license to use development or prototyping tools of Mentor Graphics’ Embedded
Software Channel (“ESC”), Mentor Graphics grants to Customer a nontransferable, nonexclusive license to reproduce and
distribute executable files created using ESC compilers, including the ESC run-time libraries distributed with ESC C and C++
compiler Software that are linked into a composite program as an integral part of Customer’s compiled computer program,
provided that Customer distributes these files only in conjunction with Customer’s compiled computer program. Mentor
Graphics does NOT grant Customer any right to duplicate, incorporate or embed copies of Mentor Graphics’ real-time operating
systems or other embedded software products into Customer’s products or applications without first signing or otherwise
agreeing to a separate agreement with Mentor Graphics for such purpose.

BETA CODE.

4.1. Portions or all of certain Software may contain code for experimental testing and evaluation (“Beta Code”), which may not
be used without Mentor Graphics’ explicit authorization. Upon Mentor Graphics’ authorization, Mentor Graphics grants to
Customer a temporary, nontransferable, nonexclusive license for experimental use to test and evaluate the Beta Code
without charge for a limited period of time specified by Mentor Graphics. This grant and Customer’s use of the Beta Code
shall not be construed as marketing or offering to sell a license to the Beta Code, which Mentor Graphics may choose not to
release commercially in any form.

4.2. If Mentor Graphics authorizes Customer to use the Beta Code, Customer agrees to evaluate and test the Beta Code under
normal conditions as directed by Mentor Graphics. Customer will contact Mentor Graphics periodically during Customer’s
use of the Beta Code to discuss any malfunctions or suggested improvements. Upon completion of Customer’s evaluation
and testing, Customer will send to Mentor Graphics a written evaluation of the Beta Code, including its strengths,
weaknesses and recommended improvements.

4.3. Customer agrees to maintain Beta Code in confidence and shall restrict access to the Beta Code, including the methods and
concepts utilized therein, solely to those employees and Customer location(s) authorized by Mentor Graphics to perform
beta testing. Customer agrees that any written evaluations and all inventions, product improvements, modifications or
developments that Mentor Graphics conceived or made during or subsequent to this Agreement, including those based
partly or wholly on Customer’s feedback, will be the exclusive property of Mentor Graphics. Mentor Graphics will have
exclusive rights, title and interest in all such property. The provisions of this Subsection 4.3 shall survive termination of
this Agreement.

RESTRICTIONS ON USE.

5.1. Customer may copy Software only as reasonably necessary to support the authorized use. Each copy must include all
notices and legends embedded in Software and affixed to its medium and container as received from Mentor Graphics. All
copies shall remain the property of Mentor Graphics or its licensors. Customer shall maintain a record of the number and
primary location of all copies of Software, including copies merged with other software, and shall make those records
available to Mentor Graphics upon request. Customer shall not make Products available in any form to any person other
than Customer’s employees and on-site contractors, excluding Mentor Graphics competitors, whose job performance
requires access and who are under obligations of confidentiality. Customer shall take appropriate action to protect the
confidentiality of Products and ensure that any person permitted access does not disclose or use it except as permitted by
this Agreement. Customer shall give Mentor Graphics written notice of any unauthorized disclosure or use of the Products
as soon as Customer learns or becomes aware of such unauthorized disclosure or use. Except as otherwise permitted for
purposes of interoperability as specified by applicable and mandatory local law, Customer shall not reverse-assemble,
reverse-compile, reverse-engineer or in any way derive any source code from Software. Log files, data files, rule files and
script files generated by or for the Software (collectively “Files”), including without limitation files containing Standard
Verification Rule Format (“SVRF”) and Tcl Verification Format (“TVF”) which are Mentor Graphics’ proprietary
syntaxes for expressing process rules, constitute or include confidential information of Mentor Graphics. Customer may
share Files with third parties, excluding Mentor Graphics competitors, provided that the confidentiality of such Files is
protected by written agreement at least as well as Customer protects other information of a similar nature or importance,
but in any case with at least reasonable care. Customer may use Files containing SVRF or TVF only with Mentor Graphics
products. Under no circumstances shall Customer use Software or Files or allow their use for the purpose of developing,
enhancing or marketing any product that is in any way competitive with Software, or disclose to any third party the results
of, or information pertaining to, any benchmark.

5.2. If any Software or portions thereof are provided in source code form, Customer will use the source code only to correct
software errors and enhance or modify the Software for the authorized use. Customer shall not disclose or permit disclosure
of source code, in whole or in part, including any of its methods or concepts, to anyone except Customer’s employees or
contractors, excluding Mentor Graphics competitors, with a need to know. Customer shall not copy or compile source code
in any manner except to support this authorized use.

5.3. Customer may not assign this Agreement or the rights and duties under it, or relocate, sublicense or otherwise transfer the
Products, whether by operation of law or otherwise (“Attempted Transfer”), without Mentor Graphics’ prior written
consent and payment of Mentor Graphics’ then-current applicable relocation and/or transfer fees. Any Attempted Transfer
without Mentor Graphics’ prior written consent shall be a material breach of this Agreement and may, at Mentor Graphics’
option, result in the immediate termination of the Agreement and/or the licenses granted under this Agreement. The terms
of this Agreement, including without limitation the licensing and assignment provisions, shall be binding upon Customer’s
permitted successors in interest and assigns.
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11.

12.

5.4. The provisions of this Section 5 shall survive the termination of this Agreement.

SUPPORT SERVICES. To the extent Customer purchases support services, Mentor Graphics will provide Customer updates
and technical support for the Products, at the Customer site(s) for which support is purchased, in accordance with Mentor
Graphics’ then current End-User Support Terms located at http://supportnet.mentor.com/about/legal/.

AUTOMATIC CHECK FOR UPDATES; PRIVACY. Technological measures in Software may communicate with servers
of Mentor Graphics or its contractors for the purpose of checking for and notifying the user of updates and to ensure that the
Software in use is licensed in compliance with this Agreement. Mentor Graphics will not collect any personally identifiable data
in this process and will not disclose any data collected to any third party without the prior written consent of Customer, except to
Mentor Graphics’ outside attorneys or as may be required by a court of competent jurisdiction.

LIMITED WARRANTY.

8.1. Mentor Graphics warrants that during the warranty period its standard, generally supported Products, when properly
installed, will substantially conform to the functional specifications set forth in the applicable user manual. Mentor
Graphics does not warrant that Products will meet Customer’s requirements or that operation of Products will be
uninterrupted or error free. The warranty period is 90 days starting on the 15th day after delivery or upon installation,
whichever first occurs. Customer must notify Mentor Graphics in writing of any nonconformity within the warranty period.
For the avoidance of doubt, this warranty applies only to the initial shipment of Software under an Order and does not
renew or reset, for example, with the delivery of (a) Software updates or (b) authorization codes or alternate Software under
a transaction involving Software re-mix. This warranty shall not be valid if Products have been subject to misuse,
unauthorized modification or improper installation. MENTOR GRAPHICS’ ENTIRE LIABILITY AND CUSTOMER’S
EXCLUSIVE REMEDY SHALL BE, AT MENTOR GRAPHICS’ OPTION, EITHER (A) REFUND OF THE PRICE
PAID UPON RETURN OF THE PRODUCTS TO MENTOR GRAPHICS OR (B) MODIFICATION OR
REPLACEMENT OF THE PRODUCTS THAT DO NOT MEET THIS LIMITED WARRANTY, PROVIDED
CUSTOMER HAS OTHERWISE COMPLIED WITH THIS AGREEMENT. MENTOR GRAPHICS MAKES NO
WARRANTIES WITH RESPECT TO: (A) SERVICES; (B) PRODUCTS PROVIDED AT NO CHARGE; OR (C) BETA
CODE; ALL OF WHICH ARE PROVIDED “AS IS.”

8.2. THE WARRANTIES SET FORTH IN THIS SECTION 8 ARE EXCLUSIVE. NEITHER MENTOR GRAPHICS NOR
ITS LICENSORS MAKE ANY OTHER WARRANTIES EXPRESS, IMPLIED OR STATUTORY, WITH RESPECT TO
PRODUCTS PROVIDED UNDER THIS AGREEMENT. MENTOR GRAPHICS AND ITS LICENSORS
SPECIFICALLY DISCLAIM ALL IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE AND NON-INFRINGEMENT OF INTELLECTUAL PROPERTY.

LIMITATION OF LIABILITY. EXCEPT WHERE THIS EXCLUSION OR RESTRICTION OF LIABILITY WOULD BE
VOID OR INEFFECTIVE UNDER APPLICABLE LAW, IN NO EVENT SHALL MENTOR GRAPHICS OR ITS
LICENSORS BE LIABLE FOR INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES (INCLUDING
LOST PROFITS OR SAVINGS) WHETHER BASED ON CONTRACT, TORT OR ANY OTHER LEGAL THEORY, EVEN
IF MENTOR GRAPHICS OR ITS LICENSORS HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN
NO EVENT SHALL MENTOR GRAPHICS’ OR ITS LICENSORS’ LIABILITY UNDER THIS AGREEMENT EXCEED
THE AMOUNT RECEIVED FROM CUSTOMER FOR THE HARDWARE, SOFTWARE LICENSE OR SERVICE GIVING
RISE TO THE CLAIM. IN THE CASE WHERE NO AMOUNT WAS PAID, MENTOR GRAPHICS AND ITS LICENSORS
SHALL HAVE NO LIABILITY FOR ANY DAMAGES WHATSOEVER. THE PROVISIONS OF THIS SECTION 9 SHALL
SURVIVE THE TERMINATION OF THIS AGREEMENT.

HAZARDOUS APPLICATIONS. CUSTOMER ACKNOWLEDGES IT IS SOLELY RESPONSIBLE FOR TESTING ITS
PRODUCTS USED IN APPLICATIONS WHERE THE FAILURE OR INACCURACY OF ITS PRODUCTS MIGHT
RESULT IN DEATH OR PERSONAL INJURY (“HAZARDOUS APPLICATIONS”). NEITHER MENTOR GRAPHICS
NOR ITS LICENSORS SHALL BE LIABLE FOR ANY DAMAGES RESULTING FROM OR IN CONNECTION WITH
THE USE OF MENTOR GRAPHICS PRODUCTS IN OR FOR HAZARDOUS APPLICATIONS. THE PROVISIONS OF
THIS SECTION 10 SHALL SURVIVE THE TERMINATION OF THIS AGREEMENT.

INDEMNIFICATION. CUSTOMER AGREES TO INDEMNIFY AND HOLD HARMLESS MENTOR GRAPHICS AND
ITS LICENSORS FROM ANY CLAIMS, LOSS, COST, DAMAGE, EXPENSE OR LIABILITY, INCLUDING
ATTORNEYS’ FEES, ARISING OUT OF OR IN CONNECTION WITH THE USE OF PRODUCTS AS DESCRIBED IN
SECTION 10. THE PROVISIONS OF THIS SECTION 11 SHALL SURVIVE THE TERMINATION OF THIS
AGREEMENT.

INFRINGEMENT.

12.1. Mentor Graphics will defend or settle, at its option and expense, any action brought against Customer in the United States,
Canada, Japan, or member state of the European Union which alleges that any standard, generally supported Product
acquired by Customer hereunder infringes a patent or copyright or misappropriates a trade secret in such jurisdiction.
Mentor Graphics will pay costs and damages finally awarded against Customer that are attributable to the action. Customer
understands and agrees that as conditions to Mentor Graphics’ obligations under this section Customer must: (a) notify
Mentor Graphics promptly in writing of the action; (b) provide Mentor Graphics all reasonable information and assistance
to settle or defend the action; and (c) grant Mentor Graphics sole authority and control of the defense or settlement of the
action.
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12.2. Ifaclaim is made under Subsection 12.1 Mentor Graphics may, at its option and expense, (a) replace or modify the Product
so that it becomes noninfringing; (b) procure for Customer the right to continue using the Product; or (c) require the return
of the Product and refund to Customer any purchase price or license fee paid, less a reasonable allowance for use.

12.3. Mentor Graphics has no liability to Customer if the action is based upon: (a) the combination of Software or hardware with
any product not furnished by Mentor Graphics; (b) the modification of the Product other than by Mentor Graphics; (c) the
use of other than a current unaltered release of Software; (d) the use of the Product as part of an infringing process; (¢) a
product that Customer makes, uses, or sells; (f) any Beta Code or Product provided at no charge; (g) any software provided
by Mentor Graphics’ licensors who do not provide such indemnification to Mentor Graphics’ customers; or
(h) infringement by Customer that is deemed willful. In the case of (h), Customer shall reimburse Mentor Graphics for its
reasonable attorney fees and other costs related to the action.

12.4. THIS SECTION 12 IS SUBJECT TO SECTION 9 ABOVE AND STATES THE ENTIRE LIABILITY OF MENTOR
GRAPHICS AND ITS LICENSORS FOR DEFENSE, SETTLEMENT AND DAMAGES, AND CUSTOMER’S SOLE
AND EXCLUSIVE REMEDY, WITH RESPECT TO ANY ALLEGED PATENT OR COPYRIGHT INFRINGEMENT
OR TRADE SECRET MISAPPROPRIATION BY ANY PRODUCT PROVIDED UNDER THIS AGREEMENT.

TERMINATION AND EFFECT OF TERMINATION. If a Software license was provided for limited term use, such license
will automatically terminate at the end of the authorized term.

13.1. Mentor Graphics may terminate this Agreement and/or any license granted under this Agreement immediately upon written
notice if Customer: (a) exceeds the scope of the license or otherwise fails to comply with the licensing or confidentiality
provisions of this Agreement, or (b) becomes insolvent, files a bankruptcy petition, institutes proceedings for liquidation or
winding up or enters into an agreement to assign its assets for the benefit of creditors. For any other material breach of any
provision of this Agreement, Mentor Graphics may terminate this Agreement and/or any license granted under this
Agreement upon 30 days written notice if Customer fails to cure the breach within the 30 day notice period. Termination of
this Agreement or any license granted hereunder will not affect Customer’s obligation to pay for Products shipped or
licenses granted prior to the termination, which amounts shall be payable immediately upon the date of termination.

13.2. Upon termination of this Agreement, the rights and obligations of the parties shall cease except as expressly set forth in this
Agreement. Upon termination, Customer shall ensure that all use of the affected Products ceases, and shall return hardware
and either return to Mentor Graphics or destroy Software in Customer’s possession, including all copies and
documentation, and certify in writing to Mentor Graphics within ten business days of the termination date that Customer no
longer possesses any of the affected Products or copies of Software in any form.

EXPORT. The Products provided hereunder are subject to regulation by local laws and United States government agencies,
which prohibit export or diversion of certain products and information about the products to certain countries and certain
persons. Customer agrees that it will not export Products in any manner without first obtaining all necessary approval from
appropriate local and United States government agencies.

U.S. GOVERNMENT LICENSE RIGHTS. Software was developed entirely at private expense. All Software is commercial
computer software within the meaning of the applicable acquisition regulations. Accordingly, pursuant to US FAR 48 CFR
12.212 and DFAR 48 CFR 227.7202, use, duplication and disclosure of the Software by or for the U.S. Government or a U.S.
Government subcontractor is subject solely to the terms and conditions set forth in this Agreement, except for provisions which
are contrary to applicable mandatory federal laws.

THIRD PARTY BENEFICIARY. Mentor Graphics Corporation, Mentor Graphics (Ireland) Limited, Microsoft Corporation
and other licensors may be third party beneficiaries of this Agreement with the right to enforce the obligations set forth herein.

REVIEW OF LICENSE USAGE. Customer will monitor the access to and use of Software. With prior written notice and
during Customer’s normal business hours, Mentor Graphics may engage an internationally recognized accounting firm to
review Customer’s software monitoring system and records deemed relevant by the internationally recognized accounting firm
to confirm Customer’s compliance with the terms of this Agreement or U.S. or other local export laws. Such review may include
FLEXIm or FLEXnet (or successor product) report log files that Customer shall capture and provide at Mentor Graphics’
request. Customer shall make records available in electronic format and shall fully cooperate with data gathering to support the
license review. Mentor Graphics shall bear the expense of any such review unless a material non-compliance is revealed. Mentor
Graphics shall treat as confidential information all information gained as a result of any request or review and shall only use or
disclose such information as required by law or to enforce its rights under this Agreement. The provisions of this Section 17
shall survive the termination of this Agreement.

CONTROLLING LAW, JURISDICTION AND DISPUTE RESOLUTION. The owners of certain Mentor Graphics
intellectual property licensed under this Agreement are located in Ireland and the United States. To promote consistency around
the world, disputes shall be resolved as follows: excluding conflict of laws rules, this Agreement shall be governed by and
construed under the laws of the State of Oregon, USA, if Customer is located in North or South America, and the laws of Ireland
if Customer is located outside of North or South America. All disputes arising out of or in relation to this Agreement shall be
submitted to the exclusive jurisdiction of the courts of Portland, Oregon when the laws of Oregon apply, or Dublin, Ireland when
the laws of Ireland apply. Notwithstanding the foregoing, all disputes in Asia arising out of or in relation to this Agreement shall
be resolved by arbitration in Singapore before a single arbitrator to be appointed by the chairman of the Singapore International
Arbitration Centre (“SIAC”) to be conducted in the English language, in accordance with the Arbitration Rules of the SIAC in
effect at the time of the dispute, which rules are deemed to be incorporated by reference in this section. This section shall not
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restrict Mentor Graphics’ right to bring an action against Customer in the jurisdiction where Customer’s place of business is
located. The United Nations Convention on Contracts for the International Sale of Goods does not apply to this Agreement.

SEVERABILITY. If any provision of this Agreement is held by a court of competent jurisdiction to be void, invalid,
unenforceable or illegal, such provision shall be severed from this Agreement and the remaining provisions will remain in full
force and effect.

MISCELLANEOUS. This Agreement contains the parties’ entire understanding relating to its subject matter and supersedes all
prior or contemporaneous agreements, including but not limited to any purchase order terms and conditions. Some Software
may contain code distributed under a third party license agreement that may provide additional rights to Customer. Please see
the applicable Software documentation for details. This Agreement may only be modified in writing by authorized
representatives of the parties. Waiver of terms or excuse of breach must be in writing and shall not constitute subsequent
consent, waiver or excuse.
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